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Chapter 1: Introducing Exceed
Welcome to Exceed

Exceed transforms your computer into a fully functional X Window 
terminal. It lets you run and display UNIX applications (X clients) from a 
Microsoft Windows environment. Exceed integrates your Windows desktop 
with environments such as UNIX, Linux, VMS, X Window System, IBM 
mainframes, and the Internet. Exceed is an integrated part of the OpenText 
Connectivity product family, which provides organizations with a 
comprehensive network connectivity solution.

Exceed includes innovative features that accelerate performance, simplify 
system administration, and optimize personal computing. Users are 
shielded from the complexities of network computing by working within 
the familiar Microsoft Windows environment. System administrators are   
provided with tools to set up, configure, and administer PCs remotely to 
ensure consistency among systems.

Use Exceed on your local computer to:

• Access powerful applications and information running on networked 
hosts.

• Establish simultaneous connections to different computers running 
X clients.

• Use an X window manager to display the visual interface you are 
familiar with from your X environment. 

Exceed and X Windows
In the X Window environment, the Exceed X server is also referred to as an 
X Window terminal or display server. Without Exceed X server software, 
X applications are accessible only via X terminals, UNIX, Linux, or VMS 
workstations.

Exceed works with your network transport software or your modem to 
access X Window applications on hosts running the X Window System. A 
host can be any machine using an operating system that is running the X 
Window environment.
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The figure below shows how Exceed lets your PC access the X Window 
environment.

X connections over TCP/IP

Dial-up (LBX) LAN WAN Secure Shell

OpenText Secure Shell add-on

UNIX Linux

The Exceed Interface

Exceed Task Menu
The Exceed task menu is accessed by right-clicking on the Exceed icon on 
the Windows taskbar once Exceed is running. If Exceed does not appear in 
the taskbar, right-click the Exceed icon in the Windows system tray, select 
Tools and then click Show Main Icon.

For more information, see 
“Setting the Window 
Manager for Exceed” on 
page 15.

If you are running an X application in multiple window mode with Default 
To Native as the window manager, you can access the Exceed menu by 
right-clicking the Exceed icon in the title bar of the window.

You can use the Exceed task menu to perform the following tasks:
4
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• accessing applications such as Xstart, Xsession, and Xconfig to 
configure settings for the current session

• perform Exceed XDMCP Broadcasts which let you start the Exceed X 
server in XDMCP Broadcast mode. For more information, see 
“XDMCP Broadcast Startup Mode” on page 55.

• perform Exceed XDMCP Queries which let you start the Exceed X 
server in XDMCP Query mode. For more information, see “XDMCP 
Query Startup Mode” on page 52.

Exceed Menu
The Exceed main menu is accessed by right-clicking on the Exceed preview 
that is displayed when you hover over the Exceed icon on the Windows 
taskbar when Exceed is running. If Exceed does not appear in the taskbar, 
right-click the Exceed icon in the Windows system tray, select Tools and 
then click Show Main Icon.

For more information, see 
“Setting the Window 
Manager for Exceed” on 
page 15.

If you are running an X application in multiple window mode with Default 
To Native as the window manager, you can access the Exceed menu by 
right-clicking the Exceed icon in the title bar of the window.

You can use the Exceed main menu for many general tasks including: 

• reloading databases for RGB, font, and keyboard

• performing copy and paste actions

• displaying the virtual desktop window

• switching the keyboard

• resetting the server

• toggling between the Windows desktop and the X server backdrop

• specifying whether mouse or touch actions on the Windows desktop are 
processed by Exceed

• viewing Exceed Help 

The Exceed menu includes the File, Edit,View,  Tools, and Help submenus.
5
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Exceed Toolbar
The Exceed toolbar is displayed when you open Exceed. The toolbar is a 
convenient way to perform typical Exceed menu actions while a session is 
running. You can drag and drop the toolbar to a desired location on your 
screen, or you can dock it by dragging it to the edge of your screen.

If the Exceed toolbar is not displayed, select View on the Exceed main menu, 
select Toolbar on the View menu, and then select Show.

For more information on 
customizing the Exceed 
toolbar, see Exceed Help.

You can also customize the Exceed toolbar to include buttons for Exceed 
menu commands or other applications. For example, you can add buttons 
for actions such as reloading the keyboard, showing workspaces, and 
resetting the server. 

Exceed Applications and Tools

You can also set up the 
connection manually.

Exceed contains several startup applications and tools that let you connect 
to a host and display UNIX, Linux, VMS and X applications on your PC. 

On the Star t menu, navigate to the OpenText Exceed program group to access 
the following applications:

Exceed      Exceed is a PC X server that displays graphical UNIX, Linux, and 
X applications on your computer.

Exceed Connection Manager     Exceed Connection Manager lets you view, 
create, rename, delete, and modify Xstart, Xsession, and Xconfig files from a 
single user interface. For more information, see Exceed Help.

Exceed Tools
On the Start menu, navigate to the OpenText Exceed program group, and 
point to Exceed Tools to access the following:

Exceed XDMCP Broadcast     Lets you start the Exceed X server in XDMCP 
Broadcast mode. For more information, see “XDMCP Broadcast Startup 
Mode” on page 55.
6
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Exceed XDMCP Query     Lets you start the Exceed X server in XDMCP 
Query mode. For more information, see “XDMCP Query Startup Mode” 
on page 52.

Xconfig     Lets you customize Exceed properties. Starting Xconfig from the 
Star t menu opens the default .xcfg file. To modify the .xcfg file for the 
current session, start Xconfig from the Exceed menu or the Exceed toolbar. 
For more information, see Chapter 4: Xconfig.

Xsession     Lets you start the Exceed X server and multiple X 
clients/Windows programs simultaneously. You can also access Xsession 
from the Exceed menu, or the Exceed toolbar. For more information, see 
“About Xsession” on page 73. 

Xstart      Use Xstart to create Xstart (.xs) startup files and create shortcut 
icons to start regular X clients, such as your UNIX, Linux and 
X applications. When you click on a shortcut icon, it automatically 
establishes a host connection, logs on, and then starts an X client or runs a 
host-based script. You can access Xstart from the Exceed menu or the 
Exceed toolbar. For more information, see “About Xstart” on page 28.

Security Tools
On the Start menu, navigate to the OpenText Exceed program group, and 
select Security Tools to access the following:

OpenText Kerberos     An OpenText client implementation of the Kerberos 
security authentication protocol developed at MIT. For more information, 
see OpenText Kerberos Help.

Other Exceed Products

Exceed 3D
Exceed 3D is not included 
with Exceed. For more 
information, contact your 
sales representative.

Exceed 3D lets you display OpenGL-based X applications. OpenGL is a 3D 
graphics software interface that lets you create interactive programs that 
produce still or animated 3D color objects, including shading, lighting, and 
other effects. Exceed 3D interprets OpenGL calls from an X application, and 
sends the information to the video card on your computer.
7
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User Files

Depending on how your OpenText products are set up, user files can be 
categorized as either per-user or shared user. There can also be global user 
files.

Per-User
Per-user files are application or service files that, when changed, affect only 
the user who is making the change (that is, the currently logged in user). 

An example of a per-user file is HostEx.ini. If you configure HostEx.ini 
with HostExplorer to Not Prompt On Window Close for a particular user, then 
other users of the machine are not affected. 

Another example of a per-user file is Exceed.xcfg. If you configure 
Exceed.xcfg with Xconfig to use a certain display, then other users of the 
machine are not affected. 

The following is the default location for per-user files. By default, this 
location is hidden: 

C:\Users\Username\AppData\Roaming\Hummingbird\Connectivity\
version

where Username is the name of the user and version is the version number 
of your product.

Shared User
Shared user files are stored in the same location, so that any changes to the 
files affect all shared users.

The following is the default location for shared user files:

C:\ProgramData\Hummingbird\Connectivity\version

where version is the version number of your product.

Note: Each user of the product on the machine receives a 
personal user directory. 
8
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Global User
The global user folder is available to all users of the machine. Generally, the 
global user folder is intended as writable by administrators and readable by 
all users. In certain cases, folder permissions may be changed to allow 
everyone write access.

Files such as user profiles and mandatory settings are accessible from the 
global folder on the local machine (regardless of the current user). They can 
also be made accessible from a central location (for example, a network 
share) to multiple users when they install the product. During installation 
(on supported Microsoft Windows platforms), these files are copied locally 
to a shared folder under the All Users folder.

The following is the default location for global user files:

C:\ProgramData\Hummingbird\Connectivity\
version\Global

where version is the version number of your product.
9
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Chapter 2: Connecting to Hosts and Running X Clients
Connecting

To connect to remote clients, you must specify the following:

• a startup method (usually through TCP/IP)

• a valid account on a UNIX host (with user ID and password)

If you are connecting for the first time, consider the following information 
on connecting to hosts:

• “Starting X Clients Using a Remote Process” on page 13

• “Creating Startup Files” on page 31 and “Running an Xstart File” on 
page 34

• “Creating Shortcuts” on page 34

• “XDMCP Broadcast Startup Mode” on page 55

After connecting to a host, ensure that you know the syntax to:

• Set display environment variables on different host systems. For more 
information, see “Setting the DISPLAY Environment Variable” on 
page 71.

• Start a specific window manager (if applicable). For more information, 
see “About Window Managers” on page 14.

Starting X Clients Using a Remote Process
You can connect to clients using a remote process when Exceed starts (for 
example, an XDM script). Ideally, use an Xterm or some other terminal 
emulator, such as TELNET, which gives you a command prompt on the host 
to let you start other clients.

Note: You can start clients in background mode in UNIX by typing 
an ampersand (&) at the end of the command.

Note: Unless you are using a local window manager (that is, either 
HWM or Native window manager), the first X client you start must 
be a remote X window manager.
13
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Before starting, do the following:

• Set the startup mode for Xconfig to passive. For more information, see 
“Running an Xstart File” on page 34. 

• Start Exceed.

• If you are using HWM, start the window manager.

For more information, see 
“Setting the DISPLAY 
Environment Variable” on 
page 71.

• Determine whether the DISPLAY variable is already defined on the 
host. If not, enter it on the command line. Otherwise, your X client will 
not run. 

Regardless of whether the DISPLAY environment variable is defined, 
you can start X clients using the appropriate command line syntax for 
your transport. Enter the command at the terminal emulator prompt.

About Window Managers

A window manager interprets requests or commands entered on the 
computer and sends them to the Exceed X server. The X server sends the 
request to the X application, and the application sends instructions to the 
Exceed X server to display.

Multiple window mode 
creates a new window for 
each X client.

You can select the window manager you want to use in either single or 
multiple window mode. Only one window manager can run on a particular 
X display at a time.

Although window managers are Exceed clients, they may not display their 
own windows at startup. However, most X window managers have 
configurable menu systems. 

Note: If you run an X window session without a window manager, 
you cannot perform window operations, such as resizing, moving, 
and iconizing. Overlapping windows can make hidden parts of 
underlying windows inaccessible. 
14
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Setting the Window Manager for Exceed
Exceed can use local and remote window managers. Local window 
managers run on the local machine, while remote window managers run on 
a remote host. Running Exceed with a remote X window manager generally 
increases network traffic and may decrease overall system performance.

To set the window manager:

1 In Xconfig, select Display And Video. 

2 On the Screen tab, select one of the following options in the Window 
Manager area:

• Native—Uses the native Microsoft window manager for the 
window manager.

• X—Any X window manager, local or remote, is used for the 
window manager. You must start the window manager, as it does 
not start by default.

• Default To Native—The native window manager is used by default. 
However, if a local or remote X window manager is running, it 
replaces the native window manager. After the X window manager 
is terminated, the native window manager is used.

Starting Local Window Managers
For more information, see 
“HWM Configuration File” 
on page 277.

With Exceed, instead of using a remote window manager application, you 
can use a local window manager, such as the native Microsoft window 
manager, or HWM. To use a local window manager, you need to specify it in 
Xconfig. For HWM, you also need to start the window manager.
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To specify the local window manager:

1 In Xconfig, select Display And Video.

2 On the Screen tab, select one of the following options in the Window 
Manager area, depending on the local window manager you want to use:

Window 
Manager

Option Notes

Native Native The native Microsoft window manager cannot 
be used in single window mode.

HWM X Hummingbird (Motif-like) Window Manager 
can be used in single or multiple window 
mode.Default To Native

To start HWM:

On the Start menu, navigate to the OpenText Exceed product group, select 
Exceed Tools, and click HWM.

If you are running Exceed in either single or multiple window mode, you 
can double-click the HWM icon.

Starting Remote X Window Managers
If a remote window manager resides on one of your hosts, you can use it in 
single window mode or in multiple window mode. To use a remote 
X window manager, you need to specify it in Xconfig and then start the 
window manager.

You can start X window managers in the same way that you start any 
X client in passive startup mode. If you are running in XDMCP startup 
mode, the remote window manager is likely specified in the hosts startup 
file.

Note: For more information on Native, X, and Default To Native 
options, see “Setting the Window Manager for Exceed” on 
page 15.
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To specify the remote window manager:

1 In the left pane of Xconfig, click Display And Video.

For more information on 
these options, see “Setting 
the Window Manager for 
Exceed” on page 15.

2 On the Screen page, select the X or Default To Native option in the 
Window Manager area.

To start a remote X window manager:

1 Connect to the remote host using any startup method, such as Xstart, 
Xsession, or TELNET.

2 Provide a user ID, password, and any other login information required.

3 Type and execute the command to start the window manager. 

You can use one of the following window manager startup commands:

Window Manager Startup Command Syntax †

DEC (UNIX) [path/]dxwm&

OpenLook [path/]olwm&

AIX [path/]aixwm&

DEC (VMS) [path/]SPAWN/NOWAIT/INPUT=NL RUN 
SYS$SYSTEM:DECW$WINMGR

KDE (Linux) [path/]startkde&

GNOME (Linux) [path/]gnome-session&

 

† You must specify the DISPLAY environment variable or command line parameter so 
that the remote window manager knows which display it should use to connect.

Note: For GNOME sessions using EsounD, you need to 
grant access to port 16001 in the Windows Firewall Settings. 
For Windows 7 and later, you have to disable EsounD on the 
host or install an EsounD server from a third party provider. 
For detailed information on this issue, refer to the Release 
Notes.
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Displaying X Clients
X clients are displayed depending on the window mode, which is based on 
your preferences. By default, the Exceed X server operates in multiple 
window mode and the window manager is configured to default to native.

To specify the window mode:

1 In Xconfig, click Display And Video. 

2 On the Screen tab, select a window mode:

• Single Window Mode—Presents all clients in a single Exceed 
window. You can use any X window manager (local or remote) as 
your window manager.

• Multiple Window Mode—Each client you start creates a new 
window on your display. You can use either the native (Microsoft 
Windows) or any X window manager (local or remote) as your 
window manager.

Location of Menu Commands

Multiple Window Mode     To access the Exceed menu, right-click Exceed 
on the taskbar with Exceed running. If the Exceed menu is hidden, 
right-click the taskbar icon in the system tray.

The location of Edit menu commands vary depending on whether you are 
running the native window manager or an X window manager in multiple 
window mode:

Native Window Manager—The Copy Rectangle and Copy All 
commands (To File, Printer, or Clipboard) appear on the Control menu 
(click the Control menu at the top left of the X client window) on the Edit 
submenu.

X Window Manager—The Copy Rectangle and Copy All commands (To 
File, Printer, or Clipboard) appear on the Control menu of Exceed and on 
the Exceed toolbar.

Note: If you minimize the Exceed X server to an icon in single 
window mode, active client windows are no longer visible. 
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Single Window Mode     To access menus, right-click Exceed in the taskbar. 
Alternatively, right-click the title bar of the Exceed window. To move menus 
to a menu bar in the Exceed window, click Move Menu on the Tools menu. To 
return the menus to being right-click accessible, click Move Menu again.

Multiple X Display Support
Exceed supports multiple X displays. Users can run multiple simultaneous 
copies of the Exceed X server (limited by available memory and resources) 
as long as each copy has a unique display number. This feature is useful for 
users who want to establish multiple XDM (X Display Manager) sessions 
with different hosts.

Command Line Parameters

The Exceed X server (Exceed.exe) supports several command line 
parameters that specify the display number, file name, and host. If you want 
a particular command line parameter to default to its current Xconfig value 
in the Exceed.xcfg configuration file, then do not specify the parameter on 
the command line.

For example, to start the Exceed X server in single window mode on display 
1 with an XDMCP Query startup mode to an xdmhost host, specify the 
following:

exceed.exe -d 1 -m query -h xdmhost -w single

To specify the display number and configuration file name:

Use the following syntax:

-d display#

-f filename.xcfg

where display# represents a display number from 0 – 9999 inclusive and 
filename.xcfg is the configuration file name.

Note: The easiest way to start up multiple simultaneous copies of 
the Exceed X server is to use Xsession. For more information, see 
“About Xsession” on page 73.
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To specify the host name (optional):

Use the following syntax:

-m [passive|query|indirect|broadcast]

-h hostname

-w [multiple|single]

where hostname represents the connection host for the XDMCP Query or 
XDMCP Indirect startup modes.

X Display Support Limitations
There are some limitations on multiple X display support. For example:

• Since X displays may share the same configuration file, do not make 
changes to your configuration while the Exceed X server is running. 

• Since only one X display can own the desktop/root window and the 
configuration file is shared, do not enable multiple window mode 
settings if you are using the multiple X display feature. 

In particular, do not enable the Root Mouse Action To X in the Multiple 
Window Mode Advanced dialog box. To access this dialog box, click 
Display And Video in Xconfig, select Multiple in the Window Mode area of 
the Screen page, and click Advanced. You can still use the Root Mouse 
Actions To X toolbar button, but make sure that the setting is selected for 
only one X display at a time. 

• Colormaps are not shared between X displays which may result in color 
flashing in 256 color video mode when you change the focus between 
windows that are on different X displays.

• Multiple copies of the Exceed X server cannot share a single log file, so 
each copy of the Exceed X server has a log file name that is based on the 
log file name in the configuration file and the display number of the 
server.

For example, if the log file name in your configuration file is 
exceed.log, then each copy of the Exceed X server will use 
exceeddisplay#.log as the log file name, where display# is the display 
number of the Exceed X server.
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To disable support for multiple X displays:

Do the following:

• Create an XServer key under the following key in the registry:

• Create a (DWORD) value named DisableMultipleXDisplays and set 
the value to 1.

Entering Data Using the Mouse and Keyboard
You can use a two- or three-button Windows-compatible mouse with 
Exceed. To help you input data using your X Window terminal, Exceed also 
supports international keyboards.

You can perform any of the following changes, which are transparent to the 
X protocol:

• Type an X Window-supported character or string of characters using 
user-defined keystrokes by modifying the basic keyboard layout. For 
more information, see “Modifying a Keyboard File” on page 105.

• Simplify accented key entry by defining compose-key sequences. For 
more information, see “Creating Compose-Key Sequences” on 
page 110.

• Customize keyboard and mouse options and preferences. For more 
information, see “Modifying a Keyboard File” on page 105 and 
“Configuring Mouse Wheel Movements and Middle Button 
Emulation” on page 121.

• Customize or create new keyboard layouts with XKeys, a graphical 
keyboard utility. For more information, see “Using the XKeys Utility to 
Customize the Keyboard” on page 102.

HKEY_LOCAL_MACHINE\SOFTWARE\Hummingbird\Connectivity\version\
Exceed\
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Copying and Pasting in Exceed

To print data, you must set 
up your printer using Print 
Setup on the Exceed Edit 
menu. For more 
information, see “Setting 
Print Settings” on page 27.

Exceed provides functionality that lets you copy and paste between 
Windows and X applications. You can copy, paste, and print selected 
rectangles of information, entire windows, and X selections. For example, 
you may want to copy and paste data, such as long path specifications, 
command lines, or sections of script files.

The copying and pasting procedure varies depending on the source and 
destination of the data, such as:

• between Windows-based applications (for example, Microsoft Word, 
Notepad, Paintbrush, Telnet, HostExplorer Basic, Xstart)

• between Windows-based applications and X clients displayed on your 
PC (that is, displaying to your Exceed X server)

• between X clients displayed on your PC

In the X environment, the X selection is a buffer with a specific name that 
stores the data you select within an X client window. It is the mechanism 
that you use to copy data from X to Windows or vice versa. If data is not 
being copied to or pasted from X selections, make sure that the correct X 
selection type is defined. 

For more information, see 
“Copying and Pasting 
Between X Clients” on 
page 27.

The X client determines the X selection that is used. In most cases, the 
PRIMARY X selection is used, but other selections are available, such as 
SECONDARY, CLIPBOARD, and CUT_BUFFER0 to CUT_BUFFER7. 
Some X clients can use more than one X selection.

To define the X selection:

1 In the left pane of Xconfig, click X Selection. 

2 On the X Selection page, select the X selection associated with edit 
operations. 

3 You can also automate copying and pasting using the Auto Copy X 
Selection and Auto Paste To X Selection options. 
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Edit Menu Commands
For information on 
automatic copying and 
pasting, see “Automatic 
Copy and Paste” on 
page 218.

The copy and paste commands are available on the Exceed menu by 
selecting Edit. Most commands are similar to those in other Windows 
applications, and some commands use an X selection. 

The Edit menu includes the following commands:

Copy Rectangle –>To Clipboard | To Printer | To File—Copies a selected 
rectangle of the active X client window (multiple window mode) or the 
Exceed X server root window (single window mode) to a destination (such 
as Clipboard, printer, or file). After clicking Copy Rectangle, the cursor 
changes to a crosshair. To define an area to copy, click anywhere within the 
window and drag the mouse to define a rectangle. Releasing the mouse 
button copies the selected rectangle to the specified destination.

Copy All –>To Clipboard | To Printer | To File—Copies all visible portions 
of the active X client window (multiple window mode) or the server root 
window (single window mode) to the specified destination (such as 
Clipboard, printer, or file).

Copy X Selection –>To Clipboard | To Printer | To File—Copies the X 
selection to the specified destination (such as Clipboard, printer, or file).

Paste To X Selection –> From Clipboard | From File—Pastes the contents 
of Clipboard or a file to the X selection. Any X client requesting the 
selection can paste the associated data as long as it supports the data type 
reported in the selection.

Copying and Pasting Data
If you are having difficulty 
cutting and pasting data, 
check that Windows 
Clipboard contents appear 
in Clipboard Viewer.

You can copy data to Windows Clipboard, a file, or to the printer. If you 
copy and paste using Clipboard, you can use csv and biff formats. 

To copy data:

Copy data to Windows Clipboard using an appropriate Windows 
application, such as Paint.

Note: You can paste data from the Windows Clipboard to another 
Windows application as long as the destination application 
supports the data or format type.
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To paste text:

1 On the Exceed menu, select Edit, select Paste To X Selection, and then 
click From Clipboard.

2 Click the right mouse button in the X client window. It may be 
necessary to click the right and left mouse buttons simultaneously in 
the X client window. 

To paste data:

On the Exceed menu, select Edit and do any of the following:

• To paste data from Clipboard, click From Clipboard.

• To paste data from a file, click From File.

To clear the X selection buffer:

On the Exceed menu, select Edit and click Clear X Selection. 

Copying and Pasting Graphics
Exceed lets you copy images from X to the Windows Clipboard. You can 
copy an entire window or a partial window by dragging a rectangle over the 
window.

You can also paste images from the clipboard into an X client. The method 
of pasting an image to X is based on ICCCM (Inter-Client Communication 
Conventions Manual). Many X clients support the copying and pasting of 
graphics to other X clients, but only through ICCCM X selections. 

For a technical description of copying and pasting images, refer to 
seltest.doc, located in the Exceed installation directory. For an example of 
copying and pasting images, refer to seltest.c. These files are in the 
following location:

To build Seltest, you must upload it to a host where an Xlib development 
environment is available. 

To compile Seltest on a UNIX host:

Use the following syntax:

C:\Program Files\Hummmingbird\Connectivity\version\Exceed\Info
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cc -o seltest seltest.c -lX11

where the library file libX11.a is on your path.

To paste images from Clipboard to Seltest:

1 Copy an image to the Windows Clipboard using an appropriate 
Windows application, such as Paintbrush.

2 Run Exceed.

3 In the left pane of Xconfig, click X Selection. Check that the X selection 
setting is set to PRIMARY.

4 Run Seltest from an Xterm or TELNET window. This ensures that 
information is output to the standard output stream. Seltest initially 
displays an empty window.

5 Do one of the following:

• Single window mode—On the Exceed menu, select Edit, select Paste 
To X Selection, and then click From Clipboard.

• Multiple window mode—On the Exceed menu, select Edit, select 
Paste To X Selection.

6 Click the right mouse button in the Seltest window.

Seltest requests the current PRIMARY selection information and displays 
the selection target types that are available in the Xterm or TELNET 
window. If an image is available, it is displayed in the Seltest window. The 
amount of time it takes to display the image in the Seltest window varies 
depending on network load, image size, and color resolution. In most cases, 
it should not take longer than 30 seconds.

To copy images from Seltest to Clipboard: 

1 Follow the previous procedure for pasting a clipboard image to the 
Seltest client.

2 Clear the contents of Clipboard by clicking Delete on the Edit menu of 
Windows Clipboard.
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3 On the Exceed menu, select Edit and click Clear X Selection. If you are in 
multiple window mode, this causes the server to give up ownership of 
the PRIMARY selection.

4 Click the left mouse button in the Seltest window. Seltest requests 
ownership of the PRIMARY selection and associates the image it is 
displaying in its window with the PRIMARY selection.

5 Do one of the following:

• Single window mode—On the Exceed menu, select Edit, select Copy 
X Selection and click To Clipboard.

• Multiple window mode—On the Exceed menu, select Edit and click 
Copy X Selection. This causes the server to ask the PRIMARY 
selection owner (Seltest) for the PRIMARY selection image data. 
The server copies the image to the clipboard.

6 Display the Windows Clipboard Viewer to verify the image was 

transferred from the Seltest client to the clipboard.

Copying and Pasting Between X Selection and File
You can copy the current X selection to a destination file. You can also paste 
the current X selection from a source file. By default, the X selection is 
copied/pasted from a file located in the Exceed User directory. 

To copy the X selection to a destination file:

On the Exceed menu, select Edit, and click Copy X Selection To File. In the 
dialog box that opens, select the destination file and click Save.

To paste the X selection from a source file:

On the Exceed menu, select Edit, and click Paste File To X Selection. In the 
dialog box that opens, select the source file and click Open.
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Copying and Pasting Between X Clients
If your computer is 
properly configured, 
copying and pasting 
between different locales is 
supported. You can specify 
the locales in the Regional 
Settings in Control Panel.

If two X clients running on your computer support the same X selection, 
you can copy and paste between these X clients.

To copy and paste between X clients:

1 Place the data that you want to copy in the X selection buffer.

2 On the Exceed menu, select Edit, select Copy X Selection, and then click 
To Clipboard. This places a copy of the X selection in Clipboard. 

3 On the Exceed menu, select Edit, select Paste To X Selection, and then 
click From Clipboard.

4 Use the X client-specific method to paste the X selection data.

Setting Print Settings
You can specify print settings for printing the current selection. 

To set print specifications:

To specify the printer you 
want to use, click Print 
Setup on the Exceed 
menu, which opens a print 
dialog box. 

On the Exceed menu, select Edit, select a copy command, and then click To 
Printer. The Copy To Printer dialog box lets you specify sizing and scaling 
options for printing the current selection. To have Exceed automatically size 
the selection, select the Best Fit or Stretch To Page option.

Note: You can define the X selection type used by the destination 
client. For more information, see “Copying and Pasting in Exceed” 
on page 22.
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Accessing Hosts and Starting Applications

About Xstart
Xstart automates the process of accessing hosts and starting applications. 
Use Xstart to create Xstart (.xs) startup files and create shortcuts to UNIX, 
Linux, and X applications. Clicking one of these shortcuts automatically 
establishes a host connection, logs on, and then starts an X application.

X Client Setup
In Xstart, the specified startup method, host, user ID, password, and 
command are stored in the .xs file. The X client is started using this 
information, along with various other Xstart settings.
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Xstart with Profile Spaces
If your installation of Exceed includes the Profile Space feature, and your 
Exceed administrator has enabled it, then you can use any Profile Space to 
save and run Xstart startup files.

To open Xstart:

On the Star t menu, navigate to the OpenText Exceed program group, point to 
Exceed Tools, and then click Xstar t. 

If Exceed is already running, you can also right-click Exceed in the taskbar, 
and then click Xstar t under Tasks.

Startup Files
By installing an Xstart shortcut to an .xs file, you can double-click it to start 
Exceed and run the startup X client. You can also create script files for 
Web-based applications that require a user name and password. 

When you save an Xstart file, it is saved according to the following:

Note: 

• Using the GlobalExceed.ini file, which is located in the 
Global User directory, Administrators can enable or disable 
Profiles Spaces for all users, or allow users to enable it if 
required. 

• Xstart startup files (.xs) referenced by an Xsession file (.ses) 
must reside in the same Profile Space as the Xsession file.

Note: 

• If your installation of Exceed includes the Profile Space feature, 
and your Exceed administrator has enabled it, then you can 
use any Profile Space to save and run Xstart startup files.

• Xstart startup files (.xs) referenced by an Xsession file (.ses) 
must reside in the same Profile Space as the Xsession file.
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• By default, startup files are saved in the Profile directory for the 
currently logged in user, but you can specify another location.

The default location for startup files:

C:\Users\Username\AppData\Roaming\Hummingbird\
Connectivity\version

• If your installation of Exceed includes the Profile Space feature, and the 
Exceed administrator has enabled it, then you can use any available 
Profile Space. Xstart startup files (.xs) referenced by an Xsession file 
(.ses) must reside in the same Profile Space as the Xsession file.

Startup Methods

In Xstart, select one of the following startup methods to establish the host 
connection:

Startup Method Description

Secure Shell Encrypts remote X windows communications. This 
option is available only if you have OpenText Secure 
Shell installed. 

REXEC Requires a password to connect to the host. You can 
also use REXEC to run local X clients on other PCs on 
your network if they are running the Xstartd service.

RSH (Remote Shell) Similar to REXEC except that no password is required. 
Before using RSH, your computer must be authorized 
for RSH access on your host.

RLOGIN (Remote Login) Requires a password.

TELNET Requires a password. This startup method includes 
Kerberos V5 authentication and encryption for added 
security.

Local Application Launches Windows applications (such as 
HostExplorer FTP, Exceed, or HWM) on the local host.

 

Note: Administrators can use the GlobalExceed.ini file to enable 
or disable profiles spaces for all users, or allow users to enable it if 
required. GlobalExceed.ini is located in the Global User 
directory. 
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Xstart Events
When you run an Xstart file, the following occurs:

1 The Xstar t Information dialog box opens when you click Run if one or 
more options in the Local Prompt area are set to Ask User on the Prompts 
page of the Xstar t Settings dialog box. 

After account credentials have been verified, Exceed starts and retries 
the connection for the length of time specified in the Timeouts area on 
the Network page of the Xstar t Settings dialog box. 

2 After you have connected, the command specified in the Command box 
in Xstart is sent to the host specified in the Host box. If the command 
starts a client, the client session begins. The initial socket closes after the 
length of time specified in the Close box in the Timeouts area of the 
Network page.

3 If the Show Host Reply option is selected on the Network page, host or 
client messages are displayed in a window. You can copy text from this 
window to the clipboard.

To open the Xstart Settings dialog box:

In Xstart, click Settings in the Star tup area.

Creating Startup Files

When you create a startup file, you need to select a startup method, define 
the host, user ID, and password, and specify a command to run on the host. 
You can also specify local or remote login prompts when Xstart runs.

Command Example
Use the following command to start the Xterm client on a UNIX host:

[path/]xterm -display mypcname:displaynumber &

where:

• path is the location of Xterm on the host

• mypcname corresponds to your network node or address
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• displaynumber is the display number you entered on the Communication 
page (accessible by clicking Communication in Xconfig). The display 
number is usually zero (0).

To create a startup file and connect to the host:

1 Open Xstart. For more information, see “About Xstart” on page 28. 

2 In the Star tup area, select a method from the Method box. The method 
depends on the transport that you are using and the host to which you 
want to connect. For more information, see “Startup Methods” on 
page 30.

Options that do not apply 
to the selected startup 
method are dimmed. 

3 In the Connection area, specify the information required to connect to 
the host, log in, and execute a command to start an application. 

a) In the Host box, type the host to which you want to connect, or click 
Browse to select one from a list of hosts on the network and the X 
applications available.

Note: To configure a host table, or edit the default hostdb.txt, 
click Settings in the Startup area. In the Xstart Settings dialog box, 
click the Other tab, and then click the Configure button next to 
Hosts in the Browse Methods area.
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For more information, see 
“Using Login Macros” on 
page 61 and “User ID and 
Password Macros” on 
page 61.

b) Type a valid user ID and password for the host to which you want 
to connect. If you have defined a user ID and password macro, you 
can use it to fill in your user ID or password.

c) In the Command box, type a command to run on the host. The 
command that you type depends upon the program type (X 
Window or Windows application), your host system, and how it is 
set up.

For more information, see 
“Using Login Macros” on 
page 61 and “Command 
Macros” on page 62.

You can type the @d, @a, @:, and @# command macros as shortcuts in 
the Command box. The @d macro selects the proper IP address if the 
machine has more than one address. For more information, see 
Command Macros.

You can specify parts of the command using the available command 
macros by clicking Browse to select an application from a database.

4 In Xstart, click Save. 

In Xstart, click Create Shor tcut on the File menu to create a shortcut locally 
or on the network. To connect to the host, select Launch.

To specify local or remote login prompts when Xstart runs:

1 In Xstart, click Settings in the Star tup area. 

2 In the Xstar t Settings dialog box, do the following:

a) To provide a description for the Xstart file, click the Other tab. On 
the Other page, specify the description (maximum 40 characters) in 
the Description box.

b) To create a command on the Exceed client startup menu, select the 
Show On Exceed Star tup Menu option to display the description. The 
description also appears in Xsession if the Xstart file is added to the 
session.

c) In the Xstar t Settings dialog box, click OK.

Note: To configure an application database table, or edit the 
default appdb.txt, click Settings in the Startup area. In the Xstart 
Settings dialog box, click the Other tab, and then click the 
Configure button next to Applications in the Browse Methods area.
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3 In Xstart, click Save. 

Creating Shortcuts
You can create an Xstart or Xsession shortcut on the desktop, or in a local or 
network folder. You can double-click the Xstart or the Xsession shortcut to 
start Exceed and run the startup X client.

To create an Xstart or Xsession shortcut:

1 Do one of the following:

• In Xstart, open the .xs file.

• In Xsession, open the .ses file.

2 On the File menu, click Create Shortcut on the File menu. 

3 In the Browse For Folder dialog box, select a location for the shortcut.

To change the default icon, right-click the shortcut and click Properties to 
open the Windows Properties dialog box. To modify the shortcut caption, 
right-click the shortcut and click Rename. 

Running an Xstart File
When you use Xstart to start the X server, it is recommended that you set 
the startup mode to passive. 

To set the startup mode to passive:

In the left pane of Xconfig, select Communication. On the Communication tab, 
select Passive in the Mode box. 

To run an Xstart file:

Do one of the following:

• In Xstart, click Launch to start the X client using the startup 
information currently displayed in the Xstart window.

• In Xsession, click Launch to start Xstart files listed in the Session 
Contents area.
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• Use any Windows Run dialog box to run an Xstart file using the Xstart 
command line syntax.

• If the Profile Space feature is installed and enabled, you can run the 
startup file from Connection Central.

• Use shortcut commands to run Xstart files from the Exceed menu by 
selecting Tools, selecting Client Star tup or Session Star tup, and then 
clicking a shortcut command. 

• Double-click a shortcut located on the desktop, or in a local or 
network folder.

• On the Exceed menu, select Tools, select Client Startup, and then 
click a shortcut command.

• On the Exceed menu, select Tools, select Session Startup, and then 
click a shortcut command (assuming the Xsession includes the 
proper Xstart file). 

• Right-click the Exceed icon in the Windows taskbar and click Xstart 
in the Tasks list.

• Right-click the Exceed icon in the Windows taskbar and click 
Xsession in the Tasks list.

Launching Windows Applications
You can launch Windows applications on hosts using Xstart.

Command Line Switches
The following are possible command line switches:

-o <filename> Specifies the Exceed 
configuration file.

-w <multiple|single> Specifies the window mode.

-m <passive|query|indirect|broadcast> Specifies connection method.

-h <hostname> Specifies the remote host.

-n Name for the window title bar.

Note: Adding @h adds the host 
name to the title bar.
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You can start Exceed using command line switches that effectively override 
Xconfig settings. For example, you could type in the following in the 
Command box located in Xstart:

In this example, you can run several different X servers (Exceed.exe) on 
various hosts using different configuration parameters.

To launch Windows applications:

1 In Xstart, select Local Application in the Method box.

2 In the Command box, specify the application and related options. For 
more information, see “Creating Startup Files” on page 31.

Typical Xstart Commands
You can type the following host commands in the Command box located in 
Xstart.

UNIX C Shell Users
If you have defined the necessary environment variables, in the C shell 
resource file (.cshrc), you can type the command to invoke an X client. 

For example, type the following command to start Xterm:

xterm -ls &

UNIX Bourne Shell Users
For more information, see 
“Command Parameters” 
on page 51.

Since the Bourne shell startup file (.profile) is not called when Xstart logs 
onto the host, we recommend that you include the PATH and DISPLAY 
variables on the command line. 

The syntax is:

-display mypcname:0 &

-d Display setting.

-f <filename.xcfg> Specifies an xconfig file (other 
than the default).

"C:\Program Files\Hummingbird\Connectivity\version\Exceed\
Exceed.exe" -w single -m query -h Host1 -n Host1 -d 2
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where mypcname is the IP address of the Exceed X server, and & indicates that 
the application should start in the background.

For Sun Sparc hosts, since you cannot specify the OPENWINHOME and 
LD_LIBRARY_PATH variables on a single command line, consider creating 
a UNIX shell script on the host to perform these functions.

For example, the following script, called start_xterm, starts an xterm:

#!/bin/sh
OPENWINHOME=/usr/openwin
export OPENWINHOME
LD_LIBRARY_PATH=path
export LD_LIBRARY_PATH
path /xterm -ls -display mypcname:0 &

where usr is the appropriate directory on the host, path is the directory 
where the Xterm is located, and mypcname is the network node specification 
of your computer.

Once you have created the start_xterm script, type the following in the 
Xstart file Command box:

sh start_xterm &

Responding to an Xstart Timeout
When Xstart times out waiting for a prompt (an answer from the host), the 
Enter Reply For Prompt dialog box opens, requiring your input to proceed. To 
respond to the prompt, use the Reply box. You can reply again or send 
revised login information or commands.
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Displaying Xstart Login Information
When you run an .xs file, the Xstart Information dialog box may open 
depending on the local prompt options selected on the Prompts page of the 
Xstar t Settings dialog box. When you click OK in the Xstar t Information dialog 
box, Exceed attempts to connect.

To set local prompts:

1 In Xstart, click Settings in the Star tup area. 

2 In the Xstar t Settings dialog box, specify the local prompts on the 
Prompts page. Select one of the following prompt types for each item in 
the Local Prompts area:

• Hide—If all local prompt options are set to Hide, the Xstart 
Information dialog box does not open when you a run a file.

• Show Only—For the corresponding local prompt, the Xstart 
Information dialog box displays the information.

• Ask User—For the corresponding local prompt, the Xstar t 
Information dialog box prompts for the information before making 
the connection. You can specify Ask User for: the host you want to 
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connect to, the user ID, the command sent to the host, the display 
ID number, and the password.

Displaying the Xstart Host Reply Window
You can display a host reply window when you run Xstart, which is useful 
for troubleshooting connections and displaying errors. You can copy 
information from the Host Reply window to the Windows Clipboard.

To set the display of the host reply window:

1 In Xstart, click Settings in the Star tup area. 

2 In the Xstar t Settings dialog box, click the Network tab. 

3 On the Network page, select the Show Host Reply option to display a host 
reply window when you run Xstart.
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To hide or close the host reply window:

You can hide the Host Reply window when the connection opens. It 
re-displays when the X client terminates. When the connection closes, click 
OK to close this window.

Click Close to terminate the remote execution command socket monitoring 
the host replies. Click Copy to copy text from the Host Reply window to 
Windows Clipboard.

Browsing for Hosts and Applications
To browse for hosts and applications in Xstart, you must specify which 
methods and options to use in the Browse Hosts and Browse Applications 
dialog boxes.

To set browsing options:

1 In Xstart, click Settings in the Star tup area. 

2 In the Xstar t Settings dialog box, click the Other tab. 

3 On the Other page, click the Configure button next to Hosts to open the 
Browse Hosts dialog box, or the Configure button next to Applications to 
open the Browse Applications dialog box. For more information, see:

• Browse Hosts/Applications dialog box: Method page 

• Browse Hosts dialog box: Options page 

• Browse Applications dialog box: Options page 

Browse Hosts/Applications dialog box: Method page

This page lets you specify the file retrieval method for the Browse Hosts and 
Browse Applications dialog boxes.

Method—Specifies the file retrieval method.

For more information about 
hostsdb.txt, see “Host 
Address File” on page 44. 
For more information about 
appdb.txt, see “Application 
Database File” on page 45.

• File—Uses the hostdb.txt file as a source for the host browse and 
appdb.txt as a source for the application browse. You can create and 
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maintain these files. The hostdb.txt file lists IP addresses and their 
associated hosts. This information affects which hosts Xstart browses.

For example:

123.45.67.89     boethius

The appdb.txt file lists applications and their typical locations on 
various servers in the form:

#category/application                 /full/path/to/binary

For example:

#Terminals

Terminals/dtterm               /usr/dt/bin/dtterm

#Window managers

Window managers/fluxbox       /usr/bin/fluxbox

 

• FTP—Uses files on an FTP server as the source for the host and the 
application browse. You can only access these files, not edit them. 
Source files are similar to those described for the File method. To 
properly configure the Browse Hosts or Browse Applications tabs using 
FTP, you must provide a server name, user name, password, account (if 
applicable), and path. In the File box, enter the name and location of the 
source file on the FTP server.

NIS and NIS+ file retrieval 
methods are available only 
after configuring them in 
Directory Services 
Explorer.

• NIS—Uses NIS (Network Information Service) maps hosts.byaddr as a 
source for the host browse and appdb as a source for the application 
browse. The system administrator on the UNIX side must create these 
maps.

Note: The stdappdb.txt file, which contains applications and their 
typical locations on various servers, is located in the Exceed User 
directory. For more information, see the Installation Guide. 

An application may be listed here, and consequently appears 
when you browse for applications, but there is no automatic 
confirmation that the application itself is in the specified directory. 
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• NIS+ —Uses NIS+ maps hosts (as a source for the host browse) and 
appdb (as a source for the application browse). The system 
administrator on the UNIX side must create these maps.

Edit—Opens an editing tool, where you can modify the selected file.

Browse—Opens a browse dialog box, where you can select a different file.

Browse Hosts dialog box: Options page

The Options page let you specify the options for the Browse Hosts dialog box. 

This page contains the following options:

To refresh the Host browse, 
click Refresh in the Browse 
For Hosts dialog box, 
which opens when you 
click Browse next to the 
Host box in Xstart.

Remember Browse Information—Controls whether Exceed remembers 
(caches) browse information. If the check box is cleared, information is not 
cached and each browse retrieves the applications file. If the check box is 
selected, information is cached and you can use the cached or locally saved 
list of applications and only refresh the browse from the source Once A Day 
(the default) or Only On Manual Refresh. Even if you select Once A Day, you 
can still use Refresh to update the information.

Click Default to restore original settings.
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Browse Applications dialog box: Options page

The Options page let you specify the options for the Browse Applications 
dialog box.

This page contains the following options:

Remember Browse Information—Controls whether Exceed remembers 
(caches) browse information. If the check box is cleared, information is not 
cached and each browse retrieves the applications file. If the check box is 
selected, information is cached and you can use the cached or locally saved 
list of applications and only refresh the browse from the source Once A Day 
(the default) or Only On Manual Refresh. Even if you select Once A Day, you 
can still use Refresh to update the information.

Use Application Startup Macro And Expand When Running Command—
Determines whether the selected browse item is inserted in the Xstart 
Command box as an application macro, or as the full path and application 
name. If inserted as a macro, it expands when the startup session runs. 

Note: To force a refresh (regardless of the settings), hold down the 
Shift key before launching Xstart or an Xstart startup file.
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Append To Browse Dialog Selection—Appends a string (variables, macros, 
flags, and so on) to the end of the item selected in the Browse dialog box 
(click Browse on the Methods page).

Default—Restores original settings.

Xstart Host and Application Files

Host Address File
The hostdb.txt file lists IP addresses and corresponding host names that 
affect which hosts Xstart browses.

For example:

123.45.67.89     boethius

Host List File 
The rupdb.txt file lists hosts that are running an rpcd daemon that 
supports the rstatd service. This service is capable of running the rup 
command, which returns status information about the host, including the 
service load. The rup command is a Remote Procedure Call (RPC) and the 
rpcd daemon handles all incoming RPCs.

Xstart consults rupdb.txt when running Load Optimization by sending a 
rup RPC to each host in rupdb.txt to find the least busy one. You can use 
section names in rupdb.txt to associate applications with host names.

The following syntax rules apply:

• Lines beginning with # are comments and are ignored by the system.

• Section names are enclosed in square brackets [ ].

• If you do not provide a name in the Section Name(s) box on the Options 
page of the Browse Load Optimization dialog box, then the system inserts 
the name [Default Section] in the rupdb.txt file. For more 
information, see “Load Optimization” on page 46.

• You can use any combination of alphabetic characters, spaces, 
capitalization, and numbers in section names. If you want to list more 
than one application in a section name, separate them with commas.

• When you add the hosts, type only one host on each line. Host names 
may be in short or full form, for example, irix or irix.domain.com.
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For example:

[xclock]
onefish
twofish

[xterm]
redfish
bluefish

In this example, the hosts onefish and twofish support the xclock 
application; the hosts redfish and bluefish support the Xterm application. 
When you specify an application in the section, Xstart queries only those 
hosts following each section. This prevents Xstart from contacting a host 
that does not run the desired application. 

Application Database File 
The appdb.txt file lists host names, application category/nicknames, and 
full path names for applications on remote hosts. Xstart uses appdb.txt to 
determine which hosts run a particular application.

For example:

solaris/mailtool: /usr/bin/mailtool

where solaris is the host, mailtool is the application, and 
/usr/bin/mailtool is the application path.

Listing NIS Maps on the System
The Browse NIS Maps dialog box in Xstart lists the configured NIS maps 
available to your system. These can be standard maps, such as hosts.byaddr 
which lists available hosts by their IP addresses, or custom maps set up by 
your system administrator, such as appdb, which references all the 
applications available to your system.

Note:  The appdb.txt file lists hosts that must be running rstatd. 
Therefore, the list of hosts in appdb.txt is a subset of the hosts 
listed in rupdb.txt, which is itself a subset of the hosts in 
hostdb.txt.
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For the NIS maps available for host or application browsing, check with 
your system administrator.

Load Optimization
This feature makes Xstart connections more efficient. The connection is 
redirected to another host if the original host is already accommodating 
many connections.

When you run the Xstart file, the system locates the specified host. If that 
host is busy, the system finds the host best able to accommodate the 
connection, based on the search format you specified.

Methods
To configure Xstart for load optimization, select a method on the Method 
page of the Browse Load Optimization dialog box.

The following options are available:

For more information about 
rupdb.txt, see “Host List 
File” on page 44.

• File—Xstart scans the rupdb.txt file for available hosts and tries to run 
the application on the least busy host. You can create and maintain this 
file, and save it in the User directory. This method is the easiest to run 
and is convenient if the desired application resides on every host in 
rupdb.txt (such as Xterm). If the application runs on certain hosts only 
(not necessarily the least busy ones), then this method could fail.
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For more information about 
appdb.txt, see “Application 
Database File” on page 45.

Alternatively, you can use rupdb.txt in conjunction with appdb.txt 
(provided you have previously created appdb.txt). In this case, select 
the Use Applications File option on the Options page. By comparing the 
two files, Xstart figures out what subset of hosts in rupdb.txt have the 
desired application and selects from those only.

• FTP—Uses a file on an FTP server as the source for available hosts. You 
can read a file this way but not edit it. To properly configure load 
optimization by FTP, enter the server name, user name, password, and 
account (if applicable) in the fields provided. In the File box, enter the 
name and location of the source file on the FTP server.

NIS and NIS+ file retrieval 
methods are available only 
after configuring them in 
Directory Services 
Explorer.

• NIS—Uses an NIS (Network Information Service) map rupdb as a 
source for available hosts. Before browsing, you must configure 
Directory Services. The system administrator on the UNIX side must 
create the map.

• NIS+ —Uses an NIS+ map rupdb as the source for available hosts. 
Before browsing, you must configure Directory Services. The system 
administrator on the UNIX side must create the map. 

• Broadcast—Sends out a broadcast on the network. This option is 
limited to queries within your subnet, unless you type an address for 
another subnet. If you selected Use Applications File on the Options page, 
then Xstart broadcasts the rup RPC to the subset of hosts in appdb.txt 
that run the desired application. If Use Applications File is not selected, 
then Xstart broadcasts to all hosts on the subnet. Using this method, 
you do not need a rupdb.txt file.

• Browse Applications—Uses an application database file (appdb.txt) to 
get a list of hosts to check.
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Options
To specify options for load optimization, select a method on the Options 
page of the Browse Load Optimization dialog box.

The following options are available:

Use Applications File—Specifies that Xstart uses rupdb.txt in conjunction 
with appdb.txt. 

Section Name(s)—Specifies one or more section names (separated by 
commas). These are defined in rupdb.txt. Each section name field can 
include one or more section names (separated by commas). 

Timeout—Sets a timeout value from 0 to 9999 milliseconds. If Broadcast 
was selected on the Method page, this time is the total time that Xstart waits 
for answers from remote hosts. If other methods were selected, this time is 
the maximum time to wait for an answer from each host.

Remember Browse Information—For more information, see the 
description in “Browse Hosts dialog box: Options page” on page 42.

Default—Restores original settings.
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To optimize loads on hosts:

1 Create the Xstart file. For more information, see “Creating Startup 
Files” on page 31.

2 In Xstart, click Settings. 

3 In the Xstar t Settings dialog box click the Other tab. 

4 In the Browse Methods area, select Load Optimization and then click 
Configure. 

5 In the Browse Load Optimization dialog box, do the following:

• On the Method page, select a method and provide the appropriate 
information.

• On the Options page, provide application file 
information/parameters and browse information parameters.

6 Click OK.

When you run the Xstart file, the system locates the host you specified. If 
that host is busy, the system finds the host best able to accommodate the 
connection, based on the search formats specified.

Using Xstart on VMS Systems

You can use Xstart on VMS systems by selecting the correct startup method 
for your transport software and entering all of the required information in 
the Xstart window.

TCP/IP Transports
You can use Xstart on a VMS system running TCP/IP if your VMS system 
supports REXEC or RSH. Alternatively, you can use TELNET to connect 
and start remote applications.

You must create a script on the host containing the DISPLAY environment 
variable specification and the command to start the X client. You can then 
use REXEC or RSH to connect to the host and execute the script.
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Startup Modes

Selecting an X Client Startup Mode
For more information, see 
“Configuring 
Communication Settings” 
on page 124.

In Xconfig, you can select the startup mode for the client. The startup mode 
determines the sequence of events when you start Exceed, including 
automatic host connection. The startup mode you use depends on your 
transport, your host, and your preferences.

To select an X client startup mode:

1 In the left pane of Xconfig, click Communication.

2 On the Communication page, select one of the following startup modes 
from the Mode box:

• Passive Mode—Before using HostExplorer, Xstart, Xsession, or a 
remote process to manually connect to a host and start an X client, 
select Passive. This startup mode does not connect to a specific host 
when it starts Exceed. You must know the UNIX commands 
required to run X clients.

• XDMCP Query—Connects to, and queries, the host specified in 
the Connect Host box of the XDMCP Star tup Modes dialog box 
(accessible by selecting XDCMP Query in the Mode box on the 
Communication page and clicking the Configure button).

• XDMCP Indirect—Connects to, and queries, the host specified in 
Connect Host in the XDMCP Star tup Modes dialog box. After 
connecting, a general request is made for X display management 
(XDM) to start clients on the host and broadcast the request to one 
or more other hosts.

• XDMCP Broadcast—Broadcasts an XDM request to hosts included 
in the Host List file (xdmcp.txt) or to the address in the Broadcast 
Address box of the Transpor t Settings dialog box.
50



Chapter 2: Connecting to Hosts and Running X Clients
Passive Startup Mode
Passive startup mode lets you start Exceed without connecting to a specific 
host. If you plan to use Xstart or Xsession to manually connect to a host and 
start X clients, or if you are using a remote process such as TELNET or an 
Xterm to start clients, you must use this startup mode.

Before starting Exceed:

• Start the HWM window manager. You can double-click the appropriate 
shortcut. You must know how to run X clients. Enter commands in the 
Command box. Depending on whether your host is UNIX or VMS, the 
command line varies. 

For more information about 
DISPLAY, see “Setting the 
DISPLAY Environment 
Variable” on page 71.

• Determine whether the DISPLAY environment variable is already 
defined on the host. If not, enter it on the command line. Otherwise, 
your X client will not run.

Command Parameters
The following is a list of available command parameters:

Note: If you are not using a local window manager (that is, either 
HWM or native window manager), you must start a remote X 
window manager.

Parameter Explanation

path The directory containing the application you want to run 
on the host to which you are connected. If you have 
pre-configured the PATH environment variable on your 
host, you may not need to enter it on the command line. 

application The executable name of the application.

parameters Any application parameters that you want to specify.

-display The command line option that introduces the display 
specification of Exceed. This specification contains the 
mypcname, transportindicator, and 
displaynumber parameters.

If you have pre-configured the DISPLAY environment 
variable on your host, you do not need to enter your 
display specification on the command line. 
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XDMCP Query Startup Mode
When you start Exceed, XDMCP Query startup mode automatically 
connects to the host specified in the Connect Host box of the XDMCP Startup 
Modes dialog box. After you log in, Exceed queries the host that starts the 
clients specified in the host XDM session (script) file.

Before starting Exceed:

• Ensure that the host is running the X Display Manager (XDM).

• Verify the name or network node specification is correct for the host 
you are connecting to (as specified in the Connect Host box in the 
XDMCP Startup Modes dialog box). To access this dialog box, refer to the 
following procedure.

• Ensure an XDM session file exists—Xstart verifies that an XDM session 
file (client starter script) exists on the host.

To configure Exceed to use XDMCP Query startup mode:

1 In the left pane of Xconfig, click Communication.

2 On the Communication page, select XDMCP Query in the Mode box. Leave 
the Display Number set to the default value of 0 unless your system 
administrator tells you otherwise.

mypcname The name or network address of the computer running 
Exceed.

displaynumber The Exceed display number. You can specify this value 
on the Communication page (by clicking 
Communication in Xconfig). Typically, the display 
number is zero (0).

& Indicates that this UNIX application should run in the 
background.

Note: XDMCP Query startup mode assumes that the host 
supports the X Display Manager Control Protocol and contains a 
session file (script) to start clients.

Parameter Explanation
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3 Click Configure.

4 In the XDMCP Star tup Modes dialog box, type the name of the host to 
which you want to connect at server startup in the Connect Host box. If 
you leave the box blank, Exceed prompts for a host name at runtime.

5 Modify any additional XDM settings displayed in the XDMCP Startup 
Modes dialog box.

To start X clients:

Before starting X clients, 
make sure that Exceed is 
configured to start in 
XDMCP Query startup 
mode using Xconfig.

1 Start Exceed and run XDMCP Query. One way to do this is to navigate 
to the OpenText Exceed program group on the Start menu, point to 
Exceed Tools, and click Exceed XDMCP Query.

2 In the Exceed XDMCP Query dialog box, type a host name or IP address 
and click OK.

3 Log in to the host. Exceed queries the host, starting clients listed in its 
XDM session (script) file.

4 To start additional X clients, you can use another startup application 
(that is, Xstart, Xsession, or TELNET).

XDMCP Indirect Startup Mode
When you start Exceed, XDMCP Indirect startup mode sends a query to the 
host specified in the Connect Host box of the XDMCP Star tup Modes dialog 
box. Either the host starts, or it broadcasts a request for one or more other 
hosts to start clients.

Before starting Exceed:

• Ensure that the host is running the X Display Manager (XDM).

• Verify the name or network node specification for the host you are 
connecting to (as specified in the Connect Host box in the XDMCP 
Star tup Modes dialog box). To access this dialog box, refer to the 
following procedure.

Note: This startup mode assumes that the host supports the 
X Display Manager Control Protocol and contains a session file 
(script) to start clients.
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• Ensure an XDM session file exists—Xstart verifies that an XDM session 
file (client starter script) exists on the host.

To configure Exceed to use XDMCP Indirect mode:

1 In the left pane of Xconfig, click Communication.

2 On the Communication page, select XDMCP Query in the Mode box. Leave 
the Display Number set to the default value of 0 unless your system 
administrator tells you otherwise.

3 Click Configure.

4 In the XDMCP Star tup Modes dialog box, specify the hosts that you want 
to receive the broadcast.

5 Specify additional XDM settings as necessary, and click OK.

If the Select First Display Manager option is selected in the XDMCP Star tup 
Modes dialog box, Exceed connects to the first display manager that 
responds to the broadcast and the Login Information dialog box prompts you 
to log in to the host.

If the Select First Display Manager option is cleared, Exceed opens the Display 
Manager Chooser dialog box, prompting you to select a host to manage the 
display. After you make a selection, the Login Information dialog box prompts 
you to log in. Once successfully logged in to the host, clients specified in the 
XDM session file (script) are run.

To start X clients:

Before starting X clients, 
make sure that Exceed is 
configured to start in 
XDMCP Query startup 
mode using Xconfig.

1 Start Exceed and run XDMCP Query. Navigate to the OpenText Exceed 
program group on the Start menu, point to Exceed Tools, and click 
Exceed XDMCP Query.

2 Log in to the host specified in the Connect Host box. After a connection 
is established, the host either starts clients or broadcasts a request for 
one or more other hosts to start clients, depending on information in 
the XDM session file (script).
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3 The host that becomes the display manager depends on the Select First 
Display Manager setting in the XDMCP Startup Modes dialog box. 

If this setting is checked, the first responding host becomes the display 
manager, and the Login Information dialog box appears for you to log in 
to that host.

If this setting is not checked, the Display Manager Chooser dialog box 
opens. You must select a host to be the display manager. After you 
choose, the Login Information dialog box opens for you to log in to the 
host.

4 To start additional X clients, you can use another startup application 
(that is, Xstart or Xsession).

XDMCP Broadcast Startup Mode
When you start Exceed, XDMCP Broadcast startup mode broadcasts an X 
connection request to the network hosts. You can broadcast to hosts in the 
host list file (xdmcp.txt) and/or those referenced by the broadcast address. 
Multicast addressing limits the sending of packets to a specific group of 
hosts. This avoids a broadcast to every host on the network. You can specify 
an address in the XDMCP area of the XDMCP Star tup Modes dialog box.

Before starting Exceed:

• Ensure that the host is running the X Display Manager (XDM).

• Verify the name or network node specification is correct for the host 
you are connecting to (as specified in the Connect Host box in the 
XDMCP Startup Modes dialog box). To access this dialog box, refer to the 
following procedure.

• Ensure an XDM session file exists—Xstart verifies that an XDM session 
file (client starter script) exists on the host.

Note: This startup mode assumes that the host supports the X 
Display Manager Control Protocol and contains a session file 
(script) to start clients.
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To configure Exceed to use XDMCP Broadcast mode:

1 In the left pane of Xconfig, select Communication.

2 On the Communication tab, select XDMCP Broadcast in the Mode box. 
Leave the Display Number set to the default value of 0 unless your system 
administrator tells you otherwise.

3 Click Configure.

4 In the XDMCP Star tup Modes dialog box, specify the hosts that you want 
to receive the broadcast.

You can add the broadcast host names to the Host List file (by default, 
xdmcp.txt). If you select Broadcast/Multicast, Exceed broadcasts to the 
address specified in the Address box. 

5 Specify additional XDM settings as necessary.

If Select First Display Manager is selected in the XDMCP Star tup Modes dialog 
box, Exceed connects to the first display manager that responds to the 
broadcast and the Login Information dialog box prompts you to log in to the 
host.

If Select First Display Manager is cleared, Exceed opens the XDMCP Display 
Manager Chooser dialog box which prompts you to select a host to manage 
the display. After making a selection, the Login Information dialog box 
prompts you to log in. Once successfully logged in to the host, clients 
specified in the XDM session file (script) are run.

To start an X client:

Before starting X clients, 
make sure that Exceed is 
configured to start in 
XDMCP Broadcast startup 
mode using Xconfig.

1 Navigate to the OpenText Exceed program group on the Star t menu, 
point to Exceed Tools, and click Exceed XDMCP Broadcast.

2 Exceed starts and broadcasts a request to hosts listed in the Host Access 
Control file to start clients specified in their scripts.

The host that becomes the display manager depends on whether Select 
First Display Manager is selected in the XDMCP Star tup Modes dialog box. 
If selected, the host connects to the first display manager.

Note: To specify a host that is not listed in the Host List file, type 
the address in the Host box, and click Add. 
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3 If you want to run additional X clients, you can use a separate startup 
application (that is, Xstart, Xsession, or TELNET).

XDMCP Timeouts
The XDMCP Idle dialog box indicates that the host has not responded to your 
XDMCP request and Exceed has timed out. The timeout is set to 126 
seconds.

• To force the server to reset after timing out, click Retry.

• To force Exceed into Passive mode until the server resets, click Passive.

• To exit Exceed, click Exit.
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Advanced Xstart Features

Using Login Macros
You can use macros as shortcuts in the User ID, Password, and Command 
boxes of Xstart.

User ID and Password Macros
For more information, see 
“Creating a Global Login” 
on page 63.

You can use the following macros to specify your user ID and password in 
Xstart.

Macro Description

@u or @U Inserts the user ID, depending on the startup mode.

@p or @P Inserts the password, depending on the startup mode.

@h or @H Inserts the host name, depending on the startup mode. 

@w or @W Inserts the Windows user name.

%w Inserts your Windows user ID.

For more information, see 
“Defining User ID and 
Password Macros” on 
page 65.

You can also use @u or @U and @p or @P to specify default login information in 
Xstart. 
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Command Macros
In Xstart, the Command box lets you send a UNIX command to the host. 
The command you type depends on your host system and how it is 
configured. You can use the following macros when specifying a command. 
These macros are automatically defined by Xstart; you do not need to 
perform additional steps to define them.

Macro Description

@d or @D
           

Inserts the display environment specification. Do not use with 
VMS systems.

For example, type the following command to start xterm:

xterm -display @d &

@a or @A Inserts the network address.

For example, type the following command to start xterm:

xterm -display @a:0 &

@m Inserts security information as part of the MIT-MAGIC-COOKIE-1 
(Xauthority) security feature. At run time, Xstart replaces @m with 
the required security information and key and sends this 
information to the host. Xstart also adds the key to the local 
database, and Exceed then uses this key to authenticate 
X applications. If you select the Enable User Access Control List 
option on the Security page in Xconfig, only X connections 
started by Xstart with the @m macro in the command line are 
accepted.

For example, type the following command to start xterm using 
Xauthority security: 

@m/usr/openwin/bin/xterm -sb -ls -display @d&@;

@: Inserts the display transport identifier. 

For example, type the following command to start xterm:

xterm -display @a@:0 &

@# Inserts the Display Number as configured on the Communication 
page in Xconfig. 

For example, type the following command to start xterm:

xterm -display @a@:@# &

@@ Inserts the @ character.
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Creating a Global Login
This feature lets you cache your password, so that during an Xstart session, 
you log in just once. The system caches the password until you either exit 
Exceed or manually empty the cache. For example, you may need to 
manually empty the cache if you are leaving your computer unattended for 
a long period of time.

To create a universal login:

For more information, see 
“Creating Startup Files” on 
page 31.

1 Create an Xstart file using Xstart.

2 In Xstart, click Options on the Tools menu. The Xstar t Global Options 
dialog box opens.

3 In the Login Macros area, do the following:

@# (Local Application method only) Inserts the Display Number.

@! (Local Application method only) Starts Exceed if it is not already 
running.

Macro Description
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For more information, see 
“User ID and Password 
Macros” on page 61.

• User ID (@u)—Type a global user name. @u or @U automatically 
inserts this default user ID in the Xstar t Information dialog box for 
each connection you make.

• Password (@p)—Type a global password. An asterisk displays for 
each character. @p or @P automatically inserts this default password 
in the Xstar t Information dialog box for each connection you make.

4 In the Password List area, create a password list by providing one or 
more host names and a corresponding user ID and password for each 
host.

5 Select an option from the Remember Password drop-down list.:

• No—The password is not remembered and must be typed for each 
connection.

• Until X Session Loaded Or X Server Exits—If the host recognizes 
the user ID and password, further connections to that host by the 
user ID do not require a password unless either the Xsession 
finishes loading or the Exceed X server exits.

• Until X Server Exits—If the host recognizes the user ID and 
password, further connections to that host by the user ID do not 
require a password unless the Exceed X server exits.

• Until X Server And Xstart Exit—If the host recognizes the user ID 
and password, further connections to that host by the user ID do 
not require a password unless both the Exceed X server and Xstart 
exit.

6 Ensure that the Warn On Insecure Connections check box is selected if 
you want a warning message to appear each time a user attempts to 
establish an unsecured connection using Exceed. If you do not select 
this option, this warning message does not appear.

To secure your connection sessions, Exceed offers Secure Shell 
encryption and authentication, which is available only if you purchase 
and install OpenText Secure Shell.

7 Click OK to close the Xstar t Global Options dialog box.

8 In Xstart, click Save on the File menu.
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To manually empty the password cache:

1 In Xstart, open an Xstart file by clicking Open on the File menu.

2 Click Options on the Tools menu. The Xstar t Global Options dialog box 
opens.

3 In the Password List area, click Delete All. This empties the cache, so that 
the next time you run or create an Xstart connection, the system 
prompts for a password.

Defining User ID and Password Macros
You can use a user ID and password macro to automatically provide your 
user ID or password.

To define user ID and password macros:

1 In Xstart, click Options on the Tools menu. 

For more information, see 
“User ID and Password 
Macros” on page 61.

2 In the Xstar t Global Options dialog box, type a user name and password 
in the Login Macros area. Macro @u (or @U) inserts the user name and 
macro @p (or @P) inserts the password automatically in the Xstart 
Information dialog box.

3 Continue to configure and save your Xstart file as appropriate.

Remembering Host Passwords
For a description of 
available password 
options, see “Creating a 
Global Login” on page 63.

Use the Xstart Global Options dialog box to specify the Remember Password 
state for a specific host, as well as user ID and password. To access this 
dialog box, click Options on the Tools menu in Xstart. After Xstart recognizes 
the login combination, it uses the appropriate Remember Password rule. 

Managing the Password List in Xstart
You can add or modify password entries for Xstart files.

Note: If you cannot browse, you may need to configure Host 
browsing in the Browse Hosts dialog box. In Xstart, click Settings 
in the Startup area. In the Xstart Settings dialog box, click the 
Other tab. On the Other page, click Configure for Hosts in the 
Browse Methods area. 
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To add or update password entries:

1 In Xstart, open an Xstart file by clicking Open on the File menu.

2 Click Options on the Tools menu. The Xstar t Global Options dialog box 
opens.

3 Specify values for the Host, User ID, and Password boxes. Next, select a 
rule from the Remember Password drop-down list box, and then click 
Add. If an entry already exists for the host and user ID you specified, you 
have the option of updating the entry when you click Add.

4 Click Yes in the confirmation dialog box that opens to apply your 
changes.

To delete password entries:

1 In Xstart, open an Xstart file by clicking Open on the Tools menu.

2 Click Options on the Tools menu. The Xstar t Global Options dialog box 
opens.

3 Do one of the following in the dialog box:

• To delete all password list entries, leave all boxes blank and click 
Delete All.

• To delete all password list entries for a specific user ID, specify the 
value in the User ID box and click Delete All.

• To delete all password list entries for a specific host, specify the 
value in the Host box and click Delete All.

• To delete all password list entries for a specific user ID on a specific 
host, specify the host in the Host box and the user ID in the User ID 
box and click Delete.

Password Expiry Prompts
Xstart detects UNIX password expiry prompts that require the user to 
change the password. This applies to Rlogin, TELNET, and Secure Shell 
start methods.
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Changing Hosts, IDs, and Passwords Across Multiple 
Files
You can change your host, user ID, and password across multiple Xstart files 
at the same time.

To change information across multiple files:

1 In Xstart, click Find And Replace in the Tools menu. The Find And Replace 
dialog box opens.

2 In the Location area, browse to the directory in which you want to 
perform your search. The User directory is selected by default. 

3 In the Find area, specify the item(s) you want to change using the Host, 
User ID, and/or Password boxes.

4 In the Replace area, specify your new information. If you are changing 
the password, you must type the new password in the Password box and 
then re-type it in the Confirm Password box.

5 Click one of the following buttons:

• Replace All—Lets you apply changes to all Xstart files meeting the 
defined criteria.

• Replace—Lets you apply changes to individual files.

6 In the Confirm Change dialog box that opens, review your proposed 
change(s) and use the Change, Next, or Change All buttons to apply the 
appropriate action to the specified Xstart file.

7 Repeat steps 2 – 6 as many times as necessary, then click Close in the 
Find And Replace dialog box.

Running Multiple Exceed Sessions
For detailed user interface 
information, see Exceed 
Help.

You can run multiple instances of the Exceed X server. If you open Exceed 
while another instance of Exceed is running, the Exceed Multiple Sessions 
dialog box opens. It prompts you to decide whether to run multiple sessions 
or to run just one session.
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If Do Not Prompt For Multiple Sessions is selected on the Common Settings 
page, or if the option was selected in a previous Exceed Multiple Sessions 
dialog box, then the Exceed Multiple Sessions dialog box does not open when 
subsequent Exceed sessions are run. To re-enable the appearance of this 
dialog box, clear the Do Not Prompt For Multiple Sessions check box on the 
Common Settings page.

To run another instance of Exceed, select Run Multiple Sessions on the 
Common Settings tab of the Display and Video page in Xconfig. If this 
option is not selected (and Do Not Prompt For Multiple Sessions is selected), 
then neither the prompt dialog box nor another Exceed session opens.

Starting Multiple X Clients or Windows Programs
Xstart is designed specifically for starting X clients. Local Application 
startup method lets you start any Windows application, including an FTP 
or TELNET session. If you use additional command line parameters 
supported by FTP and TELNET, you can create an Xstart file (and shortcut) 
that automatically connects to the host.

Using Xstart Commands
When creating an Xstart file, you can put multiple commands in the 
Command box in Xstart. This feature is useful for simultaneously starting 
X applications that you commonly use, such as expense reports, calendar, 
and e-mail applications. To use this feature, all of the X applications must 
reside on the same host. 

Using Xsession
Xsession sequentially executes a series of program/client startup files. It lets 
you create icons to run:

• Exceed using different initial window and startup modes

• multiple Xstart files

Note: You may need to edit the command line to accommodate a 
particular host. For example, each command is separated by a 
semi-colon. However, some UNIX hosts do not accept 
semi-colons.
68



Chapter 3: Advanced Connection Methods
Running Xstart from a Command Line
You can run Xstart from a command line to start an X client directly from a 
Windows shell. Use the following command line syntax in the Windows 
Run dialog box:

or

where:

• home is your User directory.  

• Settings.xs is the name of an Xstart settings file. If the Xstart file name 
is preceded by a path, Xstart searches that directory. Otherwise, it 
searches the User directory.

• items enclosed in [ ] are available options.

Command Line Options

Spaces within a command 
must be enclosed in 
double quotation marks: 
" ".

The following table describes command line parameters: 

home/xstart [-m Method] [-h Host] [-u UserID] [-p Password] 
[-c Command] [-l|-l-] [-t CloseTimeout] 

home/xstart Settings.xs [-m Method] [-h Host] [-u UserID] 
[-p Password] [-c Command] [-l|-l-] [-t CloseTimeout] 

Note: Options specified after the Settings.xs parameter 
override settings in the .xs file provided that the options are 
placed to the right of the file specification. If an .xs file is 
specified without command line options, Xstart uses information 
in the file to start the X client.

Parameter Description

-m Method Method can be REXEC, RSH, TELNET, RLOGIN, SSH, or 
local, each representing the supported startup method.

-h Host Host is the host to which you want to connect. Type either 
the host name or its network address. 

-u UserID UserID is the login name used to log in to the host.
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To start an xterm on a host called Sparcy, using REXEC:

To start an xterm on a host called Sparcy, using RSH:

To use the file xterm.xs located in the User directory to start an X client:

home\exceed\xstart xterm.xs

-p Password Password is the host password for the startup method.

-c Command Command is the action executed by the host. If the 
command contains spaces, it must be enclosed in double 
quotes (for example, “my command”).

-l|-l- Login Information prompt. Type either:

• (Minus sign, lowercase L) The Xstart Login Information 
dialog box opens at run time and prompts for a host, 
user ID, password, and command.

• (Minus sign, lowercase L, minus sign) Xstart does not 
prompt for login information.

-t CloseTimeout CloseTimeout is the number of seconds the remote 
execution facility socket remains open after the host has 
acknowledged receipt of the command.

Note: You can run multiple Xstart files simultaneously with 
Xsession. You can create an Xsession file (.ses) that includes 
multiple client or application startup files (.xs). You can also 
create a shortcut that lets you start the files included in the 
Xsession.

home\xstart -m rexec -h sparcy -u user -p abcdabcd -c "xterm -
ls -display pc:0&"

home\xstart -m rsh -h sparcy -u user -c "xterm -ls -display 
pc:0&"

Parameter Description
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Environment Variables

DISPLAY and PATH variables are often defined for the host session. For 
example, X clients use DISPLAY to determine which X server to use. You 
can specify these variables:

• on the command line

• for the current X window session

You can save the DISPLAY variable in the startup file (UNIX hosts: .cshrc 
for the C shell, or .profile for the Bourne shell). The startup file 
automatically sets any variables needed when a user logs in. To include your 
DISPLAY variable in the startup file, add the commands described in the 
next topic.

Setting the DISPLAY Environment Variable
You can specify the DISPLAY on the Xstart command line that starts the X 
client. The syntax is: 

-display mypcname:0 &

where mypcname is the IP address of the Exceed X server, and & indicates that 
the application should start in the background.

For the Current X Window Session
If you set the DISPLAY variable on the host, you have to specify it when you 
start a client. The command to set your DISPLAY variable depends on your 
shell.

Note: You may want to verify that the DISPLAY environment 
variable does not already exist in the host startup file. If DISPLAY 
has been set, it appears in the list of environment variables for 
your computer on the host.

To view this list, enter the command corresponding to your host:

• UNIX: "env" or "printenv" ("echo $DISPLAY" gives the current 
value

• VMS: "SHOW DISPLAY"
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C shells normally display a % prompt. 

setenv DISPLAY mypcname:0

Bourne shells normally display a $ prompt. 

DISPLAY=mypcname:0
export DISPLAY

Command Line Syntax for Starting X Clients

UNIX Hosts

If DISPLAY is not defined, you can start X clients using the following 
command line syntax:

[path/]application [parameters] -display mypcname:displaynumber &

If DISPLAY is defined, you can start X clients using this command line 
syntax:

[path/]application [parameters] &

VMS Hosts

You can specify DISPLAY on the client startup command only if you are 
using Xstart with certain command line syntax shown missing. Otherwise, 
you must define DISPLAY on the host.

If DISPLAY is defined, you can start X clients using this command line 
syntax:

RUN SYS$SYSTEM:DECW$application

Note: If you are running Open Windows on a Sun Sparcstation, set 
the following environment variables after setting the display:

OPENWINHOME=/usr/openwin

LD_LIBRARY_PATH=/usr/openwin/lib

For both variables, replace usr with the directory on the host 
where the X Window system files are located.
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For example:

RUN SYS$SYSTEM:DECW$CLOCK

About Xsession

See page 75 for a sample 
Xsession Window.

Xsession lets you start multiple X clients or Windows programs (including 
TELNET, TN3270, and FTP settings files) simultaneously. Each Xsession file 
(.ses) references multiple Xstart startup files (.xs), each of which is 
configured to automate the process of accessing hosts and starting 
applications. Therefore, before starting an Exceed session using Xsession, 
you must create an Xstart file for each X client and Windows application 
that you want Xsession to start. The information required by individual 
programs resides in the Xstart files associated with the Xsession file.

Windows 7 users can pin 
specific Xsession files to 
the Xsession jump list. 

When you run an Xsession file, the .xs files run in the order specified. You 
can indicate whether you want to start the Exceed X server when you run 
the Xsession file. If so, you can also specify the initial window and startup 
modes. You can install a shortcut that lets you run the files included in the X 
session.

Note: There is no space after the colon (:) in the specified 
command line.
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Using Xsession with Profile Spaces
If your installation of Exceed includes the Profile Space feature, and the 
Exceed administrator has made the feature available, then you can use any 
available Profile Space to save and run Xsession files. 

Running Multiple Xstart Profiles
To run multiple connections, create an Xsession file. Xsession lets you 
combine .xs files into a single .ses file that starts multiple X clients or 
Windows programs (including HostExplorer, TN3270, and FTP settings 
files) simultaneously.

In Xsession, click Options on the Tools menu. In the Xsession Options dialog 
box, you can specify the following:

• Whether the Exceed X server lists the file in its Session Star tup submenu 
(accessible by clicking Tools on the Exceed menu) and the Exceed 
toolbar Session Star tup button.

• Whether Exceed automatically starts before running the clients or 
programs.

• If you want Xsession to start the Exceed X server automatically, you can 
also specify the initial window and startup modes.

Note: 

• Using the GlobalExceed.ini file, which is located in the 
Global User directory, administrators can enable or disable 
profiles spaces for all users, or allow users to enable it if 
required. 

• Xstart startup files (.xs) referenced by an Xsession file (.ses) 
must reside in the same Profile Space as the Xsession file.
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You can create different 
Xsessions to run different 
window managers 
simultaneously.

Xsession provides other useful options such as specifying a configuration 
file with custom settings, window modes, and startup modes. If you select 
these settings within Xsession, they override Xconfig settings.

Entering Startup Information
You may find it useful to create Xsession files that just start the X server with 
a specific startup mode and window mode. This lets you install custom 
icons to start the X server in different ways and to selectively override the 
default settings in Xconfig.

The Xsession displays information about Xstart files in the current Xsession.  

Note: 

• By default, all Xsession files are saved in the Profile directory 
for the currently logged in user, but you can specify another 
location. The .ses file extension is appended automatically.

• If your installation of Exceed includes the Profile Space feature, 
then you can use any available Profile Space to save and run 
Xsession files. Xstart startup files (.xs) referenced by an 
Xsession file (.ses) must reside in the same Profile Space as 
the Xsession file.
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For information on creating 
an Xstart file, see “Creating 
Startup Files” on page 31.

Use the Up and Down arrows in the Actions column to rearrange the 
Xsession startup sequence. Use the X in the Actions column to delete an 
Xstart file from the current Xsession. Use the Pencil in the Actions column 
to open the Xstart file for editing.

For more details about 
Xsession menus, see 
Exceed Help.

File menu commands let you create new Xsessions, open existing Xsessions, 
save Xsessions, and create shortcuts. View menu commands let you toggle 
the toolbar (on or off), set button size, or reload (update and redraw) the 
list of available Xstart files. This is useful if you are adding or deleting Xstart 
files while running Xsession.

Actions menu commands let you add Xstart files to the current Xsession, 
modify existing Xstart files, and remove Xstart files. Repair Xstar t lets you 
find and select a file which the application cannot locate (for example, if it 
was moved, deleted, or renamed since it was first added to the Xsession). 
The missing file is replaced by the selected file. You can also rearrange Xstart 
files.

Tools menu commands let you reload your Xsession or open the Xsession 
Options dialog box.
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Xstart Launch Interval 
applies to Xstart programs 
only. Local applications are 
started immediately. 

Use the General area to specify the interval between the startup of each 
Xstart file.

You can type a Session Description (up to 40 characters) which becomes the 
caption for the Session Star tup menu command (and the menu that displays 
when you click Client Star tup on the Exceed toolbar). To create this 
command, select Show On Exceed Star tup Menu. If you did not specify a 
Session Description, Xsession uses the file name (without the extension) for 
the (menu command) caption.

Xsession settings override 
the defaults in Xconfig.

The Run X Server option starts Exceed automatically when the Xsession file 
is run. To restart the server with the server options specified in the Xsession 
file before running any programs, select Prompt For Server Restar t. You can 
specify an Exceed X server configuration file.

You can specify further overrides under Startup Option Overrides. Select 
Single, Multiple, or Default (whatever is specified on the Xconfig Screen page) 
window mode. If the window mode is Multiple, select a window manager. 
Select a startup mode (Default is the mode specified on the Xconfig 
Communication page). If XDMCP Query or XDMCP Indirect is selected, specify 
the network address of the connect host.

Working with Xsession

To create or modify an Xsession file:

1 In Xsession, do one of the following:

• To create an Xsession file—Click Add Xstar t at the bottom of the 
Session Contents area to locate and select a .xs file. Repeat as 
necessary.

• To modify an Xsession file—Click Open on the File menu to locate 
and select a .ses file.

2 Use the icons in the Session Contents area to edit, remove, or rearrange 
your .xs file(s).

Warning!  To apply the new Xsession settings, you must restart the 
server. 
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3 On the File menu, click Save. Xsession files are automatically saved with 
an .ses extension in one of the following locations:

• By default, all Xsession files are saved in the Profile directory.

• If your installation of Exceed includes the Profile Space feature and 
the Exceed administrator has made it available, then you can use 
any available Profile Space to save and run Xsession files. Xstart 
startup files (.xs) referenced by an Xsession file (.ses) must reside 
in the same Profile Space as the Xsession file.

To specify options for the current Xsession file:

1 In Xsession, click Options on the Tools menu. The Xsession Options 
dialog box opens.

2 In the General area, do the following as necessary:

• To change the time between startup of .xs files, modify the Xstart 
Launch Interval setting. The default value is 2 seconds.

• To provide a brief description of the current Xsession file, use the 
Session Description box. This description becomes the caption for 
the file when it appears on the Session Star tup menu (accessible by 
clicking Tools on the Exceed menu). If you do not provide a 
description, Xsession uses the current Xsession file name as the 
caption.

• Use the Parameters For Xstar t box to add command line parameters 
to the selected Xstart file. For more information, see “Running 
Xstart from a Command Line” on page 69.

• To list the current Xsession file on the Session Star tup menu for 
Exceed, select Show On Exceed Startup Menu. If you select this 
option, the file also appears in the list that appears when you click 
Session Star tup on the Exceed toolbar.

The file is displayed with the caption as specified by the Session 
Description box mentioned above. For information on how to access 
the Session Star tup menu, see the previous bulleted item.

• To launch a new Exceed session for each Xsession profile you run, 
select Launch New Exceed Session. Exceed launches a session with 
an incremented display number for each new Xsession.
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3 If you want to automatically start the Exceed X server with your 
Xsession file, do the following:

a) Select Run Exceed X Server.

b) In the Exceed Configuration area, specify the Xconfig file that you 
want your Xsession file to run.

4 In the Star tup Options Overrides area, select the appropriate startup 
options for your Exceed sessions. These options override the defaults in 
Xconfig.

5 If you want Xsession to prompt for confirmation before restarting the 
server (each time the file is run), select Prompt For X Server Restar t.

6 Click OK to apply your changes and close the Xsession Options dialog 
box.

7 In Xsession, click Save on the File menu. Xsession files are automatically 
saved with an .ses extension in one of the following locations:

• By default, all Xsession files are saved in the Profile directory.

• If your installation of Exceed includes the Profile Space feature and 
the Exceed administrator has made it available, then you can use 
any available Profile Space to save and run Xsession files. Xstart 
startup files (.xs) referenced by an Xsession file (.ses) must reside 
in the same Profile Space as the Xsession file.

Xsession File Sequence
To troubleshoot a 
connection, see “Exceed 
Diagnostics” on page 265 
and “Chapter 2: 
Connecting to Hosts and 
Running X Clients” on 
page 11.

The following describes the sequence of events when you run an Xsession 
session. You can use this information to help you troubleshoot connection 
issues.

1 If Run Exceed X Server is selected in the Xsession Options dialog box 
(accessible by clicking Options on the Tools menu in Xsession), and the 
X server was not previously started, the X server starts.

If the X server is already running and you selected Prompt For X Server 
Restar t, Xsession prompts you to restart the server.
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2 The pause between the start of profiles corresponds to the Xstar t Launch 
Interval specified in the General area of the Xession Options dialog box. 
Profiles start according to the order listed in the Session Contents area of 
the Xsession file (.ses).

Starting Multiple Exceed X Servers
The easiest way to startup multiple, simultaneous instances of the Exceed 
X server is to use Xsession.

To start multiple Exceed X servers:

1 In Xsession, click Options on the Tools menu. The Xsession Options 
dialog box opens.

2 In the Session Description box, provide a description for the current 
Xsession file. For more information on how this description is used, see 
“Working with Xsession” on page 77.

3 Select Run Exceed X Server.

4 Click OK to save the session and close the Xsession Options dialog box.

5 In Xstart, create and save a profile (specifying Local Application as the 
startup method) for each instance of the Exceed X server. For each 
profile, ensure that:

• the command line is fully specified or that settings in Exceed.xcfg 
are suitable

• a unique display number is used for each instance

Note: 

• Multiple X display support has certain restrictions. For more 
information, see Multiple X Display Support.

• If your installation of Exceed includes the Profile Space feature 
and the Exceed administrator has made it available, then you 
can use any available Profile Space to save and run Xsession 
files. Xstart startup files (.xs) referenced by an Xsession file 
(.ses) must reside in the same Profile Space as the Xsession 
file.
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6 In Xsession, add the Xstart profiles to your Xsession file by clicking Add 
on the Actions menu.

7 Save your Xsession file by clicking Save or Save As on the File menu. 
Optionally, create a shortcut to enable a double-click startup of the 
session by clicking Create Shor tcut on the File menu.

Exceed Display Controller Console
For more details about the 
Exceed Display Controller 
Console, see Exceed Help.

Display numbers are used for differentiating between multiple instances of 
Exceed and are required to correctly map X server input and output. The 
Exceed Display Controller Console (a Microsoft Management Console 
plug-in) provides an interface for setting parameters that control display 
numbers in the Display Manager.ini file. The left pane displays a tree of 
the types of display number settings, which can be expanded to view 
various options. Select an option to view settings in the right pane.

For more information about Microsoft Management Console, consult the 
Microsoft Windows documentation.  

Common Desktop Environment (CDE)

A handshake is an activity 
that keeps two computers 
or programs synchronized 
(such as the CDE display 
manager and the X 
protocol). It usually 
involves the exchange of 
messages or packets of 
data between two systems.

When you log in to the UNIX host via the CDE display manager using 
XDMCP, a handshake implemented by the X protocol is employed. CDE 
does not begin unless it detects a supported X server (that is, Exceed). 

Note: Exceed Display Controller Console is available only for 
terminal servers/remote desktop servers that are running 
Windows Server 2008 (32 and 64 bit), Server 2008/2012 R2 (64 
bit).
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To start CDE:

1 Ensure CDE is configured properly on a UNIX host.

2 In the left pane of Xconfig, click Display and Video. On the Screen page 
that opens, select either the Multiple or Single window mode.

3 In the left pane of Xconfig, click Communication. On the Communication 
page that opens, select XDMCP Broadcast from the Mode drop-down list.

4 Click Save.

5 Start Exceed.

6 From the XDMCP Display Manager Chooser, select a UNIX host, and click 
OK. The greeter opens.

7 Log in to the UNIX host.

The CDE session manager starts and the interface displays on your 
computer.

Using Desktop Environments for Linux
There are two main types of X Graphical Desktop Environments in Linux. 
Depending on which one you chose when you installed Linux, either KDE 
or GNOME is set as the default desktop.

• KDE—K Desktop Environment uses KWin as its window manager.

• GNOME—GNU Network Object Model Environment works with 
window managers such as Enlightenment, Sawmill, and Window 
Maker.

Note: If you select multiple window mode and you are using the 
Windows (native) window manager, verify that the Cascade 
Windows option is not selected.
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KDE and GNOME run on a Linux host and are displayed on the remote 
computer using standard X protocol.

Running Multiple CDE Sessions
Running multiple CDE sessions requires passing command line parameters 
to Exceed.exe.

To create multiple Xstart sessions (each with specific command line 
parameters):

1 In Xstart, create an Xstart file by selecting Local Application as the 
startup mode, and click Settings. The Xstar t Settings dialog box opens.

2 In the General area of the Other page, provide an explanation or label 
(such as CDEHostA) in the Description box, and click OK to close the 
Xstar t Settings dialog box.

3 In Xstart, specify the exceed.exe command and its appropriate 
parameters in the Command box.

For example:

exceed.exe -d l -m query -h host -w single -n session

where:

-d 1 specifies the display number

-m query specifies the startup mode

-h host specifies the connect host

-w single specifies the window mode

-n session specifies the session name that appears in the title bar 
(single window mode)

Note: For GNOME sessions using EsounD, you need to grant 
access to port 16001 in the Windows Firewall Settings. For 
Windows 7 and later, you must disable EsounD on the host or 
install an EsounD server from a third party provider. For detailed 
information on this issue, refer to the Release Notes.
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4 Click Run on the Action menu to test the startup file. If the session runs 
successfully, close the Exceed window, and then save the startup file by 
clicking Save or Save As on the File menu.

5 On the File menu, click New. Repeat steps 3 and 4 for each startup file. 
Be sure to type a unique description (such as CDEHostB, CDEHostC, 
and so on) for each session.

To run Common Desktop Environment (CDE) sessions with Xsession:

You can also add files by 
dragging and dropping 
.xs files into the Session 
Contents list.

1 In Xsession, click Add on the Tools menu to add Xstart files (.xs) to 
your Xsession. Xsession lists the files in Session Contents.

2 If necessary, use the Xsession Options dialog box (accessible by clicking 
Options on the Tools menu in Xsession) to make additional changes to 
your Xsession file. You can also modify or reorder your Xstart sessions 
within Xsession by using the Modify, Move Up, or Move Down buttons. 
For more information, see “Working with Xsession” on page 77.

3 Click Run on the Tools menu to test the CDE sessions.

4 If the Xstart sessions run successfully and you are satisfied with how the 
overall Xsession runs, click Save on the File menu. Optionally, create a 
shortcut to enable a double-click startup of the session by clicking 
Create Shor tcut on the File menu.

Securing Connections

OpenText Secure Shell
To secure your connection sessions, Exceed offers Secure Shell encryption 
and authentication, which is available only if you purchase and install 
OpenText Secure Shell. OpenText Secure Shell is a client implementation of 
the Secure Shell protocol (SSH-2).

To make an Exceed X Window session secure, specify Secure Shell as the 
startup method in Xstart. The connection parameters specified in Xstart are 
used to establish a Secure Shell tunnel to the target host:

• Host
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• User ID

• Authentication Method

For more information, consult the OpenText Secure Shell documentation.

Kerberos
This option is available only for the TELNET startup method. Select this 
option to enable use of Kerberos V5, and to select and configure options.

Kerberos is an authentication service developed at MIT for open network 
computing environments. Kerberos works by assigning a key, called a ticket, 
to each user that logs on to the network. The ticket is then embedded in 
messages to identify the sender of the message.

For more information, refer to OpenText Kerberos Help.

X11 Authentication
For certain environments, user-level security is controlled by a binary file, 
.Xauthority. It contains cookies that associate an IP address with a binary 
value. When an X11 application runs, the file is accessed and then the 
appropriate cookie is extracted and sent to the X server (typically located on 
another computer). If the X server accepts the cookie, then the connection 
succeeds.

For more information, see 
“OpenText Secure Shell” 
on page 84. 

For a higher level of security, consider using OpenText Secure Shell (a client 
implementation of the SSH-2 Secure Shell protocol) for X11 tunnelling and 
port forwarding. This product is a TCP-based client/server protocol that 
provides authentication, encryption, and data integrity. 

X11 authentication options in Secure Shell interact with Exceed. When an 
unknown X client tries to connect, Exceed prompts for a decision to allow 
or refuse the connection. Allowing the connection depends on whether the 
X client is trusted or untrusted.
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Password Aging
Password aging is a common tool used to ensure a modest level of security. 
Changing the password periodically reduces the potential damage caused by 
intruders who gain access to the network by using stolen user credentials. 
However, frequent password change also inconveniences end-users and 
reduces productivity because, in some cases, the passwords are stored in 
many application profiles. Users must manually replace the aged password 
with the new password.

For more information, see 
“Password Expiry 
Prompts” on page 66.

Exceed can handle password aging events and automatically propagate the 
changes to Xstart profiles. Users do not have to manually update Xstart 
profiles with the new password. Xstart detects UNIX password expiry 
prompts that require the user to change password. This applies to Rlogin, 
TELNET, and Secure Shell start methods.
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About Xconfig and its Mandatory Settings

This section describes Xconfig, a utility for configuring Exceed settings. The 
settings are used when you run an X client. 

Which settings you can configure in Xconfig
The default Xconfig settings suit most systems. Typically, changes you make 
in Xconfig take effect immediately. In some cases, Exceed displays a message 
indicating that the setting cannot be updated until the server is reset. Note 
that a server reset terminates all X clients.

Xconfig enables you to configure the following settings: 

Settings for... See more...

Input Devices

Communication

Security

Display and Video

X Selection

Fonts

Open GL

X Protocol

Performance

Troubleshooting

Power Management 

System Administration

Accessibility

• Configuring your keyboard

• Configuring Communication Settings

• Configuring Security Settings

• Configuring Display and Video Settings

• Configuring the Copy, Paste, and X Selection

• Configuring Fonts

• Configuring OpenGL settings for Exceed 3D and 
GLX

• Configuring X Protocol Settings

• Configuring Performance Settings

• Configuring Troubleshooting Settings

• Configuring Power Management Settings

• Configuring System Administration Settings

• Configuring Accessibility Settings
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 XconfigMandatory Settings
Xconfig mandatory settings lets administrators lock certain individual 
settings so that users cannot change them. By default, all settings are 
initially available for configuration. This option is available only for 
Administrators or users with elevated (administrative) privileges.

To lock certain settings and options from within Xconfig:

From the Xconfig File menu, select Mandatory Settings. When this option is 
selected, a green lock icon appears for all the Xconfig settings. 

To toggle between unlocked and locked state, click the lock icon. 

• unlocked (green lock) and 

• locked or mandatory (red lock)

Locked (mandatory) settings are saved to Mandatory.xcfg (located in the 
Global directory).

Viewing or modifying configuration files created with Xconfig 

This section contains the following topics: 

• “Location of default Exceed.xcfg file” on page 92

• “Accessing an Xconfig file” on page 93

Location of default Exceed.xcfg file
The default configuration file (Exceed.xcfg.) is a per-user file. Per-user files 
affect only the user who is making the change (the user who is currently 
logged in). For example, if you configure Exceed.xcfg to use a certain 
display, other users of the machine are not affected. 

The default location for per-user files is:

C:\Users\Username\AppData\Roaming\Hummingbird\
Connectivity\version\Exceed
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where Username is the name of the user and Version is the version number 
of your OpenText product.

Accessing an Xconfig file
This section describes how to access an Xconfig file, using the command 
line or the Xsession utility. 

To view or modify an Xconfig file using the command line: 

• Specify /f and the full path to the configuration file on the Exceed 
X server command line.

To view or modify an Xconfig file from Xconfig:

1 Start Xconfig. See “Starting Xconfig and displaying the relevant 
settings” on page 95. 

2 From the File menu, select Open. A dialog box is displayed. It allows you 
to locate and select a configuration file (*.xcfg).

To specify an Xconfig file in the Xsession utility:

1 Right-click the Exceed icon in the taskbar. From the menu that is 
displayed, select Xsession. 

The Xsession utility is started.

Note: Each user of the product on the machine receives a 
personal User directory located in the product subfolder. See 
“User Files” on page 8. 
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2 From the Tools menu, select Options. The Xsession Options dialog box is 
displayed. 

3 Under Exceed Configuration, in the Xconfig File box, specify the 
configuration file. You may also click the Browse button, to browse for 
the file. 

4 Select  Prompt For X Server Restar t. 

5 Click OK. 
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Starting Xconfig and displaying the relevant settings

This section describes how to start the Xconfig utility. 

Starting Xconfig
To start the Xconfig utility:

1 Right-click on the Exceed icon in taskbar. 

2 From the menu that is displayed, select Xconfig. The utility is started. 

Accessing Xconfig categories of settings
This section describes how to access the Exceed settings you want to modify 
in Xconfig.   

To access the configuration settings you want to modify: 

1 Start Xconfig. By default, the Xconfig main page (Input Devices) is 
displayed. 

2 Click the relevant item in the Xconfig left pane. For example, to display 
Communication settings, click Communication, in the left pane. 
Alternatively, start Xconfig, display the Settings menu, and select the 
menu option of your choice. For more details about all available menus, 
see “Using Xconfig menus” on page 95. 

Using Xconfig menus

This section lists the Xconfig menus and their options. 

The following menus are available: 

• “File menu in Xconfig” on page 96

• “Settings menu in Xconfig” on page 96

• “Actions menu in Xconfig” on page 97

• “Help menu in Xconfig” on page 98
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File menu in Xconfig   
This section describes the File menu options in Xconfig. 

Menu option Description

Open Opens a dialog box for locating and selecting a 
configuration file (*.xcfg).

Save Saves the modifications you made. 

Save As Opens a dialog box for saving the current 
configuration file under a new name. By default, 
Exceed.xcfg is the configuration file name.

Mandatory Settings Displays icons beside certain settings and options that 
system administrators can lock (make mandatory), or 
unlock. This option is available only for Administrators 
or users with administrative privileges.

To toggle between unlocking or locking an option or 
setting, click the icon next to this option or setting. 

Exit Saves any changes made to the current configuration 
file and exits Xconfig.

Settings menu in Xconfig 
This section describes the Settings menu options in Xconfig.  

Note: Green lock indicate that the option or setting is 
not locked. Red icon indicates the locked option or 
setting. For more details, see “Xconfig Mandatory 
Settings” on page 203

Menu option Description

Keyboard Input Display the Keyboard Input tab of the Input Devices 
page. 

Mouse Input Display the Mouse Input tab of the Input Devices page. 

CJK Input Display the CJK (Chinese/Japanese/Korean) Input tab 
of the Input Devices page. 

Communication Display the Communication page. 

Security Display the Security page.
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Actions menu in Xconfig 
This section describes the Actions menu options in Xconfig. 

Menu option Description

Launch Exceed With 
Current Settings

Launches a new instance of Exceed using the current 
settings.

Change My Password Opens the Xconfig Password dialog box. Enter your 
old password and the new password, and confirm the 
change. See “Restricting Access to Xconfig” on 
page 197.

Restore To Default 
Settings

Restores default settings (the settings in Exceed.xcfg).

Add Screen Adds screens (up to 4, the initial screen being 0).

Remove Screen Removes the highest numbered screen (except for 
Screen 0, which is the initial screen).

Screen Definition Display the initial (Screen) tab of the Display and Video 
page in Xconfig. 

Video Display the initial (Screen) tab of the Display and Video 
page in Xconfig. 

X Selection Display the X Selection page. 

Font Display the Font page. 

OpenGL Display the OpenGL page. 

Protocol Displays the X Protocol page. 

Performance Displays the Performance page. 

Troubleshooting Displays the Troubleshooting page. 

Power Management Displays the Power Management page. 

System Administration Displays the System Administration page. 

Accessibility Displays the Accessibility page. 

Menu option Description
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Help menu in Xconfig
This section describes the Help menu options in Xconfig. 

Menu option Description

View Help Launches the Help file for Xconfig. You may select the 
option or press the F1 function key on the keyboard. 

 About Xconfig Display the information about Xconfig. 

 Configuring your keyboard

This section describes the Input Devices settings for your keyboard, and 
how to modify them. 

This section contains the following topics: 

• “Which keyboard settings you can configure” on page 99

• “Primary or Alternative keyboard settings” on page 99

• “Window Modifiers Behavior for Your Keyboard” on page 100

• “Keyboard Hook” on page 101

Keyboard files are provided. They contain keyboard layout and symbol 
mappings. Keyboard files are stored in the User directory and have a .kbf 
extension. See “User Files” on page 8. 

Exceed support international keyboards. See “International Keyboards” on 
page 1. Where the keyboard file name differs from the name of the country, 
the file name appears in parentheses ( ) beside it. 

Note: If you are running a Chinese, Japanese, or Korean (CJK) 
Windows operating system (provided Microsoft IME is installed 
and enabled), the Input Devices include a settings page for CJK 
input.
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• To customize your keyboard further, you will need to use the XKeys 
utility. See “Using the XKeys Utility to Customize the Keyboard” on 
page 102.

Which keyboard settings you can configure
Use the Keyboard Input tab of the Input Devices page to configure:

• Keyboard Mapping—customize the current keyboard file, select an 
alternative keyboard file, or allow clients to modify keyboard mapping). 
For detailed customizing of keyboard files, you will need to use the 
XKeys key mapping utility. 

• Windows Modifier Behaviour—map Shift and Alt keys for Exceed; 
associate keyboard keys with X keysyms and compose key sequences.

• Other—select whether Keyboard Hook is used

Primary or Alternative keyboard settings 

This section describes how to select a primary or alternative keyboard file, 
and configure whether Exceed users can modify them on their computers. 

• By default, Exceed automatically detects an existing keyboard as the 
primary keyboard (automatically determines the keyboard defined in 
Windows Control Panel). 

To configure the Primary or Alternative keyboard mappings:

1 Ensure that you have a copy of the original keyboard file, as a 
precaution. 

2 In the left pane of  Xconfig, click Input Devices. The Keyboard Input tab of 
the Input Devices page is displayed.

Note: By default, keyboard files are stored in the User directory 
and have a .kbf extension.If you are not using a supported 
keyboard, or if you are using a keyboard without a separate cursor 
keypad and 12 function keys, you can create a custom keyboard 
file to interact with Exceed.
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3 Under Keyboard Mapping, select the Primary and/or Alternate keyboard 
file you want to use. 

• The Primary box displays the name of the current primary keyboard 
file. 

• The Alternate box displays the name of the current alternative 
keyboard file. Displays the name of the alternate keyboard file. By 
default, the U.S. English keyboard us.kbf is used.

4 Perform the task of your choice: 

• To change the individual settings of either the Primary or Alternate 
keyboards, click Edit. To change the individual settings of a 
keyboard file not listed in the lists, Browse to the file, and then click 
Edit. 

The XKeys key mapping utility is displayed. Customize the file as 
desired, and save the changes. See “Using the XKeys Utility to 
Customize the Keyboard” on page 102. See also “Modifying a 
Keyboard File” on page 105.

• To allow users to modify keyboard files from their computers, select 
Allow Clients To Modify Keyboard Mapping. 

You may now proceed to configure the Windows Modifier Behavior. 

Window Modifiers Behavior for Your Keyboard
This section describes how to associate keyboard keys with X keysyms, and 
compose key sequences. 

1 In the left pane of Xconfig, click Input Devices. The Keyboard Input tab of 
the Input Devices page is displayed. 

2 Under Windows Modifier Behavior, define how the Alt keys, Windows 
key, and Shift keys are interpreted by Exceed. The drop-down list box 
lists the following options for each key type:

To Windows—causes the left and right keys to be sent through to 
Windows. 

To X—causes the left and right keys to be sent through to X. 

Left To Windows, Right To X—causes the left key to be sent through 
to Windows and the right key to be sent through to X.
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Right To Windows, Left To X—causes the right key to be sent through 
to Windows and the left key to be sent through to X.

• Alt Key—Defines whether Alt key sequences are directed to 
Microsoft Windows or to X Window clients. On keyboards that 
contain two Alt keys, use the Left To/Right To options to assign the 
Alt keys on the left and right-hand side of the keyboard separately. 

• Windows Key—Defines how the Windows keys on your keyboard 
are interpreted by Exceed. You can choose from the same options as 
listed for the Alt key. Each Windows key can control a different 
function.

• Shift Key—Defines how the Shift keys on your keyboard are 
interpreted by Exceed. The drop-down list box lists the following 
options: 

Map Both Left And Right—causes the left and right Shift keys to be 
treated separately. 

Map Left As Right—any time you press a Shift key on your keyboard, 
it is treated as a Right Shift. 

Map Right As Left—any time you press a Shift key on your keyboard, 
it is treated as a Left Shift.

Keyboard Hook
This section describes the Keyboard Hook option. 

Note: The Windows key does not exist in the default keyboard file. 
To map the Windows key, you must add it manually. See Adding a 
Physical Key for more information.
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• Use Keyboard Hook—Ties Exceed into the system keyboard. When 
switching the focus from a desktop application and to an X window, 
Exceed informs the X application about the corrected keyboard state.

Using the XKeys Utility to Customize the Keyboard

This section describes how to use the XKeys utility to configure keyboard 
files. The XKeys utility simplify the process of  keyboard files mapping.

This section contains the following topics: 

• “About the Xkeys Utility” on page 102

• “Modifying a Keyboard File” on page 105

• “Mapping a New Keysym to an Existing Key” on page 106

• “Deleting a Keysym Mapped to a Key” on page 108

• “Mapping a Macro to an Existing Key” on page 109

• “Macro Events” on page 109“Creating Compose-Key Sequences” on 
page 110

• “Managing Keysyms and Keysym Sets” on page 110

• “PrintScrn Key Support” on page 111

• “Adding a Physical Key” on page 112

• “Deleting a Physical Key” on page 113

About the Xkeys Utility
This section describes XKeys utility. This key-mapping utility is used to 
simplify the process of keyboard files mapping. It has been designed to 
communicate with an X protocol host. 

Warning!  Certain desktop applications (such as screen readers) 
do not work properly if Use Keyboard Hook is selected. If you 
want to enable the accessibility feature, you need to clear the Use 
Keyboard Hook option. See “Configuring Accessibility Settings” 
on page 198.
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The following changes are transparent to the X protocol:

• modify any basic keyboard layouts to send an X Window-supported 
character or string of characters using user-defined keystrokes 

• define the sequences that simplify entering accented keys (using  
Compose Key options)

• customize keyboard and mouse options and preferences in the Xconfig 
Input Settings dialog box 

• customize or create new keyboard layouts 

To open the XKeys utility:

1 In Xconfig, display the Keyboard Input tab of the Input Devices page. 

2 In the Keyboard Mapping area, select a .kbf file, and then click Edit (the 
button is available for either the Primary or Alternate keyboard files). The 
XKeys mapping utility is displayed. 

3 To load a different keyboard file so that you can modify it:

• From the XKeys File menu, select Open. This will allow you to locate 
and select the file. 

• Back up the file, before modifying it. From the File menu, select 
Save As. This ensures that the original file is intact if you need to 
revert to it.

Note: Back up a keyboard file before modifying it. Start the XKeys 
utility, and from the File menu select Save As. name the new copy 
of the file. This ensures that the copy of the original file remains 
intact, in case you need to revert to it.

Note: Every key you want to use must be defined in your keyboard 
file. To define a key, describe the symbol(s) it can generate in the 
No Shift, Shift, Mode Switch, and Shift Mode Switch states. The 
key definition is represented by a keysym (key symbol) 
hexadecimal value corresponding to the symbol generated in a 
specific state. An undefined key symbol does not function in any 
X application.
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To use different modes of XKeys configuration: 

1 From the View menu, select the Mapping Mode or the Layout Mode. 

• Mapping Mode—Allows you to customize a keyboard file, associate 
X Keysyms to keys,  compose key sequences, and build macros. 

• Layout Mode—Allows you to customize a keyboard file by adding or 
repositioning physical keys. Use this mode to create a new layout, or 
modify an existing one.

2 Proceed to modify the keyboard file. Note that you can accommodate 
non-standard keyboards by manually editing the keyboard text file or 
by using XKeys.
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Modifying a Keyboard File
This section describes how to customzie your keyboard, by modifying an 
existing keyboard file. 

The following table describes various scenarios for modifying a keyboard 
file:

Note: Create a backup of the original keyboard file before you 
customize it. After you load the file into XKeys, click Save As from 
the File menu and specify another file name. This ensures that the 
original file is intact if you need to revert to it.

You want to.. Details 

Make a key on your 
keyboard generate a 
particular X Keysym

Map the Keysym to a key on your keyboard.See topic 
“Mapping a New Keysym to an Existing Key” on 
page 106

Send multiple Keysyms 
to the remote host, using 
a single key

To forward multiple Keysyms, create a macro or a 
string of symbols, and map it to a key.See “Mapping a 
Macro to an Existing Key” on page 109.

Generate a special 
Keysym that consists of 
an unknown accented 
character

To generate a special Keysym, define a compose-key 
sequence to forward that special Keysym to the 
remote host. See topic “Creating Compose-Key 
Sequences” on page 110.
105



OpenText™ Exceed™ User's Guide
Mapping a New Keysym to an Existing Key
This section describes how to modify the mapped key on your keyboard to 
generate a different Keysym. Click Mapping on the XKeys Edit menu (in 
Mapping Mode only) to display a mapping dialog box.

For example, change the current Keysym mapping of the Backspace key to 
any of the following:

• the delete Keysym

Resolve the situation 
where your keyboard 
does not have a 
separate cursor keypad

Map existing keys to generate the symbols on a cursor 
keypad. 

Create a keyboard file 
for mathematical 
symbols or for other 
Keysyms that are not 
available

Use Keysym File Editor to add custom Keysyms and 
create new Keysym Sets.See “Managing Keysyms and 
Keysym Sets” on page 110.

Create a keyboard file 
for mathematical 
symbols or for an 
alphabet (such as 
Arabic, Cyrillic, Greek, 
and Hebrew)

Create a new keyboard file using the New command 
on the XKeys File menu and map the symbol to each 
key.

Use extra keys on your 
non-standard physical 
keyboard to send 
Keysyms to a remote 
host

To add a physical key to a keyboard file, you must 
change the layout of the keys.See “Adding a Physical 
Key” on page 112.

Note: You cannot map a Keysym to a non-standard key unless 
you have included it by changing the layout of the keyboard file. 
For more information, see “Adding a Physical Key” on page 112.

You want to.. Details (Continued)
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• a special character (such as æ or þ) defined in a compose-key sequence 

To map a new Keysym:

1 In the left pane of  Xconfig, click Input Devices. The Keyboard Input tab is 
displayed. 

2 Select a primary or alternate keyboard file, and click Edit. 

3 Select the key that you want to map. Do so by clicking the key in the 
XKeys window (Mapping Mode) or pressing the corresponding key on 
your keyboard. You can view the current mappings in the Mapping For 
Key Labelled: Keysym group box.

4 Select Mapping on the Edit menu. An XKeys mapping dialog box opens. 
You can view the current mappings for the key you specified in the 
Mapping For Key Labelled: Keysym group box.

5 Click any of the following states: Unshifted, Shifted, Mode Switch, Shift 
Mode Switch. To delete the current mapping for this state, click Clear 
Mapping.

6 Select a Keysym Set from the Symbol Set list. Each Keysym Set contains 
a different list of Keysyms, which are displayed in the Keysyms list.

7 Select the Keysym that you want to map to this key in the Keysyms list 
and click Select Keysym. The mapping is changed for the state you 
selected earlier.

Note: You can map a compose-key sequence in the X Compose 
Mapping dialog box. The X Compose Mapping dialog box has the 
same functionality as the XKeys mapping dialog box.

Note: If you do not know which Keysym Set a Keysym belongs to, 
you can search for it by entering the Keysym in the Search box 
and clicking Find. XKeys selects the appropriate Keysym Set in 
the Symbol Set list, and then highlights the closest match in the 
Keysyms list. If the first Keysym matched is not correct, click Find 
until you find the symbol.
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8 Select a modifier state in the X Key States area. You can assign any 
combination of modifiers. If you would like the key to auto-repeat 
when held down, enable the Repeat check box.

9 To map different Keysyms to the remaining states, repeat steps 5 – 8.

10 Click OK. The Current X Mapping panel in the XKeys window now 
displays the new mappings.

Deleting a Keysym Mapped to a Key

To delete a Keysym mapped to a key:

1 In the left pane of  Xconfig, click Input Devices. The Keyboard Input tab is 
displayed. 

2 Select a primary or alternate keyboard file, and click Edit.

3 Select the key that you want to map by clicking the key in the XKeys 
window (Mapping Mode) or pressing the corresponding key on your 
keyboard. You can view the current mappings in the Mapping For Key 
Labelled: Keysym area.

4 Click Mapping on the Edit menu to open a mapping dialog box. You can 
view the current mappings for the key you specified in the Mapping For 
Key Labelled: Keysym group box. 

5 Click any of the following states: Unshifted, Shifted, Mode Switch, Shift 
Mode Switch. To delete the current mapping for this state, click Clear 
Mapping.

6 To delete the mapping for another state, repeat the previous step.

Note: Select only one Mod key.

Note: To change the keycap text on a key, select Layout Mode 
from the View menu. Once in Layout mode, press the key on your 
physical keyboard to select it and type the keycap text in the 
abbreviation box.
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Mapping a Macro to an Existing Key
Use the Macros dialog box to add, edit, and delete a macro. You can display 
the Macros dialog box by selecting Macro on the XKeys Edit menu. 

To map a macro:

1 In the left pane of Xconfig, click Input Devices. The Keyboard Input tab is 
displayed. 

2 Select a primary or alternate keyboard file, and click Edit. 

3 On the XKeys Edit menu, click Macros.

4 In the Macros dialog box, click Add. The Macro Binding dialog box opens.

5 Click Browse. The Macro Selector dialog box opens.

6 Click Add. The New Macro Proper ties dialog box opens.

7 Specify a macro Name and Description.

8 Click Star t Record and type the keys and key combinations that you 
want to be a part of this macro.

9 Click Stop Record to end recording. Click OK.

10 In the Macro Selector dialog box, click OK.

11 In the Macro Binding dialog box, select a key from the Bind Key list to 
attach the macro to, including any modifiers from the Modifier area. 

12 Click OK. The macro is added to the list in the Macros dialog box.

Macro Events
A macro recorded in the New Macro Properties dialog box displays an event 
list representing actual keystrokes: the name of the key pressed and the 
physical action of either pressing or releasing the key. 

Note: You cannot map a Keysym to a non-standard key unless 
you have included the key by changing the layout of the keyboard 
file. For more information, see “Adding a Physical Key” on 
page 112.
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Creating Compose-Key Sequences
Create compose-key sequences to access additional symbols by typing two 
keystrokes. For example, Keystroke 1 + Keystroke 2 or Composing Key + 
Keystroke 2.

To define the compose-key sequence:

1 In the left pane of Xconfig, click Input Devices. The Keyboard Input tab is 
displayed. 

2 Select a primary or alternate keyboard file, and click Edit. 

3 On the XKeys Edit menu, select Compose Sequences. The Compose 
Sequence dialog box opens.

4 Click Add to define a new compose-key sequence. The Build Compose 
Sequence dialog box opens.

5 Click Keystroke 1, and then press a key on your keyboard to use as the 
composing key.

6 Choose a modifier from the Modifiers For Keystroke 1 group box.

7 Click Keystroke 2, and then press a key on your keyboard.

8 If you want to map this compose sequence, click Next. The X Compose 
Mapping dialog box opens. It is a similar to the mapping dialog box that 
appears when you click Mapping on the Edit menu. 

9 Click Finish.

Managing Keysyms and Keysym Sets
The Keysym File Editor is a powerful tool for managing custom Keysyms 
and Keysym Sets. To open the Keysym File Editor dialog box, click Keysym on 
the XKeys Edit menu.

To add custom Keysyms to an existing Keysym Set:

1 In the left pane of  Xconfig, click Input Devices. The Keyboard Input tab is 
displayed.

2 Select a primary or alternate keyboard file, and click Edit. 
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3 On the XKeys Edit menu, click Keysyms. The Keysysm File Editor dialog 
box opens.

4 On the Key Symbols page, select the Set Name of the Keysym Set into 
which you want to place the custom symbol.

5 Click Add Keysym. The Add KeySym dialog box opens.

6 Type a KeySym name and a hexadecimal value.

7 Click OK.

To add or create a new Keysym set:

1 In the Keysysm File Editor dialog box, click the Symbol Sets tab.

2 On the Symbol Sets page, click Add Set. The Add Set Name dialog box 
opens.

3 Type a name in the New Set Name box.

4 Click OK. The name appears in the list on the Key Symbols page; the 
remaining boxes appear empty, indicating that this is a new Keysym set.

5 Add a custom Keysym by following the previous procedure.

PrintScrn Key Support
This section describes how to map the PrintScrn key. 

To use the PrintScrn key: 
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1 Using Xconfg, edit the selected keyboard file. Add the PrntScrn key to 
the layout. See “Adding a Physical Key” on page 112. 

2 After the key has been added, switch to Mapping Mode and map the key 
to an X Keysym. 

Adding a Physical Key
Standard 101-key and 102-key layouts are found in the Exceed User 
directory. If you are using a non-standard keyboard, you need to add keys. 
You can perform this task in two ways:

• Start with a default keyboard and add the extra keys.

• Start from scratch and build a completely new layout.

To add a new physical key to an existing keyboard file:

1 In the Xconfig left pane, click Input Devices. The Keyboard tab is 
displayed. 

2 Select a primary or alternate keyboard file, and click Edit. The XKeys 
utility is displayed. 

3 From the XKeys View menu, click Layout Mode.

Note: 

• Before customizing a keyboard file, back up the original. To do 
this, load the keyboard file. From the Xkeys File menu, select  
Save As, and name the backup file. This preserves the original 
file in case you need to revert to it later.

• Every key you want to use must be defined in your keyboard 
file. To define a key, describe the symbol(s) it can generate in 
the No Shift, Shift, Mode Switch, and Shift Mode Switch states. 
The key definition is represented by a keysym (key symbol) 
hexadecimal value corresponding to the symbol generated in 
a specific state. An undefined key symbol does not function in 
any X application.
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4 Press a key on your keyboard that is currently not defined in your 
keyboard file. Once the key is placed in the XKeys window, move and 
reshape it to match your physical keyboard layout.

5 In the Abbreviation box, type the key cap you wish XKeys to display on 
the key. The key is added to the keyboard layout. You can map 
X symbols to the new key.

To create a new keyboard layout:

1 In Mapping Mode, click New on the XKeys File menu. Do not use an 
existing keyboard layout when prompted. A blank XKeys screen 
displays.

2 On the XKeys View menu, select Layout Mode.

3 One at a time, press each key on your keyboard. XKeys places each key 
on the supplied grid below the mouse cursor. As keys are added, move 
and reshape the key to match the physical layout of your keyboard. Keys 
may be moved using standard drag and drop methods.

4 To modify the text displayed on a key cap, replace the text in the 
Abbreviation box. This is useful when Windows supplies a long key 
description.

5 You can now map X Keysym values to each physical key.

Deleting a Physical Key
You can delete keys in Layout mode. Highlight a key and select Delete from 
the XKeys Edit menu. A message box appears to confirm the deletion.

Note: Create a completely new keyboard layout only if your 
keyboard is substantially different than the supplied layouts.

Note: You can also delete keys in Layout mode by moving the 
mouse pointer over the key and then clicking the right mouse 
button.
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3

Keyboard and Mouse Wheel Macros

About Keyboard and Mouse Wheel Macros

This section describes how to use macros to modify the keyboard you want 
to use with your X applications. Y

You can:

• add, modify, and delete macros or parts of macros

• insert a macro action

• select, add, edit, delete, and import macros to use with a mouse wheel

Inserting a Macro Action
In the Edit Macro Properties dialog box, click a macro, and then click Insert. 
In the Insert Action Item dialog box, select an insert option. After you click 
OK, the Edit Macro Action dialog box opens. Edit the Action Type, Key, and 
Event Type.

Selecting a Macro
In the Macro Selector dialog box, you can select, add, edit, delete, and 
import macros to use with a mouse wheel. Macros are useful for adding 
functionality to your mouse and keyboard for X applications. To add a 
macro to the list, click Add.

Creating a New Macro

To create a new macro:

1 Open the Macro Selector dialog box for keyboard or mouse input.

2 Click Add.

3 Complete the following boxes in the New Macro Properties dialog box:
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• Name—The name of the macro to appear in the list of macros.

• Description—Some word cues to remind you what the macro is for.

4 Click Start Record. Complete the key sequence exactly as you want the 
macro to behave.

5 When you are finished, click Stop Record.

6 Create other macros as required, by repeating steps 2-5. Click OK to 
save the macros and return to the Macro Selector dialog box.

Modifying Macros

To edit the action of a macro, select it, and then click Edit. In the Edit Macro 
Action dialog box, you can edit the following:

Action Type Keystroke or Command

Key Scancode—Lets you change the key in 
the macro. To add a key to the macro, 
click Next Key Typed. 

Event Type Key Press, Key Release or Key Press + 
Key Release—Let you change the kind 
of action required for the macro. 

Macro Shortcuts

You can use a shortcut from Exceed on the Windows taskbar to launch a 
macro under multiple window mode. Click Exceed on the Windows 
taskbar, and then press the same key/keys to which you bound a particular 
macro in the Macro Binding dialog box. This launches the macro.

Since this method does not involve X clients, keystroke action types are 
ignored and only macros with command action types are invoked. These 
action types are defined in the Edit Macro Action dialog box.
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Configuring CJK Keyboard Input (Chinese, Japanese, and 
Korean)

This section describes how to configure the Input Devices settings for the 
Chinese, Japanese and Korean languages, and how to modify them. 

The CJK Input icon appears in Xconfig only if you are running a CJK 
Windows operating system (provided Microsoft IME is installed and 
enabled).

Use the CJK Input tab of the Input Devices page to configure how to enter and 
pass Chinese, Japanese, or Korean (CJK) text to an X client. 

To enter CJK text in an X client, you need to run an Input Method (IM) 
server.

You can configure Exceed to use either an external X client as the IM server 
or an IM server built into the X server. To use the Microsoft Windows Input 
Method Editor (IME) to enter text in an X client, you must configure 
Exceed to use an IM server built into the X server.

You can select one of the following input methods to enter CJK text:

• Select Use Input Server On The Host to use an input method server 
X client.

• Select Protocol to use an Input Method Server built into the Exceed 
X server.

• Select Copy And Paste to use copy and paste commands to input CJK 
text.

Note: The CJK Input icon appears in Xconfig only if you are 
running a CJK Windows operating system or supported Microsoft 
Windows platforms (provided Microsoft IME is installed and 
enabled).
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Using an Input Method Server X Client
For information on the 
remote Input Method 
Server, refer to your host 
documentation.

Use the Use Input Method Server On The Host option to enter CJK text using 
whatever mechanism the input method (IM) server X client supports. 
Select this option if you are using an external IM server X client.This means 
the Exceed X server will not support internal CJK input methods. This 
option does not permit the use of the Microsoft Windows IME to enter CJK 
text.

The available IM Server X clients vary by host type. The following table 
shows the IM Servers typically available on specific host types:

Host Type IM Server

HP xkim/xjim/xsim/stim

Solaris htt

Digital dxhangulim/dxhanyuim/dxhaziim/dxjim

Using an Input Method Server Built into the Exceed X Server
Select the Protocol option.

The Exceed X server internally manages an Input Method Server and uses 
the Microsoft Windows IME to enter CJK text. When you enter text, Exceed 
uses one of the selected protocols to pass text to the X client.

Exceed registers and manages an Input Method Server for each protocol 
selected in the Protocol Selection area. This means that you can enable 
multiple protocols, and each X client can use the protocol of its choice. We 
recommend that you enable all available protocols.

Specifying Locale (Ximp/XIM)—Exceed supports most of the standard 
encoding names. In most cases, you do not have to specify the encoding 
name. However, if your X clients are running in a non-standard encoding 
environment, enter the appropriate locale name. 
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Using Copy and Paste to Input CJK Text
Select the Copy And Paste option. Exceed does not register an Input Method 
(IM) Server when this option is selected; it uses the Microsoft Windows 
IME to enter CJK text. Rather than using an IM Server to pass text to the 
X client, it copies the text into the X selection and tries to paste the 
X selection CJK text into the X client. 

Exceed supports two copy and paste input methods. One is designed for 
Kterm and the other for OpenLook. Select the copy and paste method you 
want to use in the Use Environment area. If the CJK text is not automatically 
pasted into your X client, you need to use the X client Paste operation to 
paste the CJK text.

Special Considerations for Traditional Chinese
Exceed supports both Simplified and Traditional Chinese. 

Because there is no standard encoding in Traditional Chinese 
environments, Exceed can support only one encoding name at a time. By 
default, Exceed supports the HP-BIG5 (HP Traditional Chinese 
Environment) encoding. If you want to use the BIG5-0 (Digital Traditional 
Chinese Environment) encoding, you need to make changes to the Exceed 
initialization file and the xlc_locale file.

To input Traditional Chinese using the BIG5-0 (Digital Traditional 
Chinese Environment) encoding:

1 Open Exceed.xcfg in a text editor. Near the end of the file, locate the 
following XML tag just after the <Undocumented> tag:

<CJK_BIG5EncodingName>HP-BIG5</CJK_BIG5EncodingName>

This tag lets you input Traditional Chinese in an HP environment. 
Modify the tag to the following and save the file:

<CJK_BIG5EncodingName>BIG5-0</CJK_BIG5EncodingName>

2 Open the xlc_locale file on your computer.

3 Under the heading fs1, modify as follows:

• # used for HP-UX

• # charset HP-BIG5:GLGR
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• # used for Digital UNIX

• charset     BIG5-0:GLGR

4 Under the heading cs1, modify as follows:

• # used for HP-UX

• # ct_encoding
HP-BIG5:GLGR:\x1b\x25\x2f\x30\x80\x8aHP-BIG5\x02

• # used for Digital UNIX

• ct_encoding 
BIG5-0:GLGR:\x1b\x25\x2f\x32\x80\89BIG5-0\x02

5 Restart Exceed if it is running.

To view the Traditional Chinese HP Common Desktop environment:

1 Download the following Chinese Big5 fonts:

• uwb5-16m.bdf.gz

• eb5-24f.bdf.gz

You can also search for the fonts on the Internet (for example, by using 
an FTP search engine).

2 Decompress the GZIP compressed fonts.

3 In Xconfig Font Settings, select Compile Fonts in the Font Settings dialog 
box and compile the downloaded .bdf fonts to the .fon format. 

4 Copy uwb5-16m.fon and eb5-24f.fon to the Home\font\chinese 
directory.

5 Import the font aliases:

a) Select Import Alias in the Font Settings dialog box.

b) Select chinese.ali in the Exceed User directory.

c) For the Limit Import To Selected Font Directory option, select 
Home\font\chinese.

d) Click Import.
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6 If Exceed is running, on the Exceed menu, select File, select Reload 
Database, and click Font.

To view the Traditional Chinese Digital Common Desktop environment:

1 Follow the steps in the previous procedure.

2 Create a new font subdirectory in the Home\font directory.

3 Download the following fonts from a Digital UNIX host that supports 
Traditional Chinese into the new font directory created in step 2:

• adecw_hei_cns11643_16_16_75.pcf

• adecw_screen_cns11643_16_18_75.pcf

• adecw_screen_cns11643_24_24_75.pcf

• jdecw_screen_decsuppl_8_18.pcf

• jdecw_screen_decsuppl_12_24.pcf

4 In Xconfig Font Settings, select Compile Fonts in the Font Settings dialog 
box and compile the downloaded .pcf fonts to the .fon format.

5 Add the new font directory to the font database and move it to the top 
of the font database list using the Move Up button.

6 Import the font aliases. To import the font aliases:

a) Select Import Alias in the Font Settings dialog box.

b) Select the dec_tw.ali file in the Exceed User directory. 

c) For the Limit Import To Selected Font Directory option, select the new 
subdirectory created in step 2 from the Home\font directory.

d) Click Import.

7 If Exceed is running, right-click Exceed on the Windows taskbar, select 
File, select Reload Database, and click Font.
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Configuring Mouse Wheel Movements and Middle Button 
Emulation

This section describes how to configure the following mouse settings. 

• mouse wheel movement

• middle-button emulation (adding a virtual middle button to your 
two-button mouse)

To customize macros and how they are mapped to the mouse wheel, see 
“Mapping a Macro to the Mouse Wheel” on page 123.

 To configure mouse settings:

1 In the left pane of  Xconfig, click Input Devices, and then the Mouse Input 
tab. The tab is displayed.   

2 Configure the available Mouse Wheel settings: 

• Wheel movement is ignored—Select this option to invalidate all 
mouse wheel input.

• Wheel movement scrolls Root window (In Single Window Mode only)—
Select this option to enable scrolling in the main root window only. 

• Wheel movement invokes macro—Select this option to map the 
wheel movement to a macro. This is the only option that lets you 
scroll in Multiple Window Mode. For instructions on how to map 
to a macro, see “Mapping a Macro to the Mouse Wheel” on 
page 123.

• Wheel movement sends Mouse button event (button 4/5/6/7)—Use 
button 4/5/6/7 events to scroll the windows of existing 
X applications. ButtonPress and ButtonRelease events are sent 
according to the mouse wheel motion (up/down).

3 Configure the Middle Button Emulation and its behavior. This allows you 
to add middle-button capabilities to your two-button mouse. A virtual 
middle button is created for your two-button mouse.

• Select the Middle Button Emulation check box to enable the feature.

• In the Click Interval box, enter the value of your choice. This value 
indicates how much time needs to pass between clicking the left and 
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right mouse buttons before the middle-button emulation will 
occur.

4 In the Movement Threshold box, enter the value of your choice. This 
value specifies how many pixels the mouse is allowed to move during 
the clicks to still be considered a middle-button mouse. The value 
indicates pixel movement that is allowed when you click the left and 
right mouse buttons. If you stay within the specified number of pixels, 
you are indicating to the system that middle button emulation is to be 
used. 

Click both left and right mouse buttons simultaneously to emulate a 
middle mouse button.
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 Mapping a Macro to the Mouse Wheel

This section describes how to map a macro to the mouse wheel, for specific 
X applications. You need to perform this task, because otherwise 
X Windows does not recognize the mouse wheel. 

To map a macro to the mouse wheel:

1 In the left pane of Xconfig, click Input Devices, and then click the Mouse 
Input tab. the tab is displayed. 

2 Select Wheel Movement Invokes Macro, and then click Macro Bindings. 
The Mouse Wheel Macro Bindings dialog box is displayed.

3 In the Assigned Wheel Macros area, select a mouse action combination, 
and then click the adjacent browse button. The Macro Selector dialog 
box is displayed.

4 Click Add. The New Macro Proper ties dialog box is displayed.

5 In the Name and Description boxes, type the function of the new macro 
and a brief description. For example, type vi_scroll_up and Scroll 
Up.

6 After you have decided on the keys you want to map to the mouse 
wheel, in the Event List area, click Start Record.

7 Type the key sequence on the keyboard. When you are finished, the 
application stops recording automatically. Click OK to return to the 
Macro Selector dialog box.

8 Select your new macro from the list, and then click OK. 

9 The new macro is associated with the wheel action you selected. Click 
OK to return to the Mouse Input page.
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Configuring Communication Settings 

This section describes the Communication settings. They determine the 
sequence of events that occur when you start Exceed, including whether a 
host connection is made automatically. 

Use this Xconfig page to configure:

• Startup mode used by Exceed — Passive or XDMCP. The mode you use 
depends on your host and preferences.

•  Network Adapters—configure which IP address and adapter are used; 
specify external addresses for connecting through a virtual private 
network (VPN)) 

• Auto Close Connection—configure whether the connection is closed 
automatically under certain conditions

• List of network providers

To access and configure the Communication settings: 

• In the left pane of  Xconfig, click Communication. Alternatively, from the 
Settings menu, select Communication. The Communication page is 
displayed. 

Startup
Mode—This drop-down list contains two basic categories of server startup 
modes: Passive and XDMCP (X Display Manager Control Protocol). 
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Mode Details

Passive   This mode starts the server without making an initial attempt to 
connect to a specific host. Use Passive mode if you intend to 
use TELNET, Xstart, Xsession, or a remote process to connect to 
a host and start an X client. 

XDMCP XDM lets you manage X displays. It allows for centralized 
control over the X environment and provides an added measure 
of security. XDM provides an X-based login function and 
generates authorization information that can be used by Exceed 
to control which users on which hosts may be given access to 
an Exceed X server display.

If you use an XDMCP startup mode, you do not need a separate 
startup application to start X clients (that is, Xstart, Xsession, or 
TELNET). However, you may use these applications to start 
additional X clients.

XDMCP lets you automatically activate the particular XDMCP 
connection process whenever you start Exceed. After you start 
Exceed and successfully log in to XDM, the clients listed in the 
XDM session script file will be started. 

For more information, click an XDMCP startup mode link:

Configure—Opens the XDMCP Startup Modes dialog box where you can 
configure additional XDMCP settings.

Display Number—Specifies which port the client connects to. The default 
display number is 0.

Network Adapters
The Network Adapters section allows you to specify which network adapter 
and which IP address to use. 

• XDMCP Query Startup Mode

• XDMCP Broadcast Startup Mode

• XDMCP Indirect Startup Mode
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Xconfig now allows user control over which interface(s) the Exceed X Server 
listens on, both through configuration file settings and command line 
settings, especially but not exclusively on multihomed hosts. 

Task Details

Specify which adapter to 
use, if you have multiple 
adapters

A new command line option allows you to specify 
which Exceed adapter to use as the DISPLAY. Enter the 
following command:

exceed.exe -adapter n 

where n = 1 or 2 or 3. 

Specify which IP 
address to use and 
where to apply it

If you  have multiple adapter or Virtualized Network, 
you can configure  the IP address  Exceed will use and 
how this IP address needs to be applied. 

In Xconfig, under Communication tab > Network 
Adapter, select one of the following three options: 

After you have configured the IP address Exceed 
should use, specify how the IP address will be applied:

Auto Close Connection
The Auto Close Connection settings determine conditions under which 
Exceed terminates a connection.

• Adapter IP Address: Type an IP address

• Network Interface: Select which adapter you want 
Exceed to use.

• Virtualized IP address: use if you have virtualized 
network

• In Exceed Title—the IP address will be displayed in 
the Exceed Windows title bar, and the Full Screen 
Toolbar. 

• For XDMCP Session: Exceed will send this IP 
address as the DISPLAY to XDMCP Server

• To Set DISPLAY Variable: Exceed will set the DOS 
 environment  DISPLAY=”the IP address for Exceed 
to use”
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• Auto Close Connection—If you enable this option, Exceed terminates a 
connection under one of the following two conditions:

Use X Screen Saver Time—The connection terminates when the screen 
saver activates. 

After __ Hours __ Minutes—The connection terminates after the 
specified time if the host is inactive.

• Close Even When Application Is Active—The connection terminates if 
the host is still generating output, for example, during processes such as 
data compiling.

Other
Click Network Providers to control and optimize the order of network service 
providers. 

Creating or Editing the Host List

This section describes the Host List file. This text file contains the names 
and Internet Protocol (IP) addresses of all hosts that receive the broadcast 
request, when you start the server in the XDMCP Broadcast startup mode. 
The file lets you restrict access to your Exceed X server to specific hosts. By 
default, the host list is the Xdmcp.txt file in your Exceed User directory.

To create a new host list:

1 Open a text editor such as Notepad.

2 List the host names. Specify only one symbolic host name or constant 
address per line.

3 Save the file.

After you create a new file, you can use it in the XDMCP startup modes.

To add a host to the xdmcp.txt file:

1  In the left pane of Xconfig, click Communication. 

2 From the Mode list, select XDMCP Broadcast.
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3 Click Configure. The XDMCP Startup Modes dialog box opens.

4 Enable Host List File.

5 Click Edit to open Xdmcp.txt in a text editor.

6 To add to the list, type the name or Internet Protocol (IP) address of the 
host you want to add on a new line.

7 Save the file and exit Notepad.

Host List File Syntax

The Host List file is a text file containing the names and addresses of all 
hosts that receive broadcast requests. You can use the Host List File option 
(in the XDMCP Broadcast area of the XDMCP Star tup Modes dialog box) to 
edit the file or enable/disable its use. The default file Xdmcp.txt is located in 
the Exceed User directory.

Text on any line following a number sign (#) is ignored. Completely blank 
lines and all carriage-control characters are also ignored. The format of 
information lines is as follows:

• Host names are not case-sensitive.

• The address is specified in Internet Protocol (IP) address notation.

Configuring Security Settings

This section describes how to configure the Security settings in Xconfig. 

Security options can either restrict or allow access to specific features of the 
Exceed X server. You can also: 

• control the hosts that can run X clients using Exceed

• edit the Host Access Control List (xhost.txt)

• edit the User Access Control List (xauth)

• specify or edit the Security Policy File
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 To access and configure the Security settings:

1  In the left pane of  Xconfig, click Security. The Security page is 
displayed. 

2 Modify the settings and click Save.

Host Access Control List
This area contains options that restrict access to your Exceed X server by 
specific hosts. By default, the Host Access Control List is the xhost.txt file 
in the User directory.

File, Edit, Browse— Specify another file through one of the following 
methods:

• Type its full path (if other than the Exceed User directory) and file name 
in the File box. You can locate it by clicking Browse adjacent to the File 
box.

• Modify the Host Access Control List file in a text editor by clicking Edit. 
The xhost.txt file is open in the text editor. In this file you can 
document the list of host names or IP addresses that can connect to 
Exceed. 

This list can use wild cards. For example: 

rnd*.opentext.com

rnd.*.com

rnd.opentext.???

10.3.15.*

10.3.*

Under Host Access Control List, you can also enable the following settings:

• No Host Access—Instructs Exceed to use an empty Host Access Control 
List to regulate access (that is, no hosts are allowed access).

Note: If you select the xhost.txt file, you can use only Passive 
startup mode on the Communication page.
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• Allow Connection from Local X clients —Select this option if you 
want to enable local X clients to connect. 

• Any Host Access—Terminates use of the Host Access Control List and 
allows unrestricted access to all hosts on the network.

• Allow Clients To Modify Host Access Control List—Regulates client 
modification of the Host Access Control List (xhost.txt).

Enable User Access Control List
This option enables security at the user level (rather than at the host level) 
without using XDMCP. By default, this setting is not selected. For optimal 
security when enabling this setting, clear the Allow Clients To Modify Host 
Access Control List option, and select the Host Access Control List option.

User-level security is controlled by an .Xauthority file (by default, xauth), 
which is read each time the server is started or reset. You can create an 
.Xauthority file using the host-based Xauth utility. To make this binary file 
available to Exceed, download it from the host and copy it to the User 
directory. To select an .Xauthority file other than the default xauth file, 
click Browse.

Connection Warnings
Warn On Unauthorized Connections—Opens a warning dialog box 
whenever an unauthorized X client tries to connect. By default, Exceed 
refuses unauthorized connections. The warning gives you the opportunity 
to accept or refuse unauthorized X application connections.

Warn On Authorized Connections—Opens a warning dialog box 
whenever an authorized X client tries to connect.

Host Access Control List Syntax
The Host Access Control List is a text file containing the names and 
addresses of all hosts with access to the Exceed server. Use the Host Access 
Control List File area on the Security page in Xconfig to specify options.

The default file xhost.txt is located in the Exceed User directory. A 
number sign (#) at the beginning of a line means the line is treated as a 
comment and is ignored. An information line has the following format:

• Host names are not case-sensitive.
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• The address is specified in Internet Protocol (IP) address notation.

Creating and Editing the Host Access Control List
This section describes how to:

• add a host to the Host Access Control List

• create and use a different Host Access Control List

The Host Access Control List is a text file. This text file allows you to provide 
access to your Exceed X server to specific hosts. The default Host Access 
Control List file (xhost.txt) is located in the User directory. 

To add a host to the xhost.txt file: 

1 In the left pane Xconfig, click Security. Alternatively, from the Settings 
menu, select Security. The Security page is displayed. 

2 In the Host Access Control List area, click File. 

3 Click Edit to open the Host Access Control List in a text editor.

4 To add to the list on a separate line in this file, specify the name or 
Internet Protocol (IP) address of the host that you want to add.

5 Save the file and exit Notepad.

6 To reload the list, right-click Exceed on the Windows taskbar. On the 
File menu, point to Reload Database, and then click Access Control Lists.

To create and select a new host access control list:

1 Open a text editor, such as Notepad.

2 List the host names. You can specify only one symbolic host name or 
constant address per line.

3 Save the file.

Note: Host names are not case-sensitive. Lines beginning with a 
number sign (#) are treated as comments.
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4 Go to  Xconfig, and display the Security page. In the left pane of 
Xconfig, click Security. Alternatively, from the Xconfig Settings menu, 
select Security. The Security tab is displayed. 

5 Select Enable User Access Control List.

6 If the file you created is not listed, click Browse.  to locate it. Locate and 
select the file. Ensure that it is specified in the File field. 

Creating the User Access Control List
This section describes how to create the User Access Control List. This text 
file allows  you to restrict access to your Exceed X server at a user level 
(rather than at the host level). 

By default, the User Access Control List for user-level security, is the 
.Xauthority file.You cannot edit this file on your computer. You must edit it 
on the host. 

The file  contains cookies that represent each client. A successful connection 
is established if the cookie sent by the client matches the one on the 
X server. Exceed includes a Windows version of the Xauth program. 
Individual cookies can be directly merged to the local .Xauthority file. This 
simplified method of synchronizing the .Xauthority file benefits 
organizations that rely heavily on this type of user-level security.

To create the user access control file:

1 Create an .Xauthority file on your host using the host-based xauth 
utility. For more information, refer to the man pages on the xauth 
utility available in UNIX.

2 Enable xstartd using InetD (in Control Panel, double-click OpenText 
InetD).

3 Propagate your DISPLAY (where DISPLAY is the Exceed X server 
IP Address:DisplayNumber) to the Exceed X server by using the 
following command on the host:

"xauth nextract - Exceed_Xserver_IP_Address:DisplayNumber 
rexec -l your_pc_username -p your_pc_password 
Exceed_Xserver_IP_Address xauth nmerge -"
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4 Go to  Xconfig, and display the Security page. In the left pane of 
Xconfig, click Security. Alternatively, from the Xconfig Settings menu, 
select Security. The Security tab is displayed. 

5 Select Enable User Access Control List.

6 If the file you created is not listed, click Browse to locate and select the 
file.

7 To reload the list, right-click Exceed on the Windows taskbar. On the 
File menu, point to Reload Database, and then click Access Control Lists. 

Authorizing X Clients
This section describes how to authorize X clients. 

In Xconfig, the Security page authorizes X clients in stages. 

If an X client tries to connect to the Exceed X server in a non-XDMCP 
startup mode, the following authorization occurs: 

• If the user access control is enabled and the X client passes the 
authorization screening, it is allowed to run.

• If the X client originates on a host specified in the Host Access Control 
List, or if host access control is disabled, the client is allowed to run.

To manage access for X clients: 

1 In the left pane of  Xconfig, click Security. Alternatively, from the 
Xconfig Settings menu, select Security. The Security tab is displayed. 

2 To disable host access control:

• Click No Host Access.  If you select Enable User Access Control and 
want full security, use a Host Access Control List with no entries. 
This is equivalent to selecting the No Host Access option.

3 To ensure that the X client is not refused:

• Clear the check box Allow Clients To Modify Host Access Control List. 
If you do not clear the check box, the client may be refused.
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2

Configuring Display and Video Settings

This section describes how to configure display and video settings for 
Exceed. 

This section contains the following topics:

• “Configuring Single Window Mode Screen Settings” on page 135

• “Configuring Multiple Window Mode Screen Settings” on page 141

• “Adding or Removing Screens at the Screen tab” on page 143

• “Creating or Editing a Local XRDB Database” on page 143

• “Configuring Common Settings for Display and Video” on page 147

• “Configuring Video Settings” on page 151

• “Configuring Advanced Settings for Display and Video” on page 152

Accessing Display and Video settings

To configure Display and Video settings: 

4 In the left pane of  Xconfig, click Display and Video. The Display and 
Video page opens, with its initial tab, Screen, displayed. Configure the 
desired settings: 
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Configuring Single Window Mode Screen Settings

This section describes how to configure the Screen settings, in Single 

Window Mode. 

The settings include: 

• use of multiple monitors and number of display screens (logical and 
physical screens)

• window panning

• loading of the XRDB database

• enabling, adding or removing screens

By default, one screen (Screen 0) is available. Screen 0 cannot be deleted or 
disabled. Up to eight screens may be supported. 

The following options are available on the Screen # tab on the Display and 
Video page once you have selected a screen (other than Screen 0) in the left 
pane.

Enabling additional screens
Select the following option: 

• Enable Screen—Enables additional screens (Screen 1, Screen 2, and 
Screen 3). 

You may clear the option to disable a screen for certain applications. 
Screen 0 cannot be disabled. 
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Monitor Settings at the Screen tab

To display an X session, you can: 

• use all monitors that are attached to your machine, or

• specify which monitors you want to use. 

To configure monitor use:

Under Use monitor(s), select the option of your choice. 

Monitor Option Details 

All Enables the use of all available monitors.

Only Primary Enables the use of only your primary monitors.

All Non-Primary Enables the use of all non-primary monitors.

Specified Lets you specify which monitors to use. Type the 
monitor number in the adjacent box. Up to 32 monitors 
are supported. To use multiple monitors, you must 
install multiple video cards or a video card that 
supports multiple monitors on your computer.
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5 In the available text field, enter the monitor number. 

The interpretation of monitor numbers depends on the resolution of a 
single monitor setting. For supported Microsoft Windows platforms, if 
you set the resolution values to 0, Exceed uses monitor numbers that 
correspond to the numbers displayed for each monitor in your 
Windows Control Panel Display settings. 

For all platforms, if these resolution values are non-zero, your monitors 
are numbered starting at 1 (for the monitor in the top left corner of 
your Windows desktop) and increment by one for each monitor (as you 
move left to right and top to bottom).

The monitor numbers for a screen must represent monitors that are 
adjacent to each other and of the same color format. If you have 
configured Multiple Window Mode for a screen, the monitor numbers 
used by this screen cannot be identical to those used by any other screen 
configured for Multiple Window Mode.

Note that you can tile multiple monitors over the Windows desktop if:

• they are all set to the same resolution (width, height, and color 
format) 

• collectively they form a complete rectangle

For example, consider the following scenario:

1 2 3 4

5 6 7 8

9 10 11 12

The shaded selection 
appears in Monitor(s) 
to Use for Screen as 
3,4,7,8,11,12.

Assuming the shaded 
selection is assigned 
to another screen, 
then any combination 
of 1, 2, 5, 6, 9, 10 that 
form a rectangle can 
be specified for the 
current screen.

1024

76
8

256

25
6

Total resolution 
(pixels) of all 
(physical) monitors 
as determined by 
Exceed.

Single (virtual) 
monitor resolution 
(pixels).

The shaded selection 
appears in Monitor(s) 
to Use for Screen as 
3,4,7,8,11,12.

Single (virtual) 
monitor resolution 
(pixels).
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Window Mode Settings at the Screen tab
Select the Single Window Mode. 

• Multiple Window Mode—Each client you start creates its own new 
window. The native (Microsoft Windows) or the X Window manager 
(local or remote) handles all window functions. The default window 
manager in multiple window mode is Default To Native. If this option is 
selected, Exceed looks for another window manager; if none exist, 
Exceed uses Microsoft Windows to manage the window. For more 
details, see “Configuring Multiple Window Mode Screen Settings” on 
page 141. 

• Single Window Mode—Presents all clients in a single Exceed window. 
A local or a remote X Window manager controls all window functions.

If several screens are used, you can mix and match window modes. 

If Multiple Window Mode is selected for a particular screen, the 
monitor numbers used by this screen cannot be identical to those used 
by any other screen that is also configured to use Multiple Window 
Mode. The monitor numbers must be unique. 

Panning Setting at the Screen tab
This option lets you pan across the server window to view parts of client 
windows that are off screen when you are running the native window 
manager (Microsoft Windows). Do this by ensuring that the client window 
has focus (it is on top of other windows), and then move the mouse pointer 
to the edge of the screen. 

The panning method depends  on whether or not the Full Screen setting, 
under Root Size , is selected. 

• Full Screen is selected—you can pan up or down to display or hide 
the window title bar, and left or right to display or hide part of the 
Windows desktop. When you select Full Screen, you cannot adjust 
the panning controls (speed and amount). 

• Full Screen is disabled— the window pans according to the panning 
controls.
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To configure the Panning feature: 

1 Select your Window Mode (Multiple or Single). 

2 If Multiple Window mode is used, ensure that  Fit Window to Display., 
under Window Manager, is disabled. 

3 If Single Window Mode is selected, select or disable Full Screen option. 
Under Root Size, select Full Screen check box. 

4 Select or clear the Panning check box. 

The following Panning options may be selected, if Full Screen option is 
disabled: 

Speed—Slow, Medium, or Fast. The default speed is Slow. When 
you set the speed to Slow, you can pan by moving the mouse 
pointer to the edge of the screen repeatedly. When the speed is 
Medium or Fast, you can pan by positioning the mouse pointer on 
the appropriate edge of the window.

Amount—The incremental percentage of the window size in which 
panning occurs. You can enter any value between 1 and 100 in the 
Amount text box.

Auto Load XRDB
Select this option if you want the Exceed X server to automatically load the 
local resource database  each time it restarts or resets.

The local resource database is named in the File text box. By default, the file 
is named xrdb.txt. 

A sample xrdb.txt file is stored in the following location:

C:\Program Files\Hummingbird\Connectivity\version\Exceed\Info

To use this file without changing the contents of the XRDB file text box, 
copy this file to your User directory. If the Auto Load XRDB setting is not 
selected, you must manually load the local resource database. to do so, 
display the Exceed File menu, and select the relevant XRDB option. 

Server Visual
Defines the color characteristics for the specified screen of your Exceed X 
server display. 
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AutoSelect—Automatically selects the server Visual setting.

PseudoColor Emulation—Supports dynamic colormaps of 16 or 256 
colors. Under normal circumstances, the PseudoColor Emulation setting is 
appropriate.

TrueColor—Use this setting if your display driver supports 32,768 or more 
simultaneous colors on your video adapter.

Root Size
Sets the size of the server root window (in pixels). You can make the root 
window larger than your screen. The maximum root window size is 8192 x 
8192 pixels. A width or height of 0 implies that the root size is equal to the 
size of your screen. For certain applications to run, you may need to make 
the root size larger than your screen. 

A width or height of 0 implies that the root size is equal to the size of the 
client area of a maximized window when Exceed menus open on the 
Control menu box (that is, with no menu bars or scroll bars). If you make 
the root size larger than the client window, you can use the panning feature 
or scroll bars to view any hidden parts of the root.

Full Screen—Sets the size of the server root window to the full size of the 
screen. If this option is selected, you cannot adjust the panning controls 
(speed and amount).

Window Appearance (Single Window Mode only)
Save Geometry On Exit—Saves the server window geometry (that is, 
window position, size, and state) when you exit the server and restores it 
when you start the server and enter single window mode. The setting for 
this option is saved when you terminate the server.

Note: A TrueColor driver supports PseudoColor mode.
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Configuring Multiple Window Mode Screen Settings

This section describes how to configure the Screen settings in Multiple 
Window Mode. 

Most of the settings from the Single Window Mod may be reused. For initial 
details, see “Configuring Single Window Mode Screen Settings” on 
page 135. This section contains additional details, for settings that affect 
Multiple Window Mode. 

When Multiple Window mode is enabled, at the Screen tab, the following 
new settings become available 

• Window Manager—Lets you select the window manager to use in 
multiple window mode. Select one of the following from the list:

• Native—Microsoft Windows is used as the window manager. 
Common Desktop Environment (CDE) sessions do not support 
the Native window manager.

• X—Any X window manager, local or remote, is used as the window 
manager. You must start the window manager because no window 
manager is started by default.

• Default to Native—By default, the Windows window manager is 
used. However, if a local or remote X window manager is started, it 
replaces the Windows window manager. After the X window 
manager is terminated, Windows is again used as the window 
manager.

• Panning is available only when you are using the Windows Window 
Manager.

• If you are using an X window manager and want to open the X 
window manager menus when you click the Windows desktop, you 
can either:

• enable the Root Mouse Actions To X option in the Advanced Multiple 
Window Mode dialog box

Note: Normal Windows desktop mouse actions do not work when 
this option is enabled.
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• change the setting as needed using the Root Mouse Actions to X button 
on the Exceed X server toolbar

Fit Window To Display—Sends a request to any client that creates a 
window larger than the size of your screen to make the window the size of 
your screen.

Cascade Windows—Tells the server to cascade all top-level client windows 
for which a client does not specify any position.

Advanced Settings
Root Mouse Actions To X—Lets you specify whether mouse actions on the 
Windows desktop are processed by the Exceed X server.

By enabling the Root Mouse Actions to X option, you can click the 
Windows desktop to access X window manager menus. Normal Windows 
desktop mouse actions do not work while this mode is enabled. To change 
the state immediately, toggle this setting in Xconfig or press a button on the 
server toolbar.

Track Mouse—Tells the server to keep track of the location of the mouse 
even when it is outside an X client window. When selected, a client like 
Xeyes follows the mouse around your screen.

Delay Window Mapping—Some X clients erroneously expect a window 
map request to be delayed, or they do not draw the contents of their 
windows. Other X clients expect windows to be mapped immediately 
because they expect no window manager to be running at the time (as is the 
case with some XDM Login clients).

When you run an X client with a remote window manager, the fact that 
window manager and Exceed X server are not running on the same machine 
causes a delay in mapping windows. In multiple window mode, however, 
you are using a local window manager; therefore, no such delay exists. Use 
the Delay Window Mapping option to determine whether window mapping 
is delayed in multiple window mode.

Note: If you enable Panning, do not enable Fit Window to 
Display.
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Adding or Removing Screens at the Screen tab 

By default, one X screen (Screen 0) is available. 

To add or remove X screens:

1 Click Add Screen button, in the upper right corner of the Screen tab. 
The new screen is added, and listed in the left pane of  Xconfig, under 
Display and Video. 

2 To remove the screen, select it in the left pane of the Xconfig, under 
Display and video. At the Screen tab, click the Remove Screen button. 

You cannot delete screen 0. Screens must be deleted in reverse 
numerical order. That is, if you have six screens (0,1, 2, 3, 4, and 5), you 
cannot delete screen 3 before deleting screen 4. 

As an alternative to deleting a screen, you can disable it by clearing the 
Enable Screen option, at the Screen  tab If you disable a screen, all 
higher-numbered screens are disabled as well. Up to eight X screens are 
supported. This feature is useful if you need the data split across 
multiple monitors or divided into many screens.

Creating or Editing a Local XRDB Database

This section describes how to create or edit a local XRDB database. 

This resource database resides on your computer instead of on the host. It 
defines properties that clients can use. The local resource database defaults 
to the xrdb.txt file in the User directory.

If you have created more screens than the default (Screen 0), you can set 
XRDB database settings independently in each screen’s page. Click Display 
And Video. The Screen tab is displayed. Click Edit (in the Auto Load XRDB 
area) on the Screen page to modify the database.

Note: To use multiple monitors, you need to install multiple video 
cards on your computer. 
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Load and remove the XRDB database using commands on the File submenu 
(available on the Exceed menu). To automatically reload the XRDB 
database with the server, select the Auto Load XRDB setting on the Screen 
page. You can also create an entirely new file or download a database from 
the host. 

RGB Database Syntax
The RGB database associates symbolic color names with specific Red, 
Green, and Blue values. X clients request these values and/or color names 
when displaying information on your screen.

File Syntax
Each valid line in the rgb.txt file has the following format:

R G B

Example: 70 130 180 SteelBlue

Interpretation—The color named SteelBlue has a Red value of 70, a Green 
value of 130 and a Blue value of 180.

RGB values must be in the range 0 through 255. The colorname field in the 
text file is not case-sensitive and spaces are ignored.

XRDB File Format
In the resource file:

• Empty lines are ignored.

• Tab characters are always converted to a single space.

• Lines starting with an exclamation mark (!) are ignored.

• Lines starting with a number sign (#) are preprocessor statements (see 
below).

Note: The Exceed log file keeps track of any client requests for 
colors not defined in the RGB database. You can then add these 
colors to the database for future use. 
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• Every line must provide a resource specification as follows:

resourceName : text

• Spaces located before resourceName, the colon, and the start of the text 
as well as at the end of the line are ignored.

• resourceName may contain only the following characters:

. a-z A-Z 0-9 _ -

Preprocessor Statements
Preprocessor statements let you set if…else conditions that define the 
xrdb.txt statements to process. You can use preprocessor statements to 
perform functions such as testing the resolution and color display of the 
video adapter and monitor before deciding which resource database 
statements to use.

A preprocessor statement is any statement that starts with a number sign 
(#).

#if Specifies an expression in a format described in the #endif example 
below. If the expression is true, successive statements are processed. 
Otherwise, they are not processed.

#endif An #endif statement marks the range of each #if statement. For 
example:

#if Planes == 8 ! test for 256 colors

color ... ! specify color statements

#endif

#else You can use one #else statement within an #if...#endif range. The 
#else statement has the effect of swapping the result of the #if for all 
the statements until the next #endif.

Expressions in Preprocessor Statements

Expressions in preprocessor statements take the following form, with the 
parameters separated by at least one space:

id operator constant

where id can be any of the following:

Note: #if and #endif statements can be nested.
145



OpenText™ Exceed™ User's Guide
• xpixels—The width of the screen in pixels.

• ypixels—The height of the screen in pixels.

• planes—The number of video planes. The number of colors is 2planes 
(that is, 4 planes specifies 16 colors; 8 planes, 256).

• color—Indicates if Exceed visual supports color. If the default 
server-visual supports color, then Color is set to 1; otherwise, it is set to 
0. Use this setting to test whether the default server-visual supports 
color (for example, PseudoColor, StaticColor, TrueColor visuals).

• static—Indicates the type of colormaps supported. If the server  
supports only static, read-only colormaps, static is set to 1. Otherwise, it 
is set to 0. Use this setting to test if the server mode supports static 
read-only colormaps or dynamic read/write colormaps. 

and operator can be any of the following where constant is a decimal 
numeric value (for example: Xpixels == 80):

Operator Definition (where n is a decimal numeric value)

== TRUE if <id> is equal to n

<> TRUE if <id> is not equal to n

< TRUE if <id> is less than n

<= TRUE if <id> is less than or equal to n

> TRUE if <id> is greater than n

>= TRUE if <id> is greater than or equal to n

For example, to see if a video resolution is available that is greater than or 
equal to 1024 pixels wide, use the following:

#if xpixels >= 1024

To test for 256-color capability:

#if planes == 8
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Configuring Common Settings for Display and Video

This section describes how to configure common Display and Video 
settings. 

To configure the common settings

1 In the left pane of  Xconfig, select Display and Video. 

2 Click the Common Settings tab. 

3 Select or clear the options of your choice, and click Save. 

Native Window Manager Focus Policy
Lets you choose whether a window has focus while the pointer is pointed 
only at the window or whether you need to click in the window.

Select one of the following options from the drop-down list: 

Focus Description

Click Click the left mouse button on the window to give it focus.

Pointer Move the mouse pointer into the window to give it focus.

Reset and Exit
Reset X Server When Last X Client Exits—Automatically resets the server 
when the last client connection is closed. This option is selected by default.

Exit On X Server Reset—Terminates the Exceed server when the last client 
connection is closed.

Note: The window is not brought to the front when it is given 
focus with the pointer. To bring the window to the front, click your 
left mouse button on the window caption or on its sizing border.
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Close Warning on Exit—Opens the Exceed Close Warning dialog box 
whenever you enter a command that shuts down the server. The dialog box 
prompts you to confirm or cancel the action (it also includes options to not 
repeat the warning, and to save the session including geometry and 
workspaces).

Save Session On Exit—(Native Window Manager Only) Exceed remembers 
applications (either Local X applications or applications started using an 
Xstart file) and their locations.

Other
Hide X Server Menu Items—Prevents users from performing tasks from 
the menu.

Use Desktop Work Area—Uses the entire desktop and excludes the Always 
On Top option for the Exceed toolbar.

Enable Workspaces—Workspaces imitate the Common Desktop 
Environment (UNIX) and GNOME (Linux). You can arrange X clients in 
different workspaces and enable multiple workspaces.

Note: If you have installed OpenText Secure Shell to secure 
Workspace-enabled Exceed sessions, ensure that the 
Dynamically Acquire X11 Cookies option is disabled in OpenText 
Secure Shell. Exceed will generate the correct cookie and make it 
available to OpenText Secure Shell.
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Single Window Mode Resizing policy
Exceed allows  Fixed, Scaled, and Dynamic resizing of the root window and 
its contents. When launching Exceed in Single Window Mode on monitors 
that use different resolutions, the root window uses the resolution of the 
smallest display. This eliminates the need for scroll bars. 

Setting Details 

Fixed In this mode, a user (or the system) defines the size of 
the root window. By default, an X session uses Fixed 
resizing policy. If you click the Maximize button in the 
toolbar, the main window is restored to its original 
position and size. 

Note: Scroll bars appear automatically, when Fixed 
policy is in use. GLX applications will be terminated 
when you switch from Fixed to Scaled resizing policy. 

Dynamic Allows you to resize the window dynamically. The X 
application (such as the KDE environment) will reflect 
this and fit in the new window. For example, you may 
switch from Single to Multiple Monitor Mode (or vice 
versa). The X applications will renegotiate the new root 
window size and be redrawn appropriately based on 
the new information. They would not be distorted as it 
might happen in the Scaled mode. The minimum size 
of the window has been set to 800x600. You cannot 
resize the window to be smaller. When the window is 
maximized, the window and root window will cover the 
work area.
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Do Not Prompt for Multiple Sessions
Do Not Prompt For Multiple Sessions—If this option is enabled, Exceed 
does not open the Exceed – Multiple Sessions dialog box when other 
instances of Exceed are run.  

Run Multiple Sessions—Runs multiple instances of Exceed. If the Do not 
Prompt for Multiple Sessions check box is cleared, the Exceed – Multiple 
Sessions dialog box prompts you to select options for each session.

Do Not Prompt for Display Settings Change
Do Not Prompt For Display Settings Change—Prevents Exceed from 
prompting for a server reset if display settings (for example, resolution or 
color depth) were changed. 

Always Reset Server—Resets the server automatically when display settings 
have changed.

Scaled When you resize the window, the size of the root 
window does not change, but the contents of the X 
session scale up/down accordingly. For example, if 
multiple X sessions are running, the user may view 
them as thumbnails. Scaling does not affect the 
behavior of UNIX applications, because the root 
window size remains the same.

When you select the Scaled policy you have the 
following options: 

• Select Maintain Aspect Ratio—In this case, the 
contents of the X session scale so that their original 
ratio is preserved, and the objects in the main 
window do not appear distorted. 

• Do not select Maintain Aspect Ratio—In this case, 
the main window of  the X session and its contents 
will be resized, but their original ratio will not be 
maintained, and the objects in the window may 
appear distorted. 

Note: You cannot switch directly from a Scaled to 
Dynamic policy, or Dynamic to Scaled. You must switch 
to and apply Fixed resizing policy, before choosing 
Scaled or Dynamic.

Setting Details (Continued)
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Exceed Toolbar Configuration File
This area lets you specify an Exceed toolbar configuration file (.tb). These 
files let you determine the language, availability and location of toolbar 
buttons in your X session. You can also use them to configure custom 
application buttons. 

Select a file from the drop down list of files, located in the Exceed program 
file location. If the file you require is located elsewhere, click Browse. If you 
want to edit the settings in the selected file, click Edit to open the Customize 
Toolbar dialog box.

Configuring Video Settings

This section describes how to configure Video settings, to customize the 
video mode and colors displayed by Exceed. 

You can set monitor width and height, associate names with Red, Green, 
and Blue values in an RGB database, and specify the icon defaults for native 
window manager mode. 

To access the Video tab and edit the settings:

1 In the left pane of  Xconfig, select Display And Video. 

2 Click the Video tab. This Xconfig tab controls the video mode and colors 
displayed by your Exceed X server. 

3 Change the available settings. 

4 Click Save, to save your settings to the configuration file. To restore 
original video settings, click Load Defaults.

Screen
Specify In mm—Lets you adjust the screen size using the Width and Height 
text boxes. Width and height define the viewable portion of the screen in 
millimeters (1 inch equals 25.4 mm). If either of these boxes is 0, the server 
uses the values returned by the Windows display driver. Because most X 
clients ignore the screen width and height data, the default values of 0 are 
sufficient in most cases.
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Compute Based On Monitor DPI (Dots Per Inch)—Calculates the screen 
size based on the monitor dots per inch. Default values are 75 and 100.

Palette
Optimize Colormaps To Reduce Flashing On Focus Change—Determines 
how the Exceed X server interacts with the Windows color palette. Select 
this option to try reducing flash when changing focus from one window to 
another.

RGB Database
Associates text names with the Red, Green, and Blue values displayed on 
your monitor. The RGB Database is the file in the User directory. To open 
the database in a text editor, click Edit. Select the appropriate keyboard file 
in the list or click Browse to select a file from another directory. Default 
locations for User files. 

Native Window Manager Icon Defaults
Lets you define the default foreground and background icon colors as well 
as which default client icon to use with the native window manager. You can 
specify the icon colors using names that are listed in the RGB database, or 
you can specify an RGB triple (for example, 255 255 255). Click Change Icon 
to open a dialog box that lets you locate and select a different icon.

Configuring Advanced Settings for Display and Video 

This section describes how to configure the Advanced Settings tab. This tab 
contains native window manager options and various other options 
affecting display and video.

To access the Advanced tab and edit the settings:

1 In the left pane of  Xconfig, select Display And Video. 

2 Click the Advanced tab. 

3 Change the available settings. 
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4 Click Save, to save your settings to the configuration file. To restore 
original video settings, click Load Defaults.

This Xconfig page contains the following options:

Native Window Manager
Map Window Without Motif Input—Motif input is a window property 
that specifies which window requires keyboard input. Selecting this option 
means the user can put input into any window.

Configure Window Position To Client—Sets the window position to that 
of the client window.

Pad Motif Window—Puts one extra layer on the frame window. Some 
applications expect this extra layer.

Native Window Manager Tooltip—Enables tooltips when the cursor 
hovers over a toolbar button.

Allow Primary Window On Top—Lets the primary window appear on top 
of any transient (secondary) dialog box.

Draw On Moving Window—If you move a window that is displaying an 
animated X client (such as Ico), selecting this option forces the window to 
keep drawing.

Draw On Resizing Window—If you resize a window that is displaying an 
animated X client (such as Ico), selecting this option forces the window to 
keep drawing.

No Focus On Window Raise—Keeps the focus on the lower window unless 
the X application sets the focus on the upper window. This option is 
selected by default.

On Focus Raise Window To Top—Raises the window in focus to the top of 
the screen. Even if the X application doesn’t require it, the window is 
restacked to the top.

Warn On X Client Exit—Displays a warning dialog box when you close an 
X client in multiple window mode with the native window manager. 
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Other
Show Multiple Monitor Warnings—Causes warning dialog boxes to be 
displayed when using multiple monitors that have differing video settings. 
To resolve incompatible settings, Exceed runs using a default Screen 
configuration. For further details, consult the Exceed log file. This option is 
selected by default.

Force Window To Foreground—Forces the X application window to the 
foreground. This option is selected by default.

Raise Window On Click—Forces the X application window to the 
foreground of a Microsoft application window when clicked.

Multiple Color Depths Support—Enables advertisement of all supported 
visuals. This lets certain X applications display correctly (for example, if 8-
bit PseudoColor or 24-bit TrueColor is the default visual on a high-color 
video device). Clearing this option means that Exceed advertises only the 
default visual.

Sun Microsystems Compatible Colormap—Enables Sun Microsystems-
compatible colors and affects the default settings of the PseudoColor 
Emulation server visual (by default, the X server allocates the color black to 
cell zero, and the color white to cell one when PseudoColor Emulation is 
enabled). Selecting this option reverses the allocation: black is allocated to 
cell one, and white is allocated to cell zero.

User Installed Colormap—Use in PseudoColor emulation mode only 
(select PseudoColor from the Server Visual drop-down list on the Screen 
page and select TrueColor in Windows' video settings). Exceed can emulate 
colormaps when in PseudoColor Emulation mode. Most applications set 
each window to a certain colormap. For these applications, this option 
should be cleared. However, some applications (incorrectly) assume only 
one colormap is visible at any time. When this option is selected, windows 
that have requested the default colormap will use the installed colormap 
(via the InstallColormap protocol request) instead.

2D Overlay—Treats the 2D overlay window as if it were placed on the main 
layer. This option avoids unnecessarily having to recalculate and redraw all 
windows on the main layer if the 2D overlay window is repositioned.

Depth 12 PseudoColor—Allow depth-12 PseudoColor Emulation for 
screens set to high color or true color.
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Layered Windows Support—When this option is selected, window layers 
do not have to be redrawn.

Prevent Center Dialog Across Monitors—Ensures that when multiple 
monitors are used, dialogs are not displayed in the center of the viewing 
area (across two or more monitors). When this option is enabled, dialogs 
that would otherwise span two or more screens are displayed entirely within 
a single physical screen.

This option repositions only those dialog boxes that are centered (center-
mapped vertically and horizontally ) by their parent applications. Dialog 
boxes mapped otherwise will retain their mapped position and may appear 
across multiple monitors.

Configuring the Copy, Paste, and X Selection

This section describes how to configure the ability to copy, paste and select 
content in an X application. 

To configure X Selection settings:

1 In the left pane of  Xconfig, click X Selection. The X Selection page is 
displayed. 

2 Select the options of your choice. 

3 Click Save.

The following options are available at the X Selection page. 

• X Selection Associated With Edit Operations—Lets you identify the 
correct X selection type. Most X applications use the PRIMARY 
selection. With X clients that support SECONDARY or CLIPBOARD, 
you can change the X selection. For old X clients that do not support 
the X selection mechanism, you can choose from CUT_BUFFER0 
through CUT_BUFFER7. If a client supports a different selection than 
those listed, type the name of the custom X selection in the box.

• Auto Copy X Selection—When the X selection changes, the contents of 
the X selection are automatically copied to Clipboard.
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• Copy On Focus Loss—Copies the X selection to Clipboard when the 
window containing the X selection loses focus.

• Auto Paste To X Selection—When the content of Clipboard changes, it 
is automatically pasted to the X selection.

• Grab Clipboard Retry Time (ms)—If Clipboard is unavailable, try 
again after the specified interval (in milliseconds).

• Auto Paste Delay Time (ms)—Copies the X selection to the Windows 
Clipboard after the specified time (in milliseconds).

Specifying X Selection Type
You can select the type of X selection commands using the X Selection 
commands for copying and pasting on the Edit submenu (available on the 
Exceed menu). X selection settings and options are saved when you 
terminate the server.

Automatic Copy and Paste 
You can set your system to automatically copy and paste X selections. 

This saves time and is especially useful for high volume copying and 
pasting.

To set copying and pasting of X selections to automatic:

1 In the left pane of  Xconfig, click X Selection. The X Selection page is 
displayed.

2 Select the following options as required:

Select To 

Auto Copy X Selection Copy the contents of the X selection to the 
Clipboard.

Copy On Focus Loss Copy the contents of the X selection to the 
Clipboard when the window containing the 
X selection is not in focus.

Auto Paste To X Selection Paste the contents of the Clipboard when the 
Clipboard contents change.
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3 Click Save.

Using a Temporary Storage Buffer 
Copying and pasting processes use a temporary buffer to hold data until it is 
cleared or replaced. This is similar to Windows Clipboard. The buffer being 
used depends upon whether you are running Windows applications or 
X applications.

 The X selection an X client uses, and how it is used, depends on the client. 
Most systems use the PRIMARY X selection, but other selections such as 
SECONDARY, CLIPBOARD, and CUT_BUFFER0 to CUT_BUFFER7 are 
also defined. Some clients can make use of more than one X selection.

To specify the X selection buffer:

1 In the left pane of  Xconfig, click X Selection. The X Selection page is 
displayed.

2 Select the buffer type.

3 Click Save.

Configuring Fonts

This section describes how to configure Font settings for an Exceed font 

database. You can:

• add fonts, font directories, and font servers to the database

• select default text and cursor fonts

• create font  font aliases

• enable automatic font substitution

• compile fonts

• make fonts scalable

• extract logical font names

• recode Unicode fonts using encoding files
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To access and configure Fonts settings:

1 In the left pane of  Xconfig, select Fonts. Alternatively, from the Xconfig 
Settings menu, select the Font option. The initial tab, Font, is displayed. 

2 Configure Font Database settings. 

• File—Displays the file name for the font database.

• View—Opens the Font Database dialog box in view mode. 

• Edit—Opens the Font Database dialog box in edit mode, which lets 
you manage the font database.

• Browse—Opens a dialog box that lets you browse for another font 
database.

3 Configure Font Defaults settings. Specify the default text font.

About Font Database and Font Servers
This section describes font related information: font database and font 
server. 

The Exceed installation includes font databases that support the 
International CDE. 

The font database supports:

• scalable fonts

• font servers 

You can create multiple font sets and load the one(s) you want to use at run-
time. Exceed can automatically connect to a font server running on the 
XDMCP host server.  The font database is stored in the lfp.xdb file in the 
directory where Exceed is installed. . 

Specific fonts in the font database are stored in font directories and on font 
servers. Exceed also supports pseudo fonts for Unicode. 

A font database can contain X raster (bitmap) fonts in .fon and .wff 
format, True Type scalable fonts, and pseudo fonts (fonts provided by the 
operating system and made available to X clients). X raster fonts can be 
made scalable.
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Font Directories and Font Servers
To access font directories and servers in the font database:

1 In the left pane of  Xconfig, select Fonts. The Font tab is displayed. 

2 Click Edit. A window opens listing all Use the buttons in the Font 
Database dialog box to make the necessary changes.

When an X client requests a font, Exceed searches each font directory or 
server in the font database in the order they are listed in the Font Database 
dialog box. The search continues until the requested font is found.

Fonts
To add, change, or delete individual fonts within the selected font directory 
or server in the Font Database dialog box, click Font List. This displays the 
fonts contained in the selection. The Font Database dialog box also provides 
buttons that let you view the font, font properties, font information, and 
character information.
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Editing the Font Database 

This section describes how to edit a font database. 

To view and edit the font database:

1 In the left pane of  Xconfig, select Fonts. The initial tab, Font, is 
displayed. Alternatively, from the Xconfig Settings menu, select the Font 
option. 

1 Click Edit. The Font Database: file – Xfonts dialog box is displayed. This 
dialog box lists all the font directories and font servers in the font 
database.

2 Use the buttons and options in the Font Database: file – Xfonts dialog box 
to make the following changes:

• add, change, or delete font directories in the database

• add, change, or delete font servers in the database

• change the paths of the font directories/servers

• add Windows or X fonts

• import ot export aliases
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• display the Font List, to view physical and logical font names

• determine (resolve) the physical font names of logical fonts

• rebuild the database

3 Place the font directories/servers containing the most commonly 
requested fonts at the top of the list to reduce the amount of time it 
takes to find a match. Click Move Up and Move Down to change the 
display (search) order.

To add, change, or delete fonts:

1 In the Font Database: file – Xfonts dialog box, select a font directory or 
server, and then click Font List. The Font List dialog box opens displaying 
the fonts contained in the selection.

2 Use the buttons in the Font List dialog box to make the following 
changes:

• add, change, and delete fonts

• load another font database file

• view font lists for each database, create aliases, and scale fonts

• rebuild font databases
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3 After you have made changes, click OK in the Font List dialog box, and 
again in the Font Database dialog box. The modified file (.xdb extension) 
is saved in the directory where Exceed is installed.

Understanding Font Database Settings

This section describes Font Database settings you can configure. For more 
details on how to access the Font Database settings, see “Editing the Font 
Database” on page 160. 

Font Database
The default font database is lfp.xdb which is located in the User directory. 
This file is created during installation. You can modify the font database 
according to your needs. Click Save As to save modifications and type a new 
file name. Click Browse to locate and select another .xdb file.

Default locations for User files 

The font database box displays the following information:

Status—The following characters indicate the accessibility of the font 
directory or server at startup: "L" (Load), "K" (Keep), "I" (Inactive), “N” 
(Directory Not Available), and "P" (Physical Font Name Match Allowed).

For more details, about these options, see “Changing Paths in the Font 
Database” on page 165. 

Font List File—For each font directory, the font database file name 
(without extension) is listed. For each font server, the name of the cache 
used by the server is listed.

Font Path—Displays the path to the font directory and font server included 
in the font database.

Note: When you install fonts, you should install both 75 dpi and 
100 dpi fonts for best font matching. Additionally, if the monitor 
size is greater than 1024 x 768, in the Font Database dialog box, 
place the 100 dpi font in a higher priority than the 75 dpi font.
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Buttons
An array of buttons lets you manage the font database:

Add Font Directory—Opens the Add Font Directory dialog box.

Add Font Server—Opens the Add Server dialog box.

Change—If a font directory is selected, this button opens the Change Font 
Directory dialog box. If a font server is selected, this button opens the 
Change Font Server dialog box.

Change All—Opens the Change All Font Directories/Servers dialog box.

Delete—Prompts you to confirm deletion of the selected font database file 
or font server.

Add Windows Fonts—Opens the Add Windows Fonts dialog box.

Add X Fonts—Opens the Add X Fonts dialog box.

Import Alias—Opens the Import Alias dialog box.

Export Alias—Opens the Export Alias dialog box.

Font List—Opens the Font List dialog box.

Resolve Font Name—Opens the Resolve Font Name dialog box.

New—Opens the font database under a file name prefixed with 
“untitled_lfp”.

Open—Opens a dialog box for locating and selecting a font database file.

Save—Saves the font database.

Save As—Opens a dialog box for saving the font database under a different 
file name.

Move Up, Move Down—Moves the selected font directory or server up or 
down in the list. Exceed searches for fonts by browsing through each font 
directory or server in the order listed. Use this feature if fonts in certain 
directories can meet matching criteria and you want to give those 
directories higher priority. For a long list of directories, you can reduce 
waiting periods while a match is found by moving directories/servers 
containing frequently requested fonts to the top of the list.
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Adding and Changing Font Directories
The Add Font Directory button in the Font Database dialog box lets you add a 
font directory to the font database. The Change button lets you edit the 
selected font directory. These buttons open a similar dialog box: Add Font 
Directory or Change Font Directory, respectively. 

To add a font directory:

1 In the left pane of  Xconfig, select Fonts. The initial tab, Font, is 
displayed. Alternatively, from the Xconfig Settings menu, select the Font 
option.

2 Click Edit. The Font Database: file – Xfonts dialog box opens listing all 
font directories and servers in the font database.

3 Click Add Font Directory. The Add Font Directory dialog box opens.

4 Specify a path and file name (*.fdb), or browse to a location.

5 Select Status options.For more details about these options, see 
“Changing Paths in the Font Database” on page 165.

6 Click OK. The directory is added to the bottom of the font database list.

To change a font directory:

1 In the Font Database dialog box, click Change. The Change Font Directory 
dialog box opens.

2 Make changes to the path, file name, and directory status as necessary.

3 Click OK.

Note: Reloading the font database implements any changes you 
make. To reload the font database while the server is running, 
right-click the Exceed button on the taskbar. On the File menu, 
point to Reload Database, and then click Font.
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Changing Paths in the Font Database

To change the path in the font database:

1 In the left pane of  Xconfig, select Fonts. The initial tab, Font, is 
displayed. Alternatively, from the Xconfig Settings menu, select the Font 
option.

2 On the Font tab, click Edit. The Font Database dialog box opens.

3 Click Change All. The Change All Font Paths dialog box opens.

4 Type the prefix pattern you want to search for in the Find text box and 
the pattern you want to replace it with in the Replace text box. For 
example, to move font directories from F:\EXCEEDW to C:\EXCEED, type 
F:\EXCEEDW in the Find box and C:\EXCEED in the Replace box.

5 To change the status of font directories that match the Find pattern, click 

State in the Change Status area and select the new status you want to  
assign (Load, Keep, Inactive).

• State

Load—When the Exceed X server starts or restarts, the font directory is 
loaded automatically (or when the default font path is manually 
reloaded or requested by a client) or a connection is automatically made 
to the font server.

Keep—This is similar to Load state except the font directory or font 
server connection is kept resident at all times. It remains resident even if 
a client forces a new path that does not include the Keep directory or 
server.

Inactive—The font directory is not automatically loaded or a 
connection with the font server is not re-established when the Exceed 
X server starts. However, a client such as Xset may manually load an 
inactive font directory.
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6 To change the Physical Font Name Match Allowed setting for font 
directories that match the Find pattern:

Click Match in the Change Status area, and enable or disable Physical 
Font Name Match Allowed.  

Physical Font Name Match Allowed—Corresponds to a font file name 
without the extension. Physical font names are displayed in the left 
most column of the Xconfig Font List dialog box. The Match option is 
available only for font directories. 

7 Click Next to find the first font directory or server that matches the Find 
pattern. Xconfig displays the name of the first matching font directory 
or font server.

8 To replace the Find pattern with the Replace pattern in this font 
directory or server, click Change. To skip this font directory or server 
and go to the next match, click Next. To make changes to all matching 
font directories or servers, click Change All.

Changing the Font Directory Search Order
Exceed sequentially searches each individual directory and font server in the 
font database for X client font requests based on their listed order in the 
Font Database dialog box. You may want to move font directories or servers 
containing frequently requested fonts to the top of the font database list to 
minimize the time needed to find them. 

To change the font directory search order: 

1 In the left pane of  Xconfig, select Fonts. The initial tab, Font, is 
displayed. Alternatively, from the Xconfig Settings menu, select the Font 
option.

2 On the Font tab, click Edit. The Font Database dialog box opens.

Note: To change only the status or Physical Font Name Match 
Allowed setting of font directories or servers, leave the Find text 
box blank. This indicates that the changes should be made to all 
font directories and servers.
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3 Select the font directory or server to move and click Move Up or Move 
Down as necessary. 

Adding and Changing Font Servers
You can add or change font servers for a particular database by using the 
Font Database dialog box. 

To add a font server:

1 In the left pane of  Xconfig, select Fonts. The initial tab, Font, is 
displayed. Alternatively, from the Xconfig Settings menu, select the Font 
option.

2 On the Font tab, click Edit. The Font Database dialog box is displayed.

3 Click Add Font Server. The Add Font Server dialog box opens.

4 Specify a host name or IP address, a transport protocol, and a server 
port.

5 Select Status options (Load, Keep, Inactive).

6 Click OK. The server is added to the bottom of the font database list.

To change a font server:

1 In the Font Database dialog box, select a font server and click Change. 
The Change Font Directory dialog box opens.

2 Make changes to the font server and status as necessary. 

3 Click OK.

Note: If a font server stops running, the Exceed X server 
automatically reconnects when the server is running again.

Note: Reloading the font database implements any changes you 
make. To reload the font database while the server is running, 
right-click the Exceed button on the taskbar. On the File menu, 
point to Reload Database, and then click Font.
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Accessing the Font Server (Advanced Settings)

This section describes the advanced font management settings. The section 
describes how to control access to the font server, after you have added it to 
your list of font databases, you can control how it is accessed.

To access the Advanced settings on your Fonts page:

1 In the left pane of  Xconfig, select Fonts. Alternatively, from the Xconfig 
Settings menu, select the Font option. The initial tab, Font, is displayed. 

1 Click the Advanced tab. The tab is displayed. 

2 Modify the settings, and click Save. 

Font Servers
Synchronous Operation—Font server requests are completely processed 
before Exceed continues servicing X clients. This option should be selected 
only for troubleshooting. By default, other X clients are serviced while an X 
client is waiting for the response from the font server.

Timeouts (secs.)—Specify the Read and Write Timeout values (from 0 
through 999) for font servers. By default, the Read timeout is 30 seconds 
and the Write timeout is 5 seconds. After timeout, Exceed assumes the font 
server is no longer available and closes the connection. If the timeout is too 
short, delays caused by network traffic might cause Exceed to unnecessarily 
disconnect from the font server. If the timeout is too long and the font 
server is unavailable, an excessive delay occurs before Exceed closes the 
connection. Default values favor a reliable connection, not the quick 
response. If the timeout is set for a quick response, the Enable Auto Reopen 
option should be selected.

Enable Auto Reopen—Instructs Exceed to try reconnecting to the font 
server if the connection is broken. If the font server is unavailable, periodic 
attempts to reconnect will slow down Exceed. If the font server is reliable, 
you can clear this option.
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Enable Cache—Instructs Exceed to locally cache fonts from the font server. 
Each font is obtained from the font server once. If the same X applications 
are usually run and all necessary fonts are cached, then there is virtually no 
need for the font server. Font access from the cache is faster than from the 
font server. This option is enabled by default.

Local Fonts First—Searches local fonts first. Usually, the search priority is 
from top to bottom in the font database list. This option overrides the font 
search order set by the X client, assuming that the X client assigns a higher 
priority to the font server over local fonts. This is useful where the local font 
database can provide most of the fonts necessary to run X applications. This 
option is disabled by default.

Default Resolution for Scalable Fonts
From the drop-down list, select a resolution. Exceed uses this value to 
calculate font size in pixels. This is useful where the X client specifies size of 
a requested font in points but does not specify the resolution. If this value is 
set to zero, then the resolution is defined automatically by the screen 
resolution.

Other Options
Automatic Font Substitution—Substitutes the closest matching font for 
any font request that cannot be filled and would otherwise result in an error.

Optimize For Java VM—This option works around issues with some Java 
VM (buffer overflow) running on UNIX hosts (Java applications are more 
sensitive to large font databases than X applications).

Use Typographic Font Size—Specifies use of the absolute font size 
(according to the font family specification). By default, this option is 
enabled. 
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Making Fonts Scalable

The Make Scalable button in the Font List dialog box lets you transform the 
selected font (resize, rotate, slant, and so on). Scalable fonts let you open 
and use font sizes that do not correspond to physical font files. Font scaling 
does not occur automatically; if you want to make a font scalable, you must 
create a scalable font entry.

To scale fonts:

1 In the left pane of  Xconfig, click Fonts. The Font tab is displayed.

2 Click Edit. The Font Database dialog box opens.

3 Select the font path and directory containing the font you want to scale.

4 Click Font List. The Font List dialog box opens.

5 Select the real font that you want to make scalable.

6 Click Make Scalable. A scalable entry is created. It has a physical name of 
(scalable) and appears at the end of the font list. 

All the real fonts in this font directory that you can derive from the 
scalable entry are now scalable. To determine which fonts are scalable, 
click View Font while this scalable entry is selected. Note that they all 
have a similar XLFD logical name. At run time, Exceed chooses a closest 
real font from the list of fonts to be scaled.

Creating Font Aliases
In some cases, X clients may request a font not included in the database. 
The server responds by issuing a “Font not available” error message and 
logging the logical name or search pattern of that font in the log file. 

You can use a font alias to link the requested font to an existing font with 
similar characteristics. After you create the font alias, clients can request the 
previously denied font so that the server can deliver the font alias. 

Note: Check the log file regularly for denied font requests.
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To create a font alias:

1 In the left pane of  Xconfig, click Fonts. The Font tab is displayed.

2 Click Edit. The Font Database dialog box opens.

3 Click Font List. The Font List dialog box opens.

4 Click Search to find an existing font resembling the requested font 
pattern. If you do not find one in this directory, try another directory 
until you find one that you consider a reasonable match. 

5 Click Make Alias in the Font List dialog box.

6 Type or paste the font name in the box.

7 Click OK.

The font alias appears immediately below the logical font name in the 
second column of the Font List dialog box.

Creating Several Aliases
To create several aliases at the same time, create an alias file containing all of 
the desired aliases. An alias file is a text file that you can create or edit in any 
text editor, such as Windows Notepad. You can then import the contents of 
the alias file into the font database.

Importing Alias Files
You can import a file containing aliases into the font database. 

To import an alias file:

1 In the left pane of  Xconfig, click Fonts. The Font tab is displayed.

2 Click Edit. The Font Database dialog box opens.

3 Click Import Alias. 

4 In the Import Alias dialog box, type the path of the alias file being 
imported in the From box or click Browse.

5 In the To box, select a destination path from the drop-down list. By 
default, the entry selected in the Font Database dialog box is initially 
displayed.
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6 Click Import to start importing.

7 Repeat steps 4 – 6 for each alias file you want to import.

8 Click Close.

Exporting Alias Files
The Export Alias dialog box lets you export aliases from the font database. 
Using this feature, you can export a group of aliases to a file so that you can 
distribute them among other Exceed users in your company.

To export an Alias file:

1 In the left pane of  Xconfig, click Fonts. The Font tab is displayed.

2 Click Edit. The Font Database dialog box opens.

3 Click Export Alias. 

4 In the Export Alias dialog box, select the source path in the From box. By 
default, the entry selected in the Font Database dialog box is initially 
displayed. Select the desired Output Type.

5 Type the destination path in the To box or click Browse.

6 Click Export to start exporting.

7 Repeat the above steps for each alias file you want to export.

8 Click Close.

Alias File Format
To create several aliases at the same time, create a file containing all the 
desired aliases. You can then import the contents of the alias file into the 
font database. You can create an alias file in any text editor, such as 
Windows Notepad.

Guidelines
• Each line in a standard X alias file contains two columns separated by 

spaces or tabs.

• Lines in the alias file have a certain format. If spaces or quotation marks 
are part of either an alias name or a line, enclose the name in quotation 
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marks ("). Within the name, use the backslash character (\) before any 
quotation mark or space. For example, if you want to enter the line 
ABC"DEF fixed, then type "ABC\"DEF" fixed

Within names, you can use the standard wildcard characters * and ?. 
For example:

FILE_NAMES_ALIASES lines, typically used to automate physical font alias 
matching, are ignored. However, you can enable physical name 
matching by using the Physical Font Name Match Allowed check box in 
the Add Font Directory dialog box. 

• The following non-standard source file statements are supported:

a) Enter comments by placing a # (number sign) as the first character 
on a source line.

b) Alias names can be limited to a particular directory in the font 
database using the following source line:

+Y

where Y is the name of any directory listed in the database. For 
example:

+C:\EXCEED\FONT\75DPI

By default, a + line remains in effect until the next + line is 
encountered. A + line not followed by a path resets the search to the 
entire database. 

c) Specifying a $ as the first character of a path in an alias file implies 
the Exceed Home\Font directory. For example:

$andrew

This specifies the Home\Font\Andrew directory.

d) If the alias name ends in a period (.), the extension is removed. The 
server also removes trailing . tags from font name patterns.

myfont-*-courier-bold-r-normal--*-*-*-*-m-*-iso8859-1
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Encoding File Support
Exceed offers encoding file (.enc) support for the recoding of 
Unicode-encoded fonts (iso 10646-1) to a specified encoding. Before you 
begin, however, you must ensure that the User directory contains the 
following:

• an encodings.dir file

• a subdirectory called encodings in which you can place the encoding 
files (.enc).

To make use of encoding files, create an alias to the Unicode font you want 
to recode. You must ensure that the Unicode font contains all of the glyphs 
specified in the .enc file the font alias refers to. If a glyph is missing in the 
Unicode font, it will be absent from all text created with the alias font.

Setting Up Remote Font Architecture
By default, Exceed installs and makes use of fonts locally. However, you can 
place fonts in a central network location and configure each installation of 
Exceed to use these remote fonts.

To implement this architecture, you need a machine to serve as the remote 
font repository. For the purpose of this procedure, we will call the 
repository FONTREP. This name represents the PC name. All Exceed 
installations must have access to FONTREP to access the remote fonts.

This procedure assumes that the installation uses the default location and 
that the installation is performed by the user “Administrator”.

To set up remote fonts:

1 On FONTREP, perform a complete installation of Exceed ensuring that 
the installation includes all of the fonts that your users require.

2 Share the following font directory and set the proper permissions for 
users.

C:\Program Files\Hummingbird\Connectivity\version\Exceed\
Font\

The remote administrator should have full control and Exceed users 
who will connect to FONTREP should have read access at the 
minimum.
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3 Copy the *.fdb and lfp.xdb files from the User directory to the Exceed 
Font folder.  

The folder is in the following location:

C:\Program Files\Hummingbird\Connectivity\version\Exceed\Font\

4 Rename the relocated lfp.xdb file to shared.xdb.

5 Edit the registry on the client machines that are using 
HKEY_LOCAL_MACHINE\SOFTWARE\Hummingbird\Connectivity
\version\Exceed. 

To do this, create a new String Value for SharedFontDir and assign the 
value \\FONTREP\font, which is the directory that you shared 
previously.

6 On FONTREP, launch Xconfig. In the left pane of  Xconfig, click Fonts. 
The Font tab is displayed.

7 On the Font page, browse to and select \\fontrep\font\shared.xdb. Use 
the fully qualified rather than the local path.

8 Click Edit to open the Font Database dialog box. Ensure that all font 
paths begin with \\FONTREP\font\. 

If the paths differ, click Change All. In the Change All Font Paths dialog 
box, find and replace the default location, C:\Program Files\
Hummingbird\Connectivity\version\Exceed\Font\, with the shared 
location, \\FONTREP\font.

For example, the font paths should read:

\\FONTREP\font\misc\

\\FONTREP\font\75dpi\

9 Save the changes, and exit Xconfig.
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To deploy remote fonts using Sconfig:

1 On FONTREP or any other PC that users can access, perform an 
administrative installation (c:\admin) of Exceed. 

2 Copy the modified exceed.xcfg you created on FONTREP to 
C:\admin\Program Files\Hummingbird\Connectivity\
version\Default User\Exceed on the system where you performed the 
administrative installation. 

3 Launch Sconfig to customize this administrative installation. In the left 
pane, click Features, and expand the Exceed version tree that appears in 
the right pane. Expand the Exceed item and disable Exceed Fonts.

4 In the left pane, click Registry and set the following:

• in the Root box, type HKEY_LOCAL_MACHINE

• in the Data Type box, select REG_SZ.

• in the Key box, type SOFTWARE\Hummingbird\Connectivity
\version\Exceed

• in the Value Name box, type SharedFontDir

• in the Value Data box, type \\FONTREP\font

5 Save the changes, which will create a Transform file (font.mst).

6 Do the following on each client machine:

a) Connect to the system where you performed the administrative 
installation. In this case, the font.mst file will be in the root 
directory of the administrative copy.

b) Run the following command:

Setup /v”TRANSFORMS=font.mst”
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7 When the installation is complete, the client systems are configured to 
use the remote fonts remotely on FONTREP. To confirm this, launch 
Font Management in Xconfig again. The font database should point to 
\\FONTREP\font\shared.xdb. If you click Edit on the Font page, the 
various font paths should be prefixed with \\FONTREP\font. 

Configuring OpenGL settings for Exceed 3D and GLX

This section describes how to configure OpenGL settings. It also describes 
how Exceed allows applications that use the Mesa OpenGL client library to 
use server-side software OpenGL rendering.

The OpenGL page is available only if you have Exceed 3D installed. 

Note: By default, the font server’s cache will be located in the 
FS_cache folder under the \\FONTREP\font directory. If you want 
the font server’s cache to reside locally, use the FSCacheDir 
environment variable to specify the desired location.
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To configure OpenGL settings:

1 In the left pane of  Xconfig, click OpenGL. The OpenGL page is 
displayed. 
Alternatively, display the Xconfig X Protocol page, and its Extension 
tab. At this tab, enable the GL option, and click Configure. A dialog box 
is displayed, allowing you to set (select or clear) the OpenGL 
configuration. 

2 Configure the OpenGL options of your choice: 

OpenGL Setting Details

Enable OpenGL Enable the GLX extension so applications can use 
OpenGL. 

Recommended setting: Enabled

Disabling this option will prevent applications from 
using GLX. If an application supports multiple drawing 
methods, disabling GLX may force it to use a non-GLX 
drawing method. 

Why you may want to disable GLX:

•  Work around application bug in GLX rendering path

•  Work around application slow performance in GLX 
rendering path

•  Avoid requiring OpenGL-supporting video card on 
Exceed host

Direct Rendering Increase performance for applications running on the 
local host by passing OpenGL rendering commands 
directly to the GPU. 

Recommended setting: Enabled

When enabled, applications that are linked with 
hclglx.dll can pass their OpenGL rendering commands 
directly to the GPU. This can greatly increase 
performance compared to indirect rendering, where all 
rendering commands must first pass through the X 
server. 

Applications that are not on the local host, or are not 
linked with hclglx.dll, will fall back to indirect rendering.
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Hardware Acceleration Use the local GPU instead of software for OpenGL 
rendering.

Recommended setting: Enabled

Attempt to use a hardware-accelerated OpenGL driver 
for rendering. If none is available, or this option is 
disabled, the Microsoft Software OpenGL renderer is 
used. The software renderer is slower and supports 
fewer OpenGL features, notably disabling GLX 1.3 
support. 

RDP sessions cannot access hardware acceleration 
and always use the software renderer. Because this 
option switches OpenGL drivers, disabling it is useful 
for troubleshooting, to determine if an application 
crash or rendering issue is related to a specific 
OpenGL driver.

One Visual Per Pixel 
Format

Provide applications with a full list of Visuals, one for 
every Pixel Format the video card supports.

Recommended setting: Enabled

Each Pixel Format on the local video card supports 
different OpenGL capabilities, such as color depth, 
stencil buffer, or double buffering.

When this option is disabled, only a handful of Visuals 
with reasonably diverse capabilities are made 
available to applications. If an application complains 
that it cannot find a suitable visual, make sure this 
option is enabled. 

Sometimes applications do not correctly specify 
required visual capabilities which can result in errors or 
rendering issues. In such a case, disable this option to 
make the application choose a different visual.

Related undocumented flag: 
GLXRequiredVisualFBConfigAttribs

OpenGL Setting Details
179



OpenText™ Exceed™ User's Guide
MESA Server Side Software OpenGL Rendering 

This section describes how Exceed handles applications that use Mesa 
OpenGL client library.

By default, Exceed now allows applications that use the Mesa OpenGL client 
library to use server-side software OpenGL rendering. This means that 
Mesa (version 7.1 and later) uses its internal Software Rasterizer to render 
OpenGL and sends the resulting image to display in Exceed.  

Overlay Support Advertise hardware overlay plane support.

Recommended setting: Disabled

Some applications use hardware overlay planes to 
draw parts of the user interface (UI). This option is 
disabled by default, because most applications do not 
need overlay support, and it prevents careless 
applications from accidentally selecting an overlay 
visual.

To function, this option requires hardware support in 
the GPU and overlay support enabled in the video 
driver. Typically only workstation-class GPUs support 
hardware overlays.

GLX 1.3 Support Support and advertise GLX 1.3+ features

Recommended setting: Enabled

GLX 1.3 notably adds support for FBConfigs and 
PBuffers and allows applications to use more 
advanced OpenGL functionality. 

Sometimes applications have different rendering paths 
for GLX 1.3+ vs. lower GLX versions.

Disabling GLX 1.3 may cause an application to choose 
a different method of rendering and work around 
drawing or other issues.

OpenGL Setting Details
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For some applications this may increase performance.  For other 
applications, this may decrease performance. To disable this and force the 
previous default behaviour of indirect OpenGL rendering on the Exceed 
host, set the following environment variable before launching the 
application:

LIBGL_ALWAYS_INDIRECT=y

For example:

LIBGL_ALWAYS_INDIRECT=y glxgears

Applications that run on hosts with NVIDIA or AMD OpenGL drivers 
installed are not affected, and will continue to use indirect OpenGL 
rendering as always.

To disable Mesa software rendering completely and revert to the previous 
Exceed 14 behaviour, open your system registry and navigate to the 
following key:

HKEY_LOCAL_MACHINE\SOFTWARE\Hummingbird\Connectivity\15.00\Exceed\
XServer

Create a new DWORD value named MesaVisualCompat and set its value to 0. 

This will disable Mesa software-based OpenGL rasterizer and force the use 
of LIBGL_ALWAYS_INDIRECT=y on the application server, to make indirect 
rendering work.

Configuring X Protocol Settings

This section describes the X Protocol settings. 

These settings govern how the X protocol is interpreted, and thus regulate 
how Exceed operates. 

X protocol settings you need to:

• configure settings on the Protocol tab 

• configure extensions (enable a specific extension, and make specific 
extensions available to untrusted clients)
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Configuring the Protocol tab
This section describes how to configure the settings located on the Protocol 
tab of the X Protocol configuration page. 

To configure the settings at the Protocol tab:

1 In the left pane of  Xconfig, click X Protocol. Alternatively, from the 
Xconfig Settings menu, select Protocol. The Protocol tab is displayed. 

2 Under Compatibility, select or clear the following settings:

• DECwindows Compatibility—Provides DECwindows 
compatibility.

• X Conformance Test Compatibility—Configures Exceed to pass 
certain tests in the X Conformance Test Suite (X Test Suite) that it 
would normally fail. These failures occur because some X clients 
have problems for which the Exceed X server has benign 
workarounds. You should also select Allow Clients To Modify Host 
Access Control List on the Security page to pass certain X Test Suite 
tests. To access the Security page, click Security, Access Control And 
System Administration in Xconfig. 

Additionally, selecting this option overrides the Delay Window 
Mapping option (in the Multiple Window Mode Advanced dialog box). 
If Allow Clients To Modify Host Access Control List is selected, there is 
no delay on window mapping.

• Enable Custom Vendor String—Lets you specify the vendor string 
that is passed to clients at connection time (in the connection 
block). If your client requires a specific vendor string, select Enable 
Custom Vendor String, type the Vendor String in the box, and click OK.

Configuring X Protocol Extensions 
This section describes how to:

• enable or disable X Protocol extensions
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• make some extensions available to untrusted clients (by selecting them 
in the right pane of the Extensions tab)

To access and configure the X Protocol extensions:

1 In the  Xconfig left pane, click X Protocol. Alternatively, from the 
Xconfig Settings menu, select Protocol. The X Protocol page is displayed. 

2 Click the Extensions tab. The tab is displayed. 

3 Under Enable Extensions:

• Select the check box next to the extensions you want to enable. 
Clear the check boxes for the extensions you want to disable. 

4 Under Enable Extensions for Untrusted Clients

• Select the check box next to the extensions you want to enable. 
Clear the check boxes for the extensions you want to disable. 

5 Click OK to save your selections. 

Click Default to restore 
the original protocol 
extension selections for 
the Xconfig configuration 
file (initially 
Exceed.xcfg).

Understanding X Protocol Extensions

This section lists the supported extensions. For details on how to enable 
them or disable them, see “Configuring X Protocol Extensions” on 
page 182.

Default Protocol Extensions
The following extensions are the Xconfig defaults for Exceed.xcfg:

Warning!  If the All Extensions entry is cleared in the right list box 
after being selected, then extensions remain selected. You must 
clear each one to disallow access by untrusted clients.
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• BIG-REQUESTS—Lets clients extend the length box in protocol 
requests to a 32-bit value from the standard X protocol of 2[18] bytes 
long. This is useful for certain graphics extensions and other extensions 
that transmit complex information to the server. This extension enables 
the use of protocol requests that are longer than 262140 bytes.

• DAMAGE—Lets clients be notified whenever something is drawn to a 
window. This feature is useful for virtual network computing (VNC) 
servers, for screen magnifiers, and for clients using the Composite 
extension to update the screen.

• DOUBLE-BUFFER (X11R6.1 DOUBLE-BUFFER extension)—Lets 
applications draw images to a back buffer. When the image is 
completely rendered there, it can be swapped into the role of the front 
buffer, which makes the image. Thus, only completely rendered images 
are shown and remain visible during the entire time it takes to render a 
new frame. The result is flicker-free animation.

• RANDR—The resize and rotate extension (RandR) lets clients modify 
the size, accelerated visuals, and rotation of an X screen. It also informs 
clients when screens were resized or rotated, and it lets them discover 
which visuals have hardware acceleration available.

• RECORD—Enables support for recording all core X protocol and 
arbitrary extension protocol completely within the X Server. When the 
extension is requested to intercept a specific protocol by one or more 
clients, the protocol data is formatted and returned to the recording 
clients. The extension provides a mechanism for capturing all events, 
including input device events that go to no clients. The extension does 
not provide data compression before intercepted protocol is returned to 
the recording clients.

• RENDER—Enables anti-aliased text and alpha-blending on the Exceed 
X server. Newer desktop environments (such as the latest versions of 
KDE and GNOME) use the RENDER extension for anti-aliased text.

• SECURITY—Enables the protocol needed to provide enhanced server 
security. This extension cannot be exposed to untrusted clients. This 
extension introduces the notion of secure and insecure extensions. A 
secure extension is believed to be safe for use by untrusted clients; that 
is, there are no known significant security concerns that an untrusted 
client could use to destroy, modify, or steal data from trusted clients. All 
extensions not considered secure are called insecure.
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• SHAPE—Allows for arbitrary window and border shapes. It causes the 
server to report the SHAPE extension when queried by a client for the 
list of supported extensions. By default, this setting is selected. Drawing 
operations on non-rectangular windows are slower than on rectangular 
windows. Certain clients use non-rectangular windows instead of 
rectangular windows if the SHAPE extension is present. To improve the 
performance of these clients, disable the SHAPE extension before 
starting the client.

• SYNC—Enables the X11R6 synchronization extension. This extension 
provides primitives that let synchronization between clients take place 
entirely within the Exceed X server. It removes any error introduced by 
the network and makes it possible to synchronize clients on different 
hosts running different operating systems.

The SYNC extension is important for multimedia applications, which 
synchronize audio, video, and graphics data streams. This extension 
also provides internal timers within the Exceed X server to which client 
requests can be synchronized. This lets you implement simple 
animation applications without any round-trip requests. It also makes 
the best use of buffering within the client, network, and server.

• XFIXES—A collection of improvements for deficiencies in the core 
protocol, including:

• Save Set processing changes

• notification when a selection changes 

• server-side region objects 

• cursor tracking

• cursor names (labels)

• XINERAMA—Allows applications and window managers to use two or 
more physical displays as one display. The display behavior may differ 
depending on the window manager used. If you enable this extension, 
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ensure that the Use All Monitors setting (Xconfig, Screen Definitions) for 
screen 0 is also enabled.

• XInputExtension—Enables the X Input Extension Protocol (X11R6 
synchronization extension). Any kind of input device may be used as an 
extension input device. This extension is designed to accommodate new 
types of input devices that may be added in the future. Starting with the 
core X keyboard and pointer, new devices need have only their new 
classes (unique numbers) registered to be recognized by this extension; 
they do not need an entire new extension for each new device.

• X-Resource—Lets clients query the X server about its usage of various 
resources. It is a developer tool to assist with making server resource 
usage more efficient and to debug server-side resource leakage.

• XTEST—Client/server extensions required for hands off validation of 
the X11 server. They provide access to write-only server resources (for 
example, the cursor associated with a specific window) and remote 
activation of certain input device events (such as controlling the 
pointing device or pressing a key or button).

More information about other protocol extensions. 

Other Protocol Extensions
The following are the extensions not selected by default in Exceed.xcfg:

• Composite—Lets clients request that all drawing to window is 
redirected to an off-screen buffer. Though the DAMAGE extension, the 
client (called a compositing manager) can know which areas of a 
window are modified and render the windows on screen. By using the 
drawing requests (from both the core protocol and the RENDER 

Note: 

• It is recommended that you use TrueColor (24 or 32-bit) on 
each display, but display setting inconsistencies do not pose a 
problem for most window managers. It is also recommended 
that you do not use 8-bit (256 color) modes.

• The physical configuration of monitors in anything other than a 
horizontal or vertical row can cause inconsistent behavior.
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extension), the compositing manager can create special effects, such as 
translucent windows.

• GLX—Enables support for OpenGL, a high-performance 3D-oriented 
renderer. When this extension is selected at the Extensions tab of X 
protocol page, you may click the Configure button. A dialog box is 
displayed, allowing you to configure GLX functionality.  See also 
“Configuring OpenGL settings for Exceed 3D and GLX” on page 177.  

• MIT-SHM (Shared Memory)—Lets local X clients store ximage data in 
a memory segment that is shared with the local X server. This precludes 
having to send the ximage over the Xlib interprocess communication 
channel. For large images, using this facility can result in an increase in 
performance.

• XKEYBOARD—Provides improved layout and features for keyboards 
(for example, Russian and Hungarian).

• XVideo—Utilizes hardware capacities to speed up video playback and 
to reduce total CPU time on both systems running Exceed and the X 
client. It also provides server-side video adjustment for brightness, 
contrast, and hue if the hardware supports it. 

The Xvideo extension is comprised of two parts:

• Image playback—Depending on the capacities of the system video 
card, Exceed can utilize the color space conversion or hardware 
scaling provided by the video card to play back video frames of 
certain formats and to rescale video frames to the desired size.

• Video stream—Exceed provides interfaces to play back the video 
stream from live sources such as web cams. Exceed also supports 
still image capture from those video streams to X windows.

Note: To successfully make use of XVideo functionality, ensure 
that the following is true:

• Your hardware provides the required capacities. 

• Xvideo support is available and enabled in the video playback 
software (the X client).

• As X applications typically run on a remote host, Xvideo shared 
memory should not be used. Please refer to the X application’s 
documentation for more information.
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2

Performance Settings

Configuring Performance Settings

This section describes how to configure the following Performance settings:

• Drawing Settings 

• Advanced Settings

The settings are used to: 

• adjust Microsoft Windows system resources used by Exceed for various 
performance-related drawing techniques

• configure Exceed for optimal graphics performance for your current 
video configuration

To configure Performance settings:

1 In the left pane of  Xconfig, click Performance. Alternatively, from the 
Xconfig Settings menu, select the Performance option. The Performance 
tab is displayed.

2 Modify the Drawing and Advanced settings.

Drawing Settings 
Under Drawing, modify: 

Draft Mode—Selected by default, this option improves performance, but 
results in a slight and generally unnoticeable reduction in drawing accuracy.

Batch Requests—Can help improve the performance of the Exceed X 
Server.

Backing Store—Reduces network traffic and improves window refresh 
speed at the expense of window drawing speed and memory. You can set the 
following options that determine the conditions under which the backing 
store is used:

• None—Never saves the contents of the X application window.
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• When Mapped—Backing store is provided to all mapped windows if 
the application requests it. Window content is saved only when the X 
application is drawing to the window when it is mapped. (In this 
context, mapped means not minimized.) 

• Always—Always attempt to preserve the contents of any window, 
whether or not it is mapped, if the application requests it.

Advanced Settings 
Read On WriteBlocked—Continues processing X application requests even 
when the application temporarily stops responding to a reply or event.

Oversized Cursors—Lets the X application create cursors larger than 32 by 
32 pixels.

Configuring Troubleshooting Settings

For detailed information 
about the user interface 
and how to access it, see 
Exceed Help.

This section describes the troubleshooting settings that you can configure. 
Use the Troubleshooting page in Xconfig to modify the following settings:

• Log Settings

• Trace Settings

They allow you to: 

• specify font and other information that is written to the log file

• view the log file (Exceed.log)

• trace Exceed activity from startup

To view or modify the troubleshooting settings:

1 In the left pane of  Xconfig, click Troubleshooting. Alternatively, from the 
Xconfig Settings menu, select the Troubleshooting option. The 
Troubleshooting tab is displayed. 

2 Modify the following groups of settings: Enable Log and Trace. 
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Log Settings 
• Enable Log

This setting activates the Exceed built-in logging functionality. Initially, 
the Enable Log option is selected, and Exceed logs information to the 
file specified in this text box. By default, the Exceed.log file is stored in 
the User directory.  You can specify another file by typing the full name 
and path in this box. To open this file in a text editor, click View.

When you select the Enable Log setting, you can also enable and disable 
any of the following:

• Log Font Opens—Lets you log all requests to open fonts. Select this 
option only for troubleshooting purposes. Do not forget to clear this 
option when you are finished troubleshooting. By default, this setting is 
not selected.

• Log Window And Command Names—Causes Exceed to log the initial 
settings of the WM_COMMAND and WM_NAME properties on 
Input/Output root-level windows. This is useful when you are trying to 
determine which client is associated with a particular network socket. 
Select this option only for troubleshooting purposes. Do not forget to 
clear this option when you finish troubleshooting. By default, this 
setting is not selected.

• Log GLX Information—Logs all OpenGL requests. Select this option 
only for troubleshooting purposes. Do not forget to clear this option 
when you are finished troubleshooting. By default, this setting is not 
selected.

• Log Connection Error—Logs connection errors.

• Log XDMCP Progress Status—Logs all XDMCP progress status.

Trace Settings
The Trace group box lets you enable or disable any of the following:

• Trace Initially On—Do not select the Trace Initially On setting unless 
you want to trace the dialog between the server and the first client. 
When you select this option, the trace starts when the server does, and 
all dialog between the server and the first client, including XDM, is 
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traced. The trace file is output to the User directory with a .trx file 
name extension.   

• Slow Trace—Lets you trace situations even when the server hangs. If 
the server hangs and the PC must be rebooted, the current trace file is 
likely unavailable; this setting lets you compensate for this situation.

Viewing the Log File

This section describes how to display a log file, from the Troubleshooting 
page, or the Exceed menu. 

The following information about X applications and their connections may 
be logged:

• remote port, IP address, socket # connection 

• initial data connection from X applications

• who closed the connection and error number indicating the reason for 
closing

• rejection of an X application request to connect to Exceed

• names of fonts requested by clients but not found

• names of fonts substituted if the Automatic Font Substitution (Font 
Database dialog box) and Log Font Opens (Troubleshooting page) options 
are selected

• names of colors requested but not found in the RGB database

• Open GLX information

• which application is being loaded

Warning!  Select this setting only when absolutely necessary; it 
severely degrades server performance. Do not forget to clear this 
setting after performing your trace.

Warning!  Use this setting only when absolutely necessary, as it 
severely degrades server performance.
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To display a log file from Xconfig: 

1 In the left pane of  Xconfig, click Troubleshooting. Alternatively, from the 
Xconfig Settings menu, select the Troubleshooting option. The 
Troubleshooting tab is displayed. 

2 Click the View button, next to the name of the file. 

3 Select a log file you want to view, and click OK. 

To display a log file from the  Exceed menu: 

From the File menu, select View Log. 

 

Handling Denied Requests for Colors

This section describes what happens if a f a client requests a color that the 
server cannot supply. 

In this case, the requested color name appears in the log file. You can view 
the log file on the Troubleshooting page in Xconfig. Add these colors to the 
RGB database for future use.

To add colors to the RGB database:

1 In the left pane of  Xconfig, click Display And Video. The initial tab, 
Screen, is displayed. 

2 Click the Video tab.

3 Click Edit to open the RGB text file in a text editor.tab. 

4 Add a new entry to the database for the color name requested and 
assign Red, Green, and Blue values for that color name. The assigned 
Red, Green, and Blue values are arbitrary; they may or may not be 
related to the actual color name. An entry is made for the color to 
ensure that a color is returned to the client when requested instead of 
creating a "Color not found" error.

For example:
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A failed request for the color was logged.

239255242Melon

Interpretation—The next time a client requests the color Melon, the 
RGB combination of 239, 255, 242 will generate the color. This may or 
may not be the color that the client visualized, but a color is returned 
and the operation proceeds.

5 Save the modified rgb.txt file.

6 Right-click Exceed on the Windows taskbar, select File menu, select 
Reload Database, and then click RGB to reload the RGB database. 

This color is now available to X clients.

Handling Denied Requests for Fonts

If a client requests a font that the server cannot supply, the name of the 
requested font appears in the log file. To view the log file, click View in the 
Xconfig Troubleshooting page.

To resolve requests for missing fonts, you can:

• create font aliases

• compile the font source in .bdf or .pcf format using the Xconfig Font 
Compiler

• enable automatic font substitution

Note: Exiting and restarting the server also reloads the database.
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2

Power Management

Configuring Power Management Settings

This section describes how to configure the following Power Management 

Settings: 

• Refuse Sleep

• User Interaction

• Presentation

• Wake Up

To configure the Power Management settings:

1 In the left pane of  Xconfig, click Power Management. Alternatively, from 
the Xconfig Settings menu, select the Power Management option. 

2 At the Power Management tab, select or clear the options of your choice. 

Refuse Sleep
Select one of the options below to indicate under what circumstances the 
system should not enter sleep mode. If you are running connections to 
remote hosts, select the Always option.

• Always—Always refuse sleep requests.

• When Connected—Exceed refuses the sleep requests when there is a 
connection to an X server, either local or remote.

• When Remotely Connected—Exceed refuses the sleep requests when 
there is remote connection to an X server.

• When Remote Client Is Active Within (sec.)—Exceed refuses the sleep 
requests when a remote connection is active within the specified time 
(in seconds).
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User Interaction
Maintains the display even if the system enters sleep mode.

Select a time interval (Grace Period Before Sleep) from the list to determine 
how long the system should standby before entering sleep mode.

Examples of user interaction are mouse or keyboard actions, drawing, 
change of geometry, or other data exchanges between the Exceed X server 
and the X clients.

Presentation
Causes the system to reset after sleeping for a long period of time.

Prevent display from being shut down—Maintains the display even if the 
system enters sleep mode (due to a Windows setting that turns the monitor 
off).

Wake Up
Server reset after critical sleep—Causes the system to reset after sleeping 
for a long period of time. For example, an extended sleep period might be 
caused by some critical situation such as low battery power.

Configuring System Administration Settings

This section describes how to configure system administration settings. The 
System Administration page can be locked by the system administrator.

 In this case, you cannot disable settings. 

 To configure the System Administration features: 

1 In the left pane of Xconfig, click System Administration. Alternatively, 
from the Settings menu, select System Administration. The page is 
displayed. 

2 Select or clear the relevant option. If you select a particular check box, 
the associated feature is disabled. 
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3 Click Save. Selections are enforced the next time you start Xconfig.

The following features may be disabled (if the check box is selected) or 
enabled (if the check box is cleared): 

Options Result

Disable Features Select this check box to access the list of features. 

Test Extensions X clients cannot test X11 servers by simulating 
X events (such as keystrokes and mouse clicks).

Trace The Trace command is not available on the Exceed File 
submenu. No trace file is created.

X Client Native Window 
Manager Exit

In the Client window, the Exit button is unavailable. 
Also, the close command on the pop-up menu (right-
click the client window title bar) is unavailable.

X Server Copy/Paste On the Exceed menu, all copy and paste commands 
are not available on the Edit submenu. Also, all toolbar 
copy and paste buttons are unavailable.

X Server Exit On the Exceed menu, the Exit command is not 
available on the File submenu.

X Server Reset On the Exceed menu, the Server Reset command is 
not available on the Tools submenu.

X Server Toolbar Close When enabled, the Exceed toolbar cannot be closed.

Xstart Browse Hosts and 
Applications

Xstart Browse buttons are unavailable. These buttons 
open the Browse For Hosts dialog boxes.

Xstart Browse Hosts and 
Applications 
Configuration

On the Other page of the Xstart Settings dialog box, 
the Configure buttons are not available. These buttons 
open the Browse Hosts/Applications dialog boxes.

Xstart Load Optimization On the Other page of the Xstart Settings dialog box, 
the Load Optimization option is not available. Also, the 
Configure button that opens the Browse Load 
Optimization dialog box is not available.
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Restricting Access to Xconfig

This section describes how to set a password to:

• restrict access to Xconfig and specific Xconfig settings

• restrict access to configuration settings on the System Administration 
page. 

 To specify a password for the first time: 

1 In Xconfig, from the Actions menu, select Change My Password. 

2 In the New Password text box, type the password of your choice. 

3 In the Confirm Password text box, retype the password. 

4 Click OK. The next time you start Xconfig, the new password is 
implemented. 

To change an existing password: 

1 Type your current password in the Old Password text box.

2 Type your new password in the New Password text box and then retype 
it in the Confirm Password text box. 

Xstart Password Save The Xstart file cannot be saved or run. A warning 
informs users that saving of passwords is disabled.

Xstart Remember 
Password

In the Xstart Global Options dialog box, the Password 
List area (including Remember Password functionality) 
is unavailable.

Xstart RLOGIN Startup 
Method

The Xstart file cannot be saved or run. A warning 
informs users that this method is disabled.

Xstart RSH Startup 
Method

The Xstart file cannot be saved or run. A warning 
informs users that this method is disabled.

Options Result
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3 Click OK to save your changes. The next time you start Xconfig, the 
new password is implemented. 

To remove password protection: 

1 Type your current password in the Old Password text box, and leave the 
other two text boxes blank. 

2 Click OK to save your changes. The next time you start Xconfig, this 
password is removed. Note that if you do not use a password, anyone 
can make changes to the settings formerly protected by this password.

2

Accessibility 

Configuring Accessibility Settings

This section describes how to configure Exceed Accessibility settings. 

These settings enable access to information about the user interface. 
elements. 

To configure Accessibility settings for Exceed:

1 In the left pane of  Xconfig, click Accessibility. Alternatively, from the 
Xconfig Settings menu, select the Accessibility option. The Accessibility 
tab is displayed. 

2 Select the Enable Accessibility check box. 

• Enable Accessibility—Gives visually impaired users the capability 
to read the X display by means of support for Microsoft Active 
Accessibility (MSAA). Users with visual impairments can use 
MSAA compliant screen reading applications, such as Microsoft 
Narrator, to read and listen to the screen of Motif X Window 
applications. This feature is not available with 64-bit versions of the 
product.)
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3 Depending on how your system is configured, you may be prompted to 
turn off (clear) the following option (located under Input Devices > 
Keyboard: Use Keyboard Hook). 

Click Yes, to turn off this option, which prevents key input echo from 
working properly with the Accessibility feature. By clicking Yes, you will 
disable the keyboard echo (the appearance of letters on the screen as 
someone types).

4 Select or clear the option of your choice (available if the Enable 
Accessibility is selected):

• Readiness Check Interval (ms)—The default is 5000 milliseconds. 
Setting it to 0 means that Exceed does not wait until all the 
information is ready for collecting by a screen reader when an X 
client window is created.

• Maximum Number Of Times To Check—The default is 5. This 
determines the number of times Exceed attempts to detect 
accessibility information. If accessibility information is ready for a 
screen reader, the X client window opens. If all attempts fail, the X 
client window still opens but without accessibility information. 
This happens when an X client is launched on a system where 
accessibility modules are not installed. 
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About Exceed 3D

To order Exceed 3D, 
contact your sales 
representative. For contact 
information, see 
Appendix C: General 
Accessibility and 
Customer Support.

Exceed 3D lets you view three-dimensional (3D) applications under Exceed 
and create 3D applications using Exceed XDK. This section contains 
important information about Exceed 3D and instructions for installing 
Exceed 3D. Unless otherwise specified, all references to Windows 7/Server 
2008 and later are referred to generically as Windows.

Overview and Features
Exceed 3D lets you use the Exceed X server to display OpenGL-based 3D 
applications. Exceed 3D provides support for OpenGL 1.2 and GLX 1.4.

OpenGL is an industry-standard 3D graphics software interface. It lets you 
create interactive programs that produce still or animated 3D color objects 
with shading, lighting, and other effects. GLX is the X Window System 
extension that implements OpenGL.

Exceed 3D supports:

• OpenGL version 1.2, GLX 1.3 (if supported by your graphics adapter), 
and GLX 1.4

• RGBA and color index modes on all video devices, including True Color 
16-bit and 32-bit color video cards

• overloaded visuals to support OpenGL extended attributes such as 
double and single buffering

• direct rendering

• hardware acceleration (if supported by your graphics adapter)

• overlays (if supported by your graphics adapter)

• stereo (if supported by your graphics adapter)

• texture3D (if supported by your graphics adapter)

For demonstration purposes, sample programs are shipped with Exceed 
XDK.
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Exceed 3D Requirements

Before you install Exceed 3D, make sure the computer on which you are 
installing it meets the following minimum system requirements:

• Microsoft Windows 7/8/8.1/Server 2008, Server 2008 R2/Server 2012 
R2

• Microsoft Visual C/C++ Version 4.2 or higher to develop OpenGL X 
clients

Graphics Cards
A graphics card 
specifically designed to 
support OpenGL should 
support overlay.

Most current high performance graphics cards support OpenGL, but some 
are not specifically designed for OpenGL, which could cause problems with 
some UNIX software if it requires specific OpenGL-related features. For 
more information, contact your UNIX software vendor to see which 
hardware they support, or contact your graphics card manufacturer.

GLX Protocol

Exceed 3D includes GLX, the OpenGL extension for the X Window System.

OpenGL Extensions
For detailed information about extensions, see the OpenGL Extension 
Registry:

http://oss.sgi.com/projects/ogl-sample/registry/index.html

The registry is maintained by Silicon Graphics, Inc. and provides standards, 
specifications, naming conventions, guidelines, and other related 
documentation.
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Extensions supported by Exceed 3D
Exceed 3D supports the following OpenGL extensions:

Note: Your graphics adapter must also support these extensions.

GL_ARB_depth_texture GL_ARB_multitexture

GL_ARB_point_parameters GL_ARB_shadow

GL_ARB_shadow_ambient GL_ARB_texture_border_clamp

GL_ARB_texture_compression GL_ARB_texture_cube_map

GL_ARB_texture_env_add GL_ARB_texture_env_combine

GL_ARB_texture_env_crossbar GL_ARB_texture_env_dot3

GL_ARB_texture_mirrored_repeat GL_ARB_texture_non_power_of_two

GL_ARB_vertex_blend GL_ARB_window_pos

GL_EXT_abgr GL_EXT_blend_color

GL_EXT_blend_logic_op GL_EXT_blend_minmax

GL_EXT_blend_subtract GL_EXT_cmyka

GL_EXT_convolution GL_EXT_copy_texture

GL_EXT_framebuffer_object GL_EXT_histogram

GL_EXT_misc_attribute GL_EXT_packed_pixels

GL_EXT_pixel_transform GL_EXT_point_parameters

GL_EXT_polygon_offset GL_EXT_rescale_normal

GL_EXT_subtexture GL_EXT_texture

GL_EXT_texture_env_add GL_EXT_texture_env_combine

GL_EXT_texture_filter_anisotropic GL_EXT_texture_object

GL_EXT_texture3D GL_EXT_vertex_array

GL_HP_convolution_border_modes GL_PGI_misc_hints

GL_PGI_vertex_hints GL_SGI_color_matrix
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OpenGL Direct Rendering
Exceed 3D supports OpenGL direct rendering for improved local GLX 
client performance when the client is running on the same PC as the X 
server display. Direct rendering does not support a color index with any 
depth.

GL_SGI_color_table GL_SGI_texture_color_table

GL_SGIS_detail_texture GL_SGIS_generate_mipmap

GL_SGIS_sharpen_texture GL_SGIS_texture_border_clamp

GL_SGIS_texture_edge_clamp GL_SGIS_texture_filter4

GL_SGIS_texture_lod GL_SGIS_texture_select

GL_SGIS_texture4D GL_SGIX_clipmap

GL_SGIX_depth_texture GL_SGIX_fog_offset

GL_SGIX_interlace GL_SGIX_shadow

GL_SGIX_shadow_ambient GL_SGIX_texture_add_env

GL_SGIX_texture_lod_bias GL_SGIX_texture_multi_buffer

GL_SGIX_texture_scale_bias GL_SUN_global_alpha

GL_SUN_vertex GLX_EXT_import_context

GLX_EXT_texture_from_pixmap GLX_EXT_visual_info

GLX_EXT_visual_rating

Note: If you have problems with resizing an OpenGL window, 
turn off direct rendering. These problems are caused by the 
Microsoft implementation of OpenGL.
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Troubleshooting Problems with Graphics Cards

If you suspect that Exceed 3D has not selected the correct graphics card for 
your application, the following instructions may help you investigate the 
problem:

1 Select the Log GLX Information check box in the Troubleshooting dialog 
box of the Xconfig application.

2 Run the Exceed X server. On the Tools menu, click Log File to view the 
Exceed log file. This file lists the available OpenGL pixel formats that are 
implemented by your graphics card and by Microsoft software.

3 Run the Xglinfo demo program and view the output in the Local X 
Console window. The output lists the visuals supported by the Exceed X 
server. (By default, the Local X Console window closes after all Local X 
clients exit. To change this option, in the Local X Console, click Close on 
Last Client Exit.)

4 Run your application and view the Exceed log file again. The OpenGL 
pixel format selected by the Exceed X server for your application is 
written to the log file.

By examining this output, you can determine if the Exceed X server 
selected the right graphics card for your application. If not, contact 
Customer Support. You may be asked to send the following log files: 
exceed.log and xlib.log, located in your Exceed user directory.
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Introducing Exceed XDK

Exceed XDK is a set of .dlls, include files, and libraries that you can use to 
develop GUI or console local X clients that run on your PC instead of a 
UNIX or Linux host. You can develop a local client using Exceed XDK, or 
you can port the code of an existing UNIX or Linux X application and 
rebuild the project so that the application runs locally on a PC. You can also 
develop OpenGL X applications with 3D capabilities for Windows.

Exceed XDK includes the Motif User Interface Language compiler (UIL), a 
Motif Window Manager (MWM) that supports double-byte and multi-byte 
character sets, and various additional Motif include files and libraries for 
developing local Motif clients. Local Motif clients are clients that use the 
current implementation of the OSF/Motif Widget set and are built to run 
on your PC instead of a UNIX host.

In order to develop local X clients, you must have programming knowledge 
of these operating systems and the X Window System. Use Microsoft Visual 
C++ or CYGWIN gcc compilers and linkers to build your local X client. 

This section describes the following:

• what Exceed XDK provides

• how to use Exceed XDK to develop a local X client (including how to 
port a UNIX or Linux X client to a PC and recompile it)

• how to use the built-in Japanese and other locale-support components 

Sample Source Code
Exceed XDK contains the source files for compiling and linking the Circles, 
Ico, Xlogo, HelloMotif, Periodic, and Pplane programs in the XDK source 
directory.

Note: No development components in this version of Exceed 
XDK—including header files, import/static libraries, and sample 
source code—are intended for use with any development 
components of Exceed XDK earlier than version 6.
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Extensions Support
Exceed XDK (hclglx.lib) supports the following OpenGL extensions:

GL_ARB_imaging GL_ARB_multitexture

GLX_ARB_get_proc_address GL_ARB_texture_env_add

GL_ARB_texture_env_combine GL_EXT_abgr

GL_EXT_blend_color GL_EXT_polygon_offset

GL_EXT_texture GL_EXT_texture3D

GL_EXT_subtexture GL_EXT_copy_texture

GL_EXT_histogram GL_EXT_convolution

GL_SGI_color_table GL_EXT_texture_object

GL_EXT_vertex_array GL_EXT_blend_minmax

GL_EXT_blend_subtract GL_EXT_blend_logic_op

GL_EXT_texture_env_combine GL_EXT_texture_env_add

Your graphics adapter 
must also support these 
extensions.

Among these extensions, you can only use GLX_ARB_get_proc_address with 
Exceed direct rendering mode. This extension lets Exceed virtually support 
any extension that it does not support directly. Exceed can get extension 
functions directly from the hardware driver.

Extensions Not Supported
Some extensions are not supported, for example GL_NV_vertex_program . 
However, it is possible to use an unsupported extension by calling the 
glXGetProcAddressARB function. 

For example:

typedef void (APIENTRY * PFNGLBINDPROGRAMNVPROC )
(GLenum target, GLuint id );

PFNGLBINDPROGRAMNVPROC pfnBindProgramNV = NULL ;

char *exten = ( char * ) glGetString( GL_EXTENSIONS );
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if( strstr( exten, "GL_NV_vertex_program" ) )
pfnBindProgramNV = ( PFNGLBINDPROGRAMNVPROC )
glXGetProcAddressARB( "glBindProgramNV" );

X11 Motif and OpenGL Version Support

This version of Exceed XDK supports X11R7.0, Motif 1.2.4, Motif 2.0.3, and 
Motif 2.1.30 with Complex Text Layout (CTL).

Support to run X11R5 local clients built using (GLX 4, OpenGL 1.2, and) 
versions of Exceed XDK prior to Version 6 is also included if you install the 
X11R5 Local X Clients Runtime component. However, you cannot create 
X11R5 clients with this version of Exceed XDK.

International Support
This version of Exceed XDK includes extensions that support user input of 
the Euro and Latin-9 currency symbols.

Exceed XDK provides support for developing and running X applications 
using all major European languages, as well as Japanese, Chinese, and 
Korean. This version of Exceed XDK also supports X11 Internationalization 
(I18N).

In addition, if you are using Motif 2.1.30 CTL, you can use Exceed XDK to 
develop context-sensitive local Arabic or Hebrew applications.

Motif Tools Libraries (Xmt 2.1.2)
Exceed XDK includes support for X Motif tools. You can build Xmt 
applications with Motif 2.0.x and Motif 1.2.x. Exceed XDK provides two 
pairs of static libraries (HumXmt.lib and XmtStatXm.lib) can be used with 
dynamic and static Xm libraries. You can find Xmt header files in folders in 
this location:

Note: This example is for direct rendering only. The results of 
using extension GL_NV_vertex_program in another mode 
(rendering through Exceed) are unpredictable.
213



OpenText™ Exceed™ User's Guide
C:\Program Files\Hummingbird\Connectivity\Version\Exceed\
XDK\Include\Xmt

These libraries are not yet 
available for Cygwin.

For complete documentation of the Xmt library, consult Motif Tools: 
Streamlined GUI Design and Programming with the Xmt by David Flanagan 
(published by O’Reilly & Associates, Inc.).

Motif and OpenGL GCC Static Libraries
Motif Widget Set (libXmSt.a) and Motif Resource Manager (libMrmSt.a) 
static libraries for Motif 1.2.4, Motif 2.0.3, and Motif 2.1.30 CTL are now 
available for a gcc compiler under the CYGWIN environments on Win32 
systems.

These libraries can be found in the following locations:

• Home\Xdk\Motif12\Gcc\Lib (for Motif 1.2.4 applications)

• Home\Xdk\Gcc\Lib (for Motif 2.0.3 and OpenGL applications)

• Home\Xdk\Motif21\Gcc\Lib (for Motif 2.1.30 CTL applications)

Home directory refers to the default location, C:\Program Files\
Hummingbird\Connectivity\version\product, but another location may be 
specified in the OpenText Setup Wizard during installation.

GNOME/Linux Files
This version of Exceed XDK provides library and header files for 
GNOME/Linux development with a CYGWIN gcc compiler. These files can 
be found in the following location: Home\Xdk\Gcc\

Note: A license (required to use Xmt libraries) is included with 
“Motif Tools: Streamlined GUI Design and Programming with the 
Xmt”.
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Exceed XDK Files

For more information, see 
“Building a GNOME/Linux 
X Client Using a CYGWIN 
GCC Compiler” on 
page 43.

The table below lists Exceed XDK files that are installed and the directories 
in which they are installed. Home directory refers to the default location 
C:\Program Files\Hummingbird\Connectivity\version\product but 
another location may be specified in the OpenText Setup Wizard during 
installation. There are various types of User directories. For more 
information about installation directories and installed (user) files, see the 
Installation Guide. 

Directory Name Directory Contents

Home Xlib.dll, Xt.dll, Xaw.dll, Xmu.dll, Xm.dll, HCLXt.dll, 
HCLXaw.dll, HCLXmu.dll, HCLXm.dll, HCLXm12.dll, 
HCLXm21.dll, HCLIce.dll, HCLXiert.dll, HCLSm.dll, 
HCLXi.dll, HCLXtst.dll, HCLXp.dll, HCLShm.dll, 
layout.dll, humxim.dll, humxom_ar.dll, HCLMrm.dll, 
HCLMrm12.dll, HCLMrm21.dll, HCLXaw3d.dll, HumXpm.dll, 
HumXRender.dll, HumXRandr.dll, HumXComposite.dll, 
HumXDamage.dll, HumXEvie.dll, HumXFixes.dll, 
HumXKBFile.dll, and sample local X clients.

Also includes the Motif User Interface Compiler (UIL) and the 
sample Motif clients. Uil.exe is for use with Motif 2.0.x X clients, 
Uil12.exe is for use with Motif 1.2.x X clients, and Uil21.exe is 
for use with Motif 2.1.x X clients.

Home\Xdk\Include\GL Include files for OpenGL libraries.

Home\Xdk\Include\X11\Glw Include files for OpenGL libraries.

Home\Xdk\Include\Xmt Include files for the Motif Tools library.

Home\Xdk\Include\Xm Include files for the Motif 2.0.x Widget library.

Home\Xdk\Include\Mrm Include files for the Motif 2.0.x Resource Manager library. 

Home\Xdk\Include\UIL Include files for the Motif 2.0.x User Interface Language library.

Home\Xdk\Motif12\Include\Xm Include files for the Motif 1.2.x Widget library.

Home\Xdk\Motif12\Include\Mrm Include files for the Motif 1.2.x Resource Manager library.

Home\Xdk\Motif12\Include\Uil Include files for the Motif 1.2.x User Interface Language library.

Home\Xdk\Motif21\Include\Xm Include files for the Motif 2.1.x Widget library.
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Home\Xdk\Motif21\Include\Mrm Include files for the Motif 2.1.x Resource Manager library.

Home\Xdk\Motif21\Include\Uil Include files for the Motif 2.1.x User Interface Language library.

Home\Xdk\Src Subdirectories containing source code for the sample local X 
and Motif 2.0.x clients.

Home\Xdk\Lib (32 bit)

Home\Xdk\Libx64 (64 bit)

Import libraries: Xlib.lib, HCLXmu.lib, HCLSm.lib, 
HCLIce.lib, HCLXiert.lib, HCLXi.lib, HCLXtst.lib, 
HCLShm.lib, HCLXp.lib, HumXpm.lib, HumXRender.dll, 
HumXRandr.dll, HumXComposite.dll, HumXDamage.dll, 
HumXEvie.dll, HumXFixes.dll, and HumXKBFile.dll.

Combination import libraries and static data: HCLXt.lib, 
HCLxaw3d.lib, HCLXaw.lib, and XmStatXt.lib.

Also includes the Motif Widget library HCLXm.lib (import library 
and static data), XmStatic.lib (static library), the Resource 
Manager libraries (HCLMrm.lib is the import library and 
MrmStat.lib is the static library), Motif Tools static libraries 
HumXmt.lib and XmtStatXm.lib, and the User Interface 
Language static library (HCLUil.lib) for Motif 2.0.x.

Home\Xdk\Motif12\Lib (32 bit)

Home\Xdk\Motif12\Libx64 (64 bit)

The Motif Widget library HCLXm.lib (import library and static 
data), XmStatic.lib (static library), the Resource Manager 
libraries (HCLMrm.lib is the import library and MrmStat.lib is 
the static library), Motif Tools static libraries HumXmt.lib and 
XmtStatXm.lib, and the User Interface Language static library 
(HCLUil.lib) for Motif 1.2.x.

Home\Xdk\Motif21\Lib (32 bit)

Home\Xdk\Motif21\Libx64 (64 bit)

The Motif Widget library HCLXm.lib (import library and static 
data), XmStatic.lib (static library), the Resource Manager 
libraries (HCLMrm.lib is the import library and MrmStat.lib is 
the static library), and the User Interface Language static library 
(HCLUil.lib) for Motif 2.1.x.

Home\Xdk\Motif12\Gcc\Lib GCC import and static libraries for Motif 1.2.x.

Home\Xdk\Motif21\GCC\Lib GCC import and static libraries for Motif 2.1.x.

Home\Xdk\GCC\Lib GCC import and static libraries for X, Motif 2.0.x, and OpenGL.

Home\Xdk\GCC\Include Common include files for GNOME/Linux development.

Home\Xdk\GCC\Include\Gtk GTK files for GNOME/Linux development.

Home\Xdk\GCC\Include\Gdk GDK files for GNOME/Linux development.

Directory Name Directory Contents
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For more information regarding the files included in Exceed XDK, see the 
file XDKFiles.txt located in your Home\Info directory. 

Exceed XDK Runtime Control Variables
Runtime control over Exceed XDK libraries is provided with the settings 
described in the table at the end of this section. These settings are defined in 
the environment or the registry database. Exceed XDK initially searches for 
runtime control variables in the environment (set with the DOS command 
SET). If it cannot find the variables there, it searches the registry database for 
the variable values under the following keys:

Home\Xdk\Include\X11 Include files for compiling local X clients.

Home\Xdk\Include\X11\Extensions Include files for X Extensions. 

Home\Xdk\Include\X11\Bitmaps X11 bitmap files.

Home\Xdk\Include\X11\Xaw Include files for the Athena Widget Set.

Home\Xdk\Include\X11\Xmu Include files for X miscellaneous utility library.

Home\Xdk\Include\X11\Xaw3d Include files for the Athena 3D Widget Set.

Home\Xdk\Include\X11\Ice Include files for inter-client exchange library.

Home\Xdk\Include\X11\Sm Include files for session management library.

User User-configurable resource files, such as the .Xdefaults file and 
application resource files (including application resource files for 
the sample X clients). Also includes the X Error Database file 
and the X Keysym Database file.

Any binary User Interface files (.uid) and application resource 
files for the sample local Motif clients are also located here.

User\Locale Contains locale files database, locale aliases database, and 
various subdirectories containing locale database files for each 
different locale.

User\SJ3

User\SJ3DEF

Supporting directories for Kinput2 (Japanese XIM server).

Directory Name Directory Contents
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• If you installed the software for use by a single user: 
HKEY_CURRENT_USER\Software\Hummingbird\Connectivity\
version\Exceed\XDK

• If you installed the software for use by multiple users: 
HKEY_LOCAL_MACHINE\Software\Hummingbird\Connectivity\
version\Exceed\Xdk

where version is the version number of the software.

If Exceed XDK cannot find the variable values in these locations, it searches 
under the Exceed key in the same order.

Some of these entries replace the corresponding environment variables 
described in the MIT X Window documentation. If a variable is not 
defined, then the default value is used. 

The following table lists and describes Exceed XDK runtime variables. 

Note: When specifying values for these variables, the path 
specifications must follow the DOS or NTFS conventions. 

Variable Name Description and Default

BITMAPDIR The location of the directory containing bitmaps read by clients at runtime.

Default: Home\Xdk\Include\X11\Bitmaps

DISPLAY The name of the default display on which local X clients are displayed. The 
display name should also include the display number.

Default: LOCALPC:0.0 

Note: LOCALPC is a special keyword indicating that local X clients should be 
displayed on the local PC.

HOME The equivalent of your Home directory on UNIX. It is added to the search path 
for several types of files.

Default: Exceed Home directory.

HOMEDIR HOMEDIR=drive:path

Default: Exceed Home directory.
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LANG If you are running Local X clients, LANG defines the locale that you want to 
use. For example, to use Japanese, you would set LANG to ja_JP.SJIS or 
to japanese.

You can put your language-specific resource files under User\LANG.

Also, if you are developing local X clients, you need to call 
setlocale(LC_ALL, "") to indicate to the C runtime library that your 
application will use the locale associated with the LANG environment variable 
instead of the C locale.

Default: the default system locale.

LOGFILE

(XDK-specific variable)

The name of the file to which Local X Console messages are logged. Logging 
only occurs if the LOGGING variable (described below) is set to YES. For 
more information, see the Exceed User’s Guide.

Default: User\XLib.log

LOGGING Specifies whether messages are logged to a file.

If this variable is set to YES, then messages sent to the Local X Console are 
logged to a file. Otherwise, messages are not logged. For more information, 
see the Exceed User’s Guide.

The name of the log file is specified by the LOGFILE variable (described 
above).

Default: YES

MULTITHREADALERT

(XDK-specific variable)

Specifies an action the X client can take if it is multithreaded and is 
experiencing problems (such as freezing until the mouse is moved). You can 
specify one of three values: 0, 1, or 2.

The first option (0) sets the X client to do nothing. 

The second option (1) sets the X client to be ready for XtAppAddInput or 
XtAppAddTimeOut (either of which is set by another thread). 

The third option (2) sets the X client to be ready for XtAppAddInput or 
XtAppAddTimeOut (set by another thread) and gives the client protection 
from freezing when there is no X event data to read.

All three options can reside under the Exceed or Xdk keys. All have a string 
value.

Default: 0 (do nothing)

Variable Name Description and Default
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NAMEDPIPEONBREAK 
(XDK-specific variable)

Specifies a behavior if Named Pipe is closed or broken. This variable can 
have one of two values: 0 or 1.

The first option (0) calls a designated callback function only when some data 
is found. This functionality is consistent with how Named Pipe Xt Input 
function was handled in versions of Exceed XDK prior to version 8.0.

The second option (1) calls a specified callback function when data was 
found or if Named Pipe is closed or broken.

Default: 0

RESOURCE_NAME The default file name of an X resource.

Default: the client’s name.

RUNXSERVERIPADDR

(XDK-specific variable)

Specifies a local host name to start the X server automatically. For example, 
you can specify this variable as either 127.0.0.1 or DisplayName, where 
the first is a specific IP address and the second is your local display name.

If you do not specify this variable, the display is treated as a remote one.

Default: not specified.

UIDPATH UIDPATH=%U;drive:path\%U;

drive:path\%U

Default:%U;XAPPLRESDIR\%U;

HOME\%U

WMDPATH WMDPATH=%S;drive:path\%S;

drive:path\%S

Default:

%S;XAPPLRESDIR\%S;

HOME\%S

XAPPLRESDIR The directory containing the Xt resource files.

The format is: XAPPLRESDIR=drive:path

Default: Exceed User directory.

XBMLANGPATH XBMLANGPATH=%B;

drive:path\%B;drive:path\%B

Default:

%B;XAPPLRESDIR\%B;

HOME\%B

Variable Name Description and Default
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Sample Local X, Motif, and OpenGL Clients

Exceed XDK includes several sample local X, Motif, and OpenGL clients. 
Some of the samples include source code. To run one of these clients, 
double-click its icon in the Local X Clients folder.

Below is a brief description of the sample local X and Motif clients included 
with Exceed XDK. The icon associated with each client is shown beside the 
description.

Bitmap     A local X client used for creating and editing X bitmap files.

Circles     A local X client that shows the alpha-channel capability of the 
Render extension. Source code location: Home\Xdk\Src\Circles

XENVIRONMENT The full path and file name of an Xdefaults file (if you create one).

Default: User\.Xdefaults

XFILESEARCHPATH & 
XUSERFILESEARCHPATH

The full path for Xt resource files. The syntax for these paths is described in 
the MIT documentation for the X Window System. If a path contains more 
than one directory, use a semicolon (;) to separate them.

Default: Depends on the values for your Exceed Home directory and 
XAPPLRESDIR described above.

XKEYSYMDB The full path and file name of an X keysym database.

Default: User\Xkeysymdb

XLOCALEDIR The directory containing locale database and alias files.

Default: User\LOCALE

XMODIFIERS Specifies how the locale modifiers are configured.

Default: not specified.

XSERVERCONNECTION
RETRIES

(XDK-specific variable)

Specifies the number of attempts made by the local X client to establish a 
server connection.

Default: 3 attempts.

Variable Name Description and Default
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Editres     A local X client that lets users and application developers view the 
full widget hierarchy of any X Toolkit application that speaks the Editres 
protocol. Editres can also help you construct resource specifications, apply 
the resource to the application, and view the results dynamically. Once you 
are satisfied with the resource specification, Editres appends the resource 
string the your X Resources file. 

Ico     A local X client that displays a bouncing icosahedron. Ico is useful for 
testing the speed of your system and display. Source code location: 
Home\Xdk\Src\Ico

Maze     A local X client that draws a random maze and finds the solution. 
Maze is useful for testing the speed of your system and display.

MotifAnim      A Motif client in which both its animation and user interface 
is defined with the User Interface Language (UIL) compiler. It also 
demonstrates the use of the UIL compiler.

Periodic     A Motif client that demonstrates the use of most existing Motif 
widgets. It also demonstrates the UIL compiler. Source code location: 
Home\Xdk\Src\Periodic 

Seltest     A sample implementation of an X client that demonstrates 
copying and pasting graphics between Windows Clipboard and the X 
Selection.

Showcmap      A local X client that displays a map of the system colors.

Xdpyinfo     A local X client that prints X server information to the Local X 
Console. 

Xev     The X Event Tester that when running, writes information to the 
Local X Console about X events such as key presses, mouse movements, and 
button clicks.

Xlogo     A local X client that displays the X Window System logo. Source 
code location: Home\Xdk\Src\Xlogo

Note: To use Editres with Motif applications, you need to make 
some changes to the source code. For more information, see 
“Developing Local Motif Clients” on page 26.
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Xmt Mockup     A local X cient that demonstrates features of the Xmt 
library.

Sample Programs
For demonstration purposes, the following sample programs are shipped 
with Exceed 3D.

Atlantis      A local X client that demonstrates the movement of objects. It 
uses the hclglut.lib library.

Insect     A local X client that shows a walking insect. It uses the hclaux.lib 
library and Color Index mode.

Vulcan Gunner     A local X client that demonstrates lighting and 
animation. It uses the hclglut.lib libary.

XGLinfo      A local X client that displays GLX visual configurations. It 
returns XGL information from the server.

ZoomDino     A local X client that uses OpenGL overlay and shows a 
zooming dinosaur (if the overlay is supported by your graphics adapter).

Exceed Tools

The following Exceed tools are shipped with Exceed XDK. 

MWM
MWM is a local implementation of the Motif window manager. To access 
MWM, navigate to the OpenText Exceeed XDK program group, and then 
click MWM. 

Kinput2
Kinput2 is an input server for X11R6 applications requiring Japanese text 
input, including Kana-Kanji conversion. To access Kinput2, navigate to the 
OpenText Exceed program group, point to Exceed Tools, and click Kinput2 
XIM Server.
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About Developing Local X Clients

For more information, see 
“Developing Local X 
Applications Using Visual 
C++” on page 234 and 
“Local X Console 
Application” on page 235.

You can use the contents of the Exceed XDK in conjunction with an 
application development tool to create a local X client. The Exceed XDK lets 
you create two types of local X client applications:

• GUI application (Win32)—Makes use of the Local X Console 
application to display output.

• Console application—Runs in a DOS shell. These applications use 
STDIN for console input and STDOUT and STDERR for console output. 

Methods for Creating X Clients
You can create a local X client of either type with one of two methods: you 
can write your own code, or you can port an existing client from the UNIX 
or Linux host to your PC and rebuild. When Microsoft Visual C++ is used, 
your client code must reflect the differences between the X Window System 
(as described in MIT documentation) and Exceed XDK, and, more 
importantly, between Microsoft Visual C++ and UNIX C/C++ standard 
functions and header files.

In most cases, when you use CYGWIN GCC compilers and the Exceed XDK 
development environment, you do not have to change your code. To 
develop local X clients, you must have programming knowledge of these 
operating systems and the X Window System.

For important information on redistributing Exceed XDK components 
with your local clients, please contact your sales representative. 

Development Overview

This section describes what you need to know about Exceed XDK in order 
to develop a local X client.
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Functions Specific to the Exceed XDK 
The following additional functions are included in the Exceed XDK. They 
are specific to the OpenText implementation of Xlib.

Function Description

HCLSelect Used in conjunction with the XConnectionNumber 
API to check the status of connections.

lprintf
lfprintf
lputchar
lputc
lputs
lfputc
lfputs
lperror

hfprintf
hputc
hfputc
hputs
hperror

Prints to both the Local X Console (system console) 
and the log file (if logging is turned on).

These functions replace the original functions and 
those similar to the original ones (printf, fprintf, 
fputchar, putc, puts, fputc, fputs, perror).

Xgetenv Xgetenv is similar to getenv function except it returns 
environment variables related to X/Motif. Replaces the 
system getenv function when XGETENV is defined as 
a compiler flag.

gettimeofday Returns the time of day. This function is accurate to a 
millisecond.

The prototypes for the above functions are provided in the XlibXtra.h and 
X.h files in the home\XDK\INCLUDE\X11 directory, where home is the directory 
in which the software is installed.

Previous versions of the Exceed XDK also included functions for initializing 
the Xlib, Xaw, Xm, and Xt libraries (HCLXlibInit, HCLXawInit, HCLXmInit, 
and HCLXtInit). In this latest version, however, initialization is hidden so 
that it is transparent for porting, meaning that you no longer need to call an 

Note: For functions that take file ID as a first parameter, the 
redirection works for only SYSERR and SYSOUT. Otherwise, they 
work the same as the original ones.
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initialization function. If for some reason your compiler has difficulty with 
Xm initialization, you may need to add MOTIFAPP as an additional 
preprocessor definition; for more information, see “Troubleshooting” on 
page 251.

Memory Management
Xlib contains its own memory management routines, including Xfree, 
Xmalloc, and Xcalloc. In order to maintain compatibility with future 
versions of the Exceed XDK, use these routines instead of Microsoft WIN32 
memory management routines.

Memory allocated by these Xlib routines should be freed using Xlib 
routines. Similarly, memory that is freed using Xlib routines should be 
allocated by Xlib routines. 

XtAppAddInput Function
The XtAppAddInput function supports the following input types:

Type Mask

HCL socket XtInputReadMask, XtInputWriteMask, 
XtInputExceptMask

Winsock socket XtInputReadWinsock, XtInputWriteWinsock

File XtInputReadFileHandle

Pipe XtInputReadFileHandle

Named pipe XtInputReadNamedPipe

Gethostname Function
Xlib.dll exports the gethostname function. A function by this name is also 
exported by the Windows Sockets .dll.

We do not recommend that you use the Xlib.dll version of this function; it 
is provided by Xlib only for backwards compatibility. In order to ensure that 
you are using the Windows Sockets version of this function, and not the 
Xlib.dll version, your link statement must include Wsock32.lib before 
Xlib.lib.
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Checking X Connection Status
You can use the HCLSelect API in conjunction with XConnectionNumber to 
check the status of X connections. The HCLSelect API takes the same 
parameters and returns the same type as the Windows Sockets select API. 
The only difference between the two APIs is that HCLSelect supports 
connection numbers as returned by Xlib, while select does not.

The following example shows how to use the HCLSelect API. This example 
specifies a connection number (i) and then requests various types of 
information (&rfds, &wfds, &efds, &nowait) about that connection.

i = XConnectionNumber(dpy);
FD_SET(i, &rfds);
n = HCLSelect(0, &rfds, &wfds, &efds, &nowait);

Starting a Microsoft Application Inside an X Application
To start a Microsoft application (such as Internet Explorer), inside an X 
application, and give it focus, use the HumAllowSetFocusWindow function:

void HumAllowSetFocusWindow(Display *dpy, DWORD pid)

where Display *dpy points to the display structure of the X application, and 
DWORD pid is the process identification of the Microsoft application.

Setting the Locale for an X Client
For more information about 
setting locales, see the 
LANG environment variable 
description in “Exceed 
XDK Runtime Control 
Variables” on page 7.

The runtime control variable XLOCALEDIR replaces XNLSPATH used in 
X11R5. The default value for XLOCALEDIR is user\LOCALE. The 
locale.dir file (in user\LOCALE) replaces the nls.dir file used in X11R5.

Locale aliases are supported. You can specify your locale alias in the 
locale.alias file in the user\LOCALE directory.

Setting the proper locale in your X client depends on the following 
conditions.

Same Encoding in the Operating System and the X Client
If you are developing an X Toolkit application and the encoding of your 
operating system is the same as that for your X client, you do not need to 
specify a setlocale function because it will be called automatically from 
inside the Hclxt.dll.
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Different Encoding in the Operating System and the X Client
If you are developing an X Toolkit application and the encoding of your 
operating system is different than that for your X client, you should not use 
the system setlocale function. Rather, you should call the _Xsetlocale 
function; you can call it explicitly or use the X_LOCALE macro to call it.

Use this function in two ways:

• Specify a second parameter of the _Xsetlocale function. For example:

 _Xsetlocale(LC_ALL, "jaJP.euc");

where jaJP.euc is the locale and encoding name.

• Do not specify a second parameter and instead set the LANG variable. 
For example:

 _Xsetlocale(LC_ALL, "");

You then need to set the LANG variable to jaJP.euc.

Accepting Localized Input
X11R6 XIM support is included on the server side. This support lets local X 
clients accept localized input when displaying to an X server that supports 
X11R6 XIM (such as the X Server in Exceed 6.0.2 or higher).

Header File Type Renaming
The type BOOL in the X header files has been renamed to XBOOL to resolve 
possible conflicts with the Windows header file definition. This renaming is 
the same as in previous versions of the Exceed XDK.

Using Multiple Screens for Local X Clients
The Exceed XDK lets you use different screens with your local X clients. If 
the display name is specified as :0.X (where X is the screen number), Xlib 
assumes that the local client is to be displayed locally to LOCALPC:0.X.
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Storing X Image Data in a Memory Segment
The shared-memory extension allows local X clients to store Ximage data in 
a memory segment that is shared with the local X server. When you work 
with large images, this facility can greatly enhance performance because you 
do not have to send the Ximage over the Xlib interprocess communication 
channel.

When using the shared-memory extension, make sure that the MIT-SHM 
option is enabled.

To use shared-memory Ximages:

1 Create the shared memory Ximage structure.

2 Create a shared memory segment to store the image data.

3 Inform the X server about the shared memory segment.

4 Use the shared Ximage much like a normal image.

For more information, refer to the MIT documentation.

To enable the MIT-SHM option: 

1 Run the Xconfig utility.

2 Double-click the Protocols icon.

3 In the Protocols dialog box, click Extensions.

4 Enable the MIT-SHM option.

Exceed XDK Shared Memory Extension Files
Use the following files with the Exceed XDK shared memory extension. In 
this table, the home directory refers to the directory in which the software is 
installed.

For example:

C:\Program Files\Hummingbird\Connectivity\version\Exceed\
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where version is the version number of the software. 

File Name Description

Hclshm.dll This .dll contains an implementation of the following four UNIX 
shm functions: shmget, shmat, shmdt, and shmctl. It is located 
in your home directory.

HCLSHM.h This include file contains UNIX shm function prototypes that are 
not part of X11R6.8. It is located in your 
home\XDK\INCLUDE\X11 directory.

Note: This header file includes the shm.h file. If you are using 
any shm definitions in addition to functions, then only this file 
needs to be included.

SHM.h This header file contains the UNIX shm definitions. It is located in 
your home\XDK\INCLUDE\X11 directory.

HCLSHM.lib This file is the Import library for the Hclshm.dll. It is located in 
your home\XDK\LIB directory.

  

Restrictions on the Exceed XDK Shared-Memory Extension
The restrictions on the Exceed XDK Shared-Memory Extension are as 
follows:

• Shared-memory pixmaps are not supported.

• You can share memory between X clients and an Exceed X server only 
when they are running on the same computer.

Note: The SHM functions do not represent a complete UNIX 
implementation. You can use these functions to share memory 
only between local X clients developed for use with the Exceed X 
server. You cannot use these functions for any other purpose.
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Developing Local X Applications Using Visual C++

Developing GUI (Windows) Applications
If you are creating a GUI application, your local client application requires a 
WinMain procedure. A WinMain procedure is provided in the static part of the 
library Xlib.lib, located in the home\XDK\LIB directory. The WinMain 
procedure in the Xlib library calls your main procedure.

If you are porting a client receiving input via STDIN, use an alternate method 
of receiving input, such as a Windows dialog box.

For information about 
logging, see “Functions 
Specific to the Exceed 
XDK” on page 228.

lprintf and other Exceed XDK print functions provided in Xlib.dll are 
similar to the standard C print function, except they redirect output to the 
Local X Console and Xlib log file (when the LOGGING flag is set to “YES”). 
However, output strings are limited to 2 KB per function call.

Compiling and Linking
When creating a GUI application, you also need the standard files required 
for compiling and linking a Microsoft Windows 32- or 64-bit application 
(for example, an .rc resource file). 

Developing Console Applications
To develop local X clients as console applications, you need to compile and 
link your application as a console application type.
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Local X Console Application
The complete menu structure of the Local X Console application is shown 
in the table below:

Menu Function Name Function Definition

File Save/Save As Saves the contents of the local console to 
a file.

Print Prints the contents of the local console.

Edit Copy Copies the selected contents of the local 
console to the Windows clipboard.

Clear All Clears the entire contents of the local 
console.

Select All Selects the entire contents of the local 
console.

Undo Undoes the previous "Clear All" operation.

Find Finds a string in the local console.

Find Next Finds the next string in the local console.

View Toolbar Enables you to display or hide the toolbar.

Client Control Client Manager Displays the Client Manager dialog box.

Option Close on last exit Closes the local console dialog box when 
the last local X client is closed.

Help Help Loads the Help.

 

Developing Local Motif Clients

This section builds on the general information provided in “Development 
Overview” on page 227. After you have familiarized yourself with that 
information, read this section for Motif-specific instructions.
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The Exceed XDK provides the source code and makefile for two sample 
local Motif clients, as shown in the following table.

Client Name Code Location

HelloMotif home\XDK\SRC\HELLOMOT directory

Periodic home\XDK\SRC\PERIODIC directory

You can study the source code as examples of Motif clients modified to run 
locally. For important information on redistributing Motif Development 
Kit components with your local clients, refer to the license agreement.

Using Editres
You can also use Editres, a tool that lets you view the full widget hierarchy of 
any X Toolkit application that speaks the Editres protocol.

To use Editres with a Motif application, you need to make the following 
changes to your source code.

1 Add the following code right after the application’s shell widget (in this 
case, toplevel) is created:

XtAddEventHandler(toplevel, (EventMask)0, TRUE, 
_XEditResCheckMessages, NULL);

2 When you compile, make sure you link against HCLXmu.lib (because it 
has the _XEditResCheckMessages function inside).

Creating Support for Wheel Mouse
The Exceed XDK supports wheel mouse functionality for text-related Motif 
widgets.

To create support for a while mouse, users of the local Motif X client must 
configure the appropriate X Server setting. For example, if they are using 
Exceed as the X server, they must:

1 Open XConfig by doing one of the following:

• On the Exceed Tools menu, click Configuration.

• On the Exceed toolbar, or double-click the Xconfig icon.
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2 In the Mouse Input dialog box, select the Wheel Movement Sends Mouse 
Button Event (Button 4/5) option.

Button event 4 should be used for “Up” and button event 5 should be 
used for “Down”.

Linking with Visual C++ and GCC Static Motif Libraries
If you are linking with the static version of the Motif libraries 
(XmStatic.lib), define the symbol XMSTATIC in your compiler preprocessor 
definitions. Doing so ensures that you use the correct prototype definitions 
when you compile. Use MrmStat.lib (static Mrm library) with 
XmStatic.lib.

Using XT with XmStatic.lib
Also, if you are linking with XmStatic.lib, link with the library 
Xmstatxt.lib instead of Hclxt.lib. You must use Hclxt.lib if you are 
using the .dll version of Motif and linking with Hclxm.lib.

Linking with GCC Static Motif Libraries
To link against GCC static Motif libraries, use libXmSt.a and libMrmSt.a 
instead of libXm.a and libMrm.a.

Compiling the UIL Files of Local Motif Clients
You can compile a local .uil file of a Motif client using the Motif UIL 
Compiler, which is itself a local Motif client. It can be found in the Exceed 
home directory. There are three versions of the UIL compiler: UIL.exe is for 
use with Motif 2.0.x X clients, UIL12.exe is for use with Motif 1.2.x X 
clients, and UIL21.exe is for use with Motif 2.1.30 CTL.

To use the Motif UIL compiler, type the following command: 

home\uil.exe file name -o binfile

where home is the directory in which the software is installed, file name is 
an ASCII text file written in the Motif UIL and -o binfile specifies the 
output file for the generated binary code.

For example:
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"c:\Program Files\Hummingbird\Connectivity\version\
Exceed\uil.exe" <CR>

"c:\Program Files\Hummingbird\Connectivity\version\
Exceed\XDK\Src\Hellomotif\hellomotif.uil" -o <CR>

"c:\Program Files\Hummingbird\Connectivity\version\
Exceed\XDK\Src\Hellomotif\hellomotif.uid" <CR>

where version is the version number of the software and <CR> indicates that 
the given text must be entered as one line with a carriage return at the end.

Creating .dlls Containing Standard or Custom Widget 
Classes
When creating a .dll, you can use the standard widget classes that come 
with the Exceed XDK or you can define custom widget classes. If you choose 
to define custom widget classes, read this entire section to note compiler 
differences.

Specifying Widget Classes
You cannot directly specify a widget class structure name; you need to use a 
pointer to it instead. You have the following options:

• CustomClassRec—Cannot be specified inside the .dll

• CustomWidgetClass—Can be specified inside the .dll

Use the following function to initialize a custom widget class .dll:

void HCLXmVaFixWCs(customWidgetClass1, superclass1, 
customWidgetClass2, superclass2, ... , NULL);
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This function is used for proper superclass assignment in a .dll. It should 
be called from the inside of the .dll to initialize it. The first parameter of 
each pair specifies the new widget class. The second parameter of each pair 
specifies the superclass for the new widget class. You can add multiple pairs 
in the string depending on the number of new widget classes you want to 
create, though the final parameter of the string must be NULL.

Using Custom Widget Classes for a Microsoft Visual C++ 
Compiler
When creating .dlls involving custom widget classes, you must use the 
_declspec(dllexport) declaration for each widget class in the .dll. These 
special declarations allow proper address references to widget classes when 
importing them in another .dll.

When creating an executable or a .dll that uses a custom widget classes 
.dll, you must use _declspec(dllimport) to import the custom widget 
classes.

Using Custom Widget Classes for a GCC Compiler
You must call the HCLXmInitDll function from inside the .dll to initialize 
the widget classes.

Developing Local OpenGL X Applications  

Exceed XDK provides a full suite of GLX libraries and tools required for 
developing three-dimensional OpenGL X applications on Windows 
systems.

Note: In earlier versions of the Exceed XDK, you could use the 
HCLFixStPointers and HCLFixWidgetClass functions to create a 
custom widget class. These two functions are still supported, but 
their functionality has been combined into the new 
HCLXmVaFixWCs function.
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Using the OpenGL X Development Kit
The Open GL X Development Kit supports the following:

Libraries Description

hclglx.lib
libglx.a

The core set of GLX functions. All functions are prefixed with gl 
or glX.

hclglu.lib
libglu.a

The OpenGL Utility support library (except all NURBS functions). 
All functions are prefixed with glu.

hclnurbs.lib
libnurbs.a

All Non-Uniform Rational B-Spline (NURBS) functions from the 
OpenGL Utility library. All functions are prefixed with glu.

hclaux.lib
libaux.a

The auxiliary library, providing a simple interface that is 
independent of the Window System. All functions are prefixed 
with aux and tk.

hclglut.lib
libglut.a

The OpenGL Utility Toolkit library. All functions are prefixed with 
glut.

glwstati.lib
libglw.a

 The OpenGL Drawing Area Widget static library. It lets you draw 
3D graphics using one visual and a 2D user interface using 
another visual.

Exceed XDK includes dynamic link libraries for creating OpenGL X 
applications. Developers who resell commercial OpenGL X applications 
created with these libraries are not required to pay licensing fees.

Note: If you use two different visuals, your application may not 
display the correct colors simultaneously. Specifically, if your 3D 
graphics use the RGBA color mode (the TrueColor visual) and 
your 2D user interface uses the default visual, set the Xconfig 
Server Visual Screen Definition setting to TrueColor.

Note: If you use Motif dynamic link libraries, you need to pay 
royalties to OSF. For more information, see the Licensing 
Agreement shipped with this product.
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Developing Local Arabic or Hebrew Clients Using CTL

If you are using Motif 2.1.30 with Complex Text Layout (CTL), you can 
develop context-sensitive Arabic or Hebrew applications. 

This section builds on the general information provided in “Development 
Overview” on page 227. After you have familiarized yourself with that 
information, use this procedure for Arabic- or Hebrew-specific 
instructions.

The Exceed XDK supports Windows TrueType fonts for the Arabic 
language. As well, in addition to UNIX encoding for the Arabic language 
(ISO 8859-6), you can now use Windows encoding 1256 (described in step 
3 of the procedure below). For Hebrew applications, CTL layout methods 
are only used when you set the locale to IW.

To develop an Arabic or Hebrew application with Motif 2.1.30 CTL:

1 Develop your source code in accordance with X11 standards.

2 Build your application using the hclxm.lib (Xm library) and Motif 
header files (located in the home\XDK\MOTIF21\LIB\ directory, where 
home is the directory in which you installed the software), as well as any 
other necessary files.

3 Call the _XsetLocale function at the beginning of your application’s 
source "main" function. 

For Arabic 
applications _XsetLocale(0, "ar_CTL");

_XsetLocale(0, "ar_WINCTL");

For Hebrew 
applications _XsetLocale(0, "IW");

4 Define CTL as a preprocessor definition when you compile your 
application. If you are using Microsoft Visual C++ Studio (version 6.0 
or later), you can add preprocessor definitions by doing the following:

• For UNIX encoding, set the locale to ar_CTL:

• For Windows encoding, set the locale to 
ar_WINCTL:

• Set the locale to IW:
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a) On the Project menu, click Settings and then click the C/C++ tab. In 
the upper left of the tab, from the Settings For drop-down list, select 
All Configurations.

b) From the Category drop-down list, select Preprocessor. In the 
Preprocessor definitions field, add the string CTL.

c) Click OK to save the settings and exit the dialog box.

5 Compile and link your project.

Developing Local X Clients Using Dynamic Load of 
XLC/XIM/XOM

Xlib.dll (part of the Exceed XDK) partially supports the X11 
Internationalization (I18N) from Sun Microsystems. With this 
functionality, you can dynamically load XIM, XOM, and XLC modules. Use 
this functionality to switch to a different language on the fly. 

Activating the Functionality
If you make no changes to your code, Xlib.dll treats XLC, XIM, and XOM 
as an integrated part of the X11 binary. It does not dynamically load them.

To activate a dynamic load regime of XLC, XIM, and XOM, you need to 
specify USE_DYNAMIC_XIO as a compiler flag when you build the 
application:

-DUSE_DYNAMIC_XIO

You also need to supply the application with an information file 
(XI18N_OBJS) that lists the required XLC, XIM, and XOM .dll files. Make 
sure this information file is in the following directory:

USERDIR\LOCALE\<local_name>

Note: For this functionality to work, you must write the appropriate 
code to support this functionality, and you need to have the 
correct language-specific XLC, XIM, and XOM .dll files.
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Building an X Client Using Visual C++

This section describes how to build an X client using a Visual C++ 
development tool. It assumes the following:

• You have read the general development notes previous to this section, as 
well as the sections specific to GUI, console, Motif, or Arabic/Hebrew X 
clients (depending on the type of application you are developing).

• You have already written the source code (taking into account the 
development information described in the earlier sections of this 
chapter) or ported existing code from a UNIX machine to your PC. All 
source code must be compliant with X11 standards.

Once you have the source code and are familiar with the Exceed XDK 
development particulars, you can use this section to learn how to:

• Prepare your source code for Visual C++ use.

• Create and build a project using the Exceed XDK Application Wizard, a 
component of Microsoft Visual C++ Studio (version 6.0 or later); this 
method is the most automated. 

• Create and build a project manually using any version of Microsoft 
Visual C++ Studio. 

• Build an X client using a makefile. 

For information about building an X client using a CYGWIN GCC 
compiler, see “Building an X Client Using a CYGWIN GCC Compiler” on 
page 250 and “Building a GNOME/Linux X Client Using a CYGWIN GCC 
Compiler” on page 250.

Preparing the Source Code for Visual C++ Use
Once you have written or ported the source code for the X client, you need 
to prepare it in the following way. Regardless of whether you are using the 
Exceed XDK Application Wizard, creating and building a project manually, 
or using a makefile, you must follow this procedure.
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To prepare your code for Visual C++ development:

For more information, see 
“Memory Management” 
on page 229.

1 In the source code, change memory allocation and de-allocation 
routines to their Xlib counterparts.

2 Check for any incompatibilities between Windows and UNIX, 
including the following:

a) Ensure that there is no UNIX-dependent code that is incompatible 
with Microsoft Windows. For example, you must rewrite code that 
uses such items as timers, mailboxes, and STDIN (for GUI 
applications).

b) Ensure that the code does not use any keywords reserved for the 
Windows C compiler as variables, labels, or application-defined 
function names.

3 Ensure that all functions are properly prototyped. 

For more information, see 
“Functions Specific to the 
Exceed XDK” on page 228.

The prototypes for functions specific to the HCL implementation of 
Xlib are provided in the XlibXtra.h and X.h files in the 
home\XDK\INCLUDE\X11 directory (where home is the directory in which 
you installed the software). 

4 Compile and link your client.

Using the Exceed XDK Application Wizard
The Exceed XDK Application Wizard lets you build Motif and X Window 
projects; it operates within the user interface of Microsoft Visual C++ 
Studio (Version 6.0 or later). You can use the wizard to create an empty 
project that has the proper include paths, preprocessor definitions, and link 
libraries.
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When using the Exceed XDK Application Wizard, you can choose one of 
the following application-type options from the drop-down list. 

This Option... Creates an Empty Project that Contains:

Athena Widget The Athena Widget Set Library, along with necessary 
lower-level libraries.

Motif 1.2.4 The Motif library for version 1.2.4, along with necessary 
lower-level libraries.

Motif 2.0.3. The Motif library for version 2.0.3, along with necessary 
lower-level libraries.

Motif 2.1 CTL The Motif library for version 2.1.30 with Arabic or Hebrew 
CTL support, along with necessary lower-level libraries.

MRM 1.2.4 The MRM and Motif libraries for version 1.2.4, along with 
necessary lower-level libraries.

MRM 2.0.3 The MRM and Motif libraries for version 2.0.3, along with 
necessary lower-level libraries.

MRM 2.1 The MRM and Motif libraries for version 2.1 with Arabic 
CTL support, along with necessary lower-level libraries.

X only Only the X11 library.

Xt Application The XT and X11 libraries for version 1.2.4, along with 
necessary lower-level libraries.

After you click Finish in the 
wizard, a screen shows a 
summary of your choices.

The wizard also lets you choose the following project options:

GUI Application—The wizard creates an empty GUI application in the 
type that you specify above. If you do not click this option, the wizard 
creates a console application.

Static Motif Libraries—The wizard uses static versions of MRM and/or 
Motif libraries to create the project. If you do not click this option, the 
wizard uses .dll versions.

.dll—The wizard creates an empty project that can produce a .dll. If you 
do not select this option, the project  will produce an executable.

Loadable X i18n Architecture—Defines a preprocessor macro that forces 
the XDK to use dynamic logging of XLC, XIM, and XOM.
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To create and build a project using the Exceed XDK Application Wizard:

1 Create an empty Visual C project:

a) On the File menu of Microsoft Visual C++ Studio, click New and 
then click the Projects tab.

b) Double-click the Exceed XDK AppWizard icon.

c) In the wizard, specify a location for the project. You can browse for 
a location or type one directly into the field. For example:

C:\Program Files\Hummingbird\Connectivity\version\
Exceed\XDK\SRC\

where version is the version number of the software.

d) Specify a project name and click OK.

e) Select an application type (such as Athena Widget) and click Finish. 
Scan the resulting new project information to make sure it is 
correct and click OK. On the Project menu, click Add To Project, Files. 
Add all source files to the project.

2 If needed, include additional libraries:

a) On the Project menu, click Settings and click the Link tab.

b) In the upper left of the tab, from the Settings For drop-down list, 
select All Configurations.

c) From the Category drop-down list on the tab, select Input; type the 
library paths in the Object/Library Modules field.

d) When finished, click OK to save the settings and close the dialog 
box.

For most application types, the wizard automatically includes the 
standard libraries, but you may want to customize the settings or add 
additional ones.

3 On the Build menu, click Build ProjectName (where ProjectName is the 
name of your project that Visual Studio automatically inserts into the 
menu item).
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4  On the Build menu, click Execute ProjectName (where ProjectName is the 
name of your project that Visual Studio automatically inserts into the 
menu item). 

Creating and Building a Project Manually
Instead of using the Exceed XDK Application Wizard, which requires 
version 6.0 (or later) of Microsoft Visual C++ Studio, you can build a Visual 
C++ project manually.

To create and build a project manually:

1 Create an empty Visual C project:

a) On the File menu of Microsoft Visual C++ Studio, click New and 
then click the Projects tab.

b) In the main window of this tab, select either Win32 Application (for a 
GUI application) or Win32 Console Application (for a console 
application).

c) Specify a location for the project. You can browse for a location or 
type one directly into the field. For example:

C:\Program Files\Hummingbird\Connectivity\version\
Exceed\XDK\SRC\

where version is the version number of the software.

d) Specify a project name and click OK.

Note: If the Exceed directory is not included in the default project 
path, the execution may not work. In this case, do the following:

• On the Project menu of Microsoft Visual C++ Studio, click 
Settings and click the Debug tab.

• From the Category drop-down list, choose General.

• Type the Exceed directory path into the Working Directory 
field.

• On the Build menu, click Execute ProjectName (where 
ProjectName is the name of your project that Visual Studio 
automatically inserts into the menu item).
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e) In the resulting dialog box, choose to create an empty project and 
click Finish. Scan the resulting new project information to make 
sure it is correct and click OK.

2 Customize the project to work with the Exceed XDK:

a) On the Project menu, click Settings and then click the C/C++ tab. In 
the upper left of the tab, from the Settings For drop-down list, select 
All Configurations. (All of the subsequent settings described in this 
procedure, regardless of the tab on which they are located, should 
be for All Configurations).

b) From the Category drop-down list, select Code Generation. From the 
Use Run-time Library drop-down list, select Multithreaded .dll.

c) From the Category drop-down list, select Preprocessor. In the 
Include Additional Directories field, type the Exceed XDK include 
path (the location at which you’ve installed the Exceed XDK 
include files). For example:

C:\Program Files\Hummingbird\Connectivity\version\
Exceed\XDK\include\

where version is the version number of the software.

d) Click the Link tab of the Settings dialog box. From the Category 
drop-down list, select Input. In the Additional Library Path field, type 
the Exceed XDK lib path (the location at which you’ve installed the 
Exceed XDK lib files). For example:

C:\Program Files\Hummingbird\Connectivity\version\
Exceed\XDK\lib\

e) When finished, click OK to save the settings and close the dialog 
box.

3 On the Project menu, click Add To Project, Files. Add all source files to 
the project.

4 On the Project menu, click Settings and then click the Link tab. From the 
Category drop-down list, select Input. In the Object/Library Modules field, 
type the names of the necessary libraries for the X client.

For example:
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HCLSm.lib HclXaw.lib HclXmu.lib HclXt.lib xlib.lib

When finished, click OK to save the settings and close the dialog box.

5 On the Build menu, click Build ProjectName (where ProjectName is the 
name of your project that Visual Studio automatically inserts into the 
menu item).

6 On the Build menu, click Execute ProjectName (where ProjectName is the 
name of your project that Visual Studio automatically inserts into the 
menu item). 

Building an X Client Using a Makefile
You can build an X client using a Microsoft Visual C++ makefile.

To build an X client using a makefile:

1 Locate the source files for the X client (either files you have written from 
scratch or ones you have copied from the UNIX host to your PC).

2 Create a makefile that contains the proper Exceed XDK include and 
library paths.

3 Build the application.

Note: If the Exceed directory is not included in the default project 
path, the execution may not work. In this case, do the following:

• On the Project menu of Microsoft Visual C++ Studio, click 
Settings and click the Debug tab.

• From the Category drop-down list, choose General.

• Type the Exceed directory path into the Working Directory 
field.

• On the Build menu, click Execute ProjectName (where 
ProjectName is the name of your project that Visual Studio 
automatically inserts into the menu item).
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Building an X Client Using a CYGWIN GCC Compiler

The following procedure describes how to build an X client using either a 
CYGWIN GCC compiler.

To build an X client using a GCC compiler:

1 Locate the source files for the X client (either files you have written from 
scratch or ones you have copied from the UNIX host to your PC).

2 Do one of the following:

• From the command line, start the GCC compiler, specifying proper 
Exceed XDK include and library paths and other parameters.

• Create a makefile that includes the proper Exceed XDK include and 
library paths. You may also want to specify additional 
compiler-specific options in the updated makefile.

3 Compile and link your X client using the CYGWIN shell.

Building a GNOME/Linux X Client Using a CYGWIN GCC 
Compiler
The following procedure describes how to build a GNOME/Linux X client 
using a CYGWIN GCC compiler.

You can find the required libraries and header files in the following location:

home\XDK\GCC\

where home refers to the directory in which the Exceed XDK software is 
installed.

To build a GNOME/Linux X client using a GCC compiler:

1 Locate the source files for the X client (either files you have written from 
scratch or ones you have copied from the Linux host to your PC).

2 Do one of the following:

• From the command line, start the GCC compiler, specifying proper 
Exceed XDK include and library paths and other parameters.
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• Create a makefile that includes the proper Exceed XDK include and 
library paths. You may also want to specify additional compiler-
specific options in the updated makefile.

3 Compile and link your X client using the CYGWIN shell.

Troubleshooting

This section provides some problem-solving tips for problems commonly 
encountered when developing local X clients with the Exceed XDK.

• If you are developing an internationalized client and your operating 
system’s encoding is different than that for your X client, you need to 
call the _Xsetlocale function. For more information, see “Setting the 
Locale for an X Client” on page 230.

• When you develop Arabic or Hebrew CTL applications, you have to 
specify CTL as your preprocessor definition. In Microsoft Visual C++ 
Developer’s Studio (Version 6.0 or later), you can add preprocessor 
definitions on the C/C++ tab of the project settings dialog box: on this 
tab, from the Category drop-down list, choose Preprocessor. In the 
Preprocessor definitions field, add the string CTL.

• When you develop Motif applications and you are linking with the 
static version of the Motif libraries (XmStatic.lib), you must define the 
symbol XMSTATIC in your compiler preprocessor definitions. Doing 
so ensures that you use the correct prototype definitions when you 
compile.

• Reserved Keywords—Check for words that are reserved keywords in the 
PC C compiler but not in the UNIX host C compiler. For example, 
using exit as a variable may cause unpredictable results.

• Compiler Options—Ensure that the compiler and linker options are 
correct. You can find the correct options in the sample make files in the 
source directory.

• Path Names—Ensure that the Exceed XDK .dlls are either on your 
path or in your current default directory.
251



OpenText™ Exceed™ User's Guide
252



Chapter 8

Exceed XDK — Japanese Locale 
Support

Using Japanese Locale Support 267

Using Kinput2 268

Keystroke Conversion Tables 269
Key Bind 269
MoveCursor 269
InputMode 270
CharCodeConversion 270
Dictionary 270
Roman Character Conversion 271





Chapter 8: Exceed XDK — Japanese Locale Support
Using Japanese Locale Support

For more information 
regarding Exceed support 
for the Japanese Locale, 
see Xconfig Help.

The Xlib.dll and the X server included in Exceed XDK both support the 
X11R6 X Input Method (XIM). If your X client has been internationalized, 
users can input Japanese in your X client using a Microsoft 
Windows-compatible Japanese IME (Input Method Editor) in Japanese 
Windows. If you are developing an internationalized client, observe the 
following conditions.

Same Encoding in the Operating System and the X Client
If you are developing an X Toolkit application and the encoding of your 
operating system is the same as that for your X client, you do not need to 
specify a setlocale function because it will be called automatically from 
inside the Hclxt.dll.

Different Encoding in the Operating System and the X Client
If you are developing an X Toolkit application and the encoding of your 
operating system is different than that for your X client, you should not use 
the system setlocale function. Rather, you should call the _Xsetlocale 
function; you can call it explicitly or use the X_LOCALE macro to call it.

You can use this function in two ways:

Specify a second parameter of the _Xsetlocale function. For example:

 _Xsetlocale(LC_ALL, "jaJP.euc");

where jaJP.euc is the locale and encoding name.

Do not specify a second parameter and instead set the LANG variable. For 
example:

 _Xsetlocale(LC_ALL, "");

You then need to set the LANG variable to jaJP.euc.

Note: Performing a typical installation does not install Japanese 
Locale Support. Instead, you must perform a custom installation 
and select the Japanese Locale Support component.
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Using Kinput2

Kinput2 is an input server for X11R6 applications requiring Japanese text 
input, including Kana-Kanji conversion.

Internationalized clients using X11R6 Xlib connect to Kinput2 using the X 
Input Method Protocol (X11R6 standard). Clients requiring Kana-Kanji 
conversion services for Japanese text send a request to Kinput2, which 
receives the request, performs Kana-Kanji conversion, and sends the 
converted text back to the client.

Kinput2 supports the following input styles:

• root-window

• off-the-spot

• over-the-spot

To start Kinput2:

1 Double-click the Kinput2 icon to start Kinput2 and open the Local X 
Console.

2 On the Client Control menu in the Local X Console application, click 
Client Manager.

You can then see that Kinput2 is in the Active Clients list, meaning that 
Kinput2 is started and is ready to accept connections from X clients.

To terminate Kinput2:

1 Select Kinput2 from the Active Clients list under Client Manager in the 
Local X Console.

2 Click Terminate Client.

Note: You must install Japanese fonts to ensure that Kinput2 
functions correctly. Japanese fonts are not automatically 
installed when you select Kinput2.
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Keystroke Conversion Tables

The following tables list the keystrokes possible for Japanese locale support.

Key Bind

Purpose Keystroke

Convert Mode On/Off SHIFT+SPACE

Convert/CandidateList Ctrl+J

NextCandidate Ctrl+N

Previous Candidate Ctrl+P

Confirm Ctrl+L

ExtendService Ctrl+O

ShrinkSentence Ctrl+I

CancelChange Ctrl+G

MoveCursor

Purpose Keystroke

DeleteCharacter Ctrl+H

Up Ctrl+P

Down Ctrl+N

Forward Ctrl+F

Backward Ctrl+B

Home Ctrl+A

End Ctrl+E

Undo Ctrl+U
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InputMode

Purpose Keystroke

InputSpecialCharacter Ctrl+Q or F10

Input JIS Code F5

InputFullStop F6

ChangeMode F9

CharCodeConversion

Purpose Keystroke

ToDoubleByteKatakana F1

ToDoubleByteHiragana F2

ToSingleByteKatakana F3

ToDoubleByte F4

Dictionary

Purpose Keystroke

RegisterDictionary Ctrl+T

UnregisterDictionary Ctrl+V

Escape from the mode ESC
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Roman Character Conversion
Make sure you input all characters in the correct case. The conversion table 
for characters A, I, U, E, and O is as follows:

Roman 
Character

A I U E O

A a i u e o

K ka ki ku ke ko

C ca ci cu ce co

S sa si/shi su se so

T ta ti/tsyi/chi tu/tsu te to

N na ni nu ne no

H ha hi fu he ho

P pa pi pu pe po

M ma mi mu me mo

Y ya yi yu ye(ie) yo

R ra ri ru re ro

L la li lu le lo

W wa wi wu we wo

G ga gi gu ge go

Z za zi/ji zu ze zo

D da di du/dsu de do

B ba bi bu be bo
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The conversion table for Roman characters ya, yi, yu, ye, and yo is as 
follows:

Roman 
Character

ya yi yu ye yo

K kya kyu kye kyo

G gya gyi gyu gye gyo

Sy sya syu sye syo

Sh sha shi shu she sho

J ja ju je jo

Jy jya jyi jyu jye jyo

Sw swi swe

Th tha thi thu the tho

Ty tya tyi tyu tye tyo

Tsy tsya tsyu tsye tsyo

Ch cha chu che cho

Cy cya cyu cye cyo

Dy dya dyi dyu dye dyo

Dh dha dhi dhu dhe dho

Dw dwa dwi dwu dwe dwo

Ny nya hyi nyu nye nyo

Hy hya hyi hyu hye hyo

By bya byi byu bye byo

Py pya pyi pyu pye pyo

Hw hya hyi hyu hye hyo
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The conversion table for characters a, i, u, e, and o is as follows:

Roman 
Character

a i u e o

wh wha whi whu whe who

qw qwa qwi qwu qwe qwo

fw fwa fwi fwu fwe fwo

vy vya vyi vyu vye

kw kwa kwi kwu kwe kwo

qa qa qi qe qo

gw gwa gwi gwu gwe gwo

ts tsa tsu tse tso

tw twa twi twu twe two

f fa fi fe fo

v va ve vo

x xa xi xu xe xo

xy xya xyi xyu xye xyo

My mya myi myu mye myo

Ry rya ryi ryu rye ryo

Ly lya lyi lyu lye lyo

V vyo

Roman 
Character

ya yi yu ye yo
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The table for key input order is as follows:

Key Input in Order

nn/n' n

xtu/xtu tu

xwa wa

vya vy

xwi wi

xwe we

xwo wo

xka/xca ka

xke ke

— - (prolonged sound)

 x- - (hyphen)

x, , (comma)

,  (comma)

. ° (full stop)

x. . (period)

X[  (key parenthesis)

X]   (key parenthesis)

X/ • (central black dot)
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Appendix A: Troubleshooting
Exceed Diagnostics

This section describes possible solutions to problems that you may 
encounter while using Exceed. To troubleshoot issues, the following 
methods are available:

• Diagnosing using progress messages.

• Diagnosing using logs and trace operations.

Troubleshooting Xstart

Progress Messages
Usually, the first step in troubleshooting a connection is displaying system 
progress messages. 

To display progress messages:

1 In Xstart, click Settings in the Star tup area. 

2 In the Xstar t Settings dialog box, click the Network tab.

3 On the Network page, select any of the following options in the 
Troubleshooting area:

• Show Progress—Reveals what is happening while you try to 
connect and start an application.

• Show Host Reply—Displays a summary of the startup information, 
the macros you used displayed in expanded form, and what reply 
was given by the host or application. 

Common Error Messages
The common error messages are as follows:

Correct user name and password—System does not connect     If the host 
does not return an invalid name or password message, there may be 
something wrong with the communications link. For more information, see 
“Checking Your Setup” on page 268.
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Host returns invalid name or password message     If you receive an 
invalid name or password message but the system is connecting, the login 
information is incorrect.

Host returns “Command not found” or “No such file or directory” 
message     If you receive either message but the system is connecting, there 
may be something wrong with the path, or the parameters or syntax of the 
command specified in the Command box in Xstart. For more information, 
see “Checking Your Setup” on page 268.

Xstart connects but the client does not start     The client may not be 
getting enough time to start before the initial Xstart socket closes down. For 
more information, see “Checking That the Client Has Enough Time to 
Start” on page 269.

The Client is not authorized to run on the server     To verify 
authorization, examine the Exceed.log file for errors. 

On the Troubleshooting page, click View. 

For problems with permissions, edit the Host Access Control List file.

In the left pane of Xconfig, select Security. On the Security page, edit the 
Host Access Control List file (select File, specify the file name, and then click 
Edit). You may have to also edit the file indicated in the Enable User Access 
Control List area. 

Logs and Trace Operations
Exceed provides Troubleshooting settings in its Xconfig utility.

Troubleshooting in Xconfig
You can specify options for troubleshooting to view the log file, to set what 
information is recorded in the log file, and to enable tracing. There are two 
main methods of active troubleshooting available: logging and tracing. 
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You can log information into a file for later inspection. You can log Font 
Open requests, the initial settings of the WM_COMMAND and 
WM_NAME properties on InputOutput root level windows, and all 
OpenGL requests.

You can also conduct tracing to record all protocol traffic between the 
Exceed X server and the host to a binary file. On the Troubleshooting page in 
Xconfig, there are options that can help with the trace. For example, you 
can turn on tracing as soon as the Exceed X server starts, which means that 
the dialog with the first X client is recorded. You can also select the Slow 
Trace option, which writes all information directly to the file without 
buffering any of the data. This is helpful if you are tracing a situation where 
the Exceed X server crashes because any buffered information would be lost.

The trace stops when the Exceed X server terminates. If you turned tracing 
on by clicking Trace on the Exceed File menu, you can terminate tracing by 
selecting Trace again. If tracing was turned on in the Troubleshooting page in 
Xconfig, you should clear the Trace Initially On option as soon as possible. 
Otherwise, whenever the Exceed X server is restarted, tracing begins again.  

To specify troubleshooting options:

In Xconfig, click Troubleshooting, and then click the Troubleshooting tab. 

Note: OpenGL support requires Exceed 3D. OpenGL is an 
industry-standard three-dimensional graphics software interface. 
It lets you create interactive programs that produce still or 
animated 3D color objects with shading, lighting, and other 
effects. GLX is the X Window System extension which implements 
OpenGL.

Warning!  Tracing creates large disk files on your system, and can 
impair Exceed X server performance. Therefore, use tracing only 
when you are troubleshooting a problem.
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Required Port Numbers
The table below lists incoming ports that are required for various 
components or protocols. To avoid conflicts, ensure other applications are 
not using these ports. If your organization uses a firewall, you can block or 
allow network traffic where appropriate.

Component Port(s)

Bootstrap 67

Finger 79

FTP/SFTP 21

Lpq/Lpr 515

TELNET 23

Tftp 69

Network Time 37

Xstart/REXEC 512

Exceed 6000-6999

Secure Shell 22

XDMCP 177

Resolving Connection Problems
For more information, see 
“Progress Messages” on 
page 265.

If you cannot connect to a host or cannot start X clients with Xstart, you can 
enable the Show Progress and Show Host Reply boxes on the Network page of 
the Xstar t Settings dialog box. 

Checking Your Setup
A quick way to verify that your setup is working properly is to type an 
invalid password for the REXEC startup method or an invalid ID name for 
the RSH startup method.

• If the host does not return an invalid name or password message, there 
is a problem with the communications link. For example, the host is not 
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running or it does not support REXEC or RSH. There may also be a 
problem with your transport configuration.

• If the host returns an invalid name or password message, the system is 
connecting but the login information is incorrect.

• If you receive an invalid name or password message, the connection is 
working. However, there may be something wrong with either the 
syntax or the parameters of the command you typed in the Command 
box in Xstart. You may need to type DISPLAY or PATH variables on the 
command line. 

Checking That the Client Has Enough Time to Start
If the Xstart file seems to connect with the host properly but a client does 
not start, the client may not have enough time to start before the initial 
Xstart socket closes down. On the Network page of the Xstar t Settings dialog 
box, set the Close box in the Timeouts area to -1 (minus one), select the 
Show Host Reply option, and then click OK. To access the Xstart Settings 
dialog box, click Settings in Xstart. 

The Close setting at -1 keeps the first socket open even after the client socket 
is established. The Show Host Reply option displays all host-generated 
messages in a host reply window. If the client seems to start properly, try 
different values in the Close box until you find a value that gives the client 
enough time to start and then closes down the initial socket.

Tracing Server Operation
Exceed uses tracing to captures data transferred between the Exceed X 
server and X clients, font servers, and XDMCP servers. All traces create a 
binary file with an extension of .trx in the Exceed User directory.  

Warning!  Tracing the X protocol writes all protocol traffic between 
Exceed and the host to a file. This quickly creates large disk files, 
which can severely impair server response time. 
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Tracing a Fatal Error
If the server hangs, select Slow Trace on the Troubleshooting page of Xconfig. 
The Slow Trace option outputs all data transferred to the trace file. Since 
buffers are not used, this procedure severely degrades server performance 
and should be specified only when necessary.

Tracing Dialog with First X Client
To examine Exceed interaction with the first X client, turn tracing on from 
Xconfig to begin the trace when Exceed starts. Make sure you clear this 
option when you are finished troubleshooting.

Tracing a Session
You can turn on tracing temporarily while Exceed is running using the Trace 
command on the Exceed File menu.

To turn on tracing:

1 In Xconfig, select Troubleshooting.

2 Select Trace Initially On to turn tracing on. You should turn on tracing 
for troubleshooting purposes only. 

3 On the Exceed menu, select File and click Inser t Trace Comment.

4 In the Exceed Trace File dialog box, specify a comment related to the 
problem and then click OK.

To turn off tracing:

The trace stops when you 
close Exceed.

On the Exceed menu, select File and click Trace, which removes the check 
mark that indicates that the tracing is on. Make sure that you clear the Trace 
Initially On option on the Troubleshooting page in Xconfig. Otherwise, Exceed 
automatically turns tracing on when it restarts.

Viewing Server Error Messages
You can find server error messages in the log file, trace files, and special 
Xstart or TELNET windows. Examine the log file if an X session terminates 
abnormally. You may also want to check the log file periodically to ensure 
that X font and color requests are being met. 
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To display the log file:

Do one of the following:

• On the Exceed menu, point to Tools, and then click Log File.

• Click Log File on the Exceed toolbar.

• In Xconfig, click Troubleshooting. On the Troubleshooting page, click 
View.

General Errors
You can check Exceed operations using tracing. Once enabled, all X 
protocol traffic between Exceed and the host is written to a file. 

Transport Errors
If an error is generated before you establish connection, it usually means it 
was not possible to connect to the host. Although a transport error is 
generated, the actual cause may be that a host connection was not available.

Transport errors are reported in the log file as follows:

message (e)

where message is a text message indicating the nature of the error and e 
represents an error code associated with your network transport. For more 
information on transport errors, see your network transport 
documentation. 

Host-Generated Error Messages
If you have established a TELNET host session, messages normally 
displayed in a terminal emulation window appear in the TELNET window. 

In Xstart, you can view host-generated messages. Host or client messages 
are saved in a log file while the initial socket remains open. 

To log the entire session:

1 In Xstart, click Settings in the Star tup area.

2 In the Xstar t Settings dialog box, click the Network tab.

3 On the Network page, set the Close box in the Timeouts area to -1 (minus 
one). 
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Denied Font Requests
If an X client requests a font that Exceed cannot provide, the font name or 
search pattern is noted in the log file. 

Denied Color Requests
If an X client requests a color that Exceed cannot provide, the color is noted 
in the log file. 
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About HWM
HWM is a local, Motif-like window manager. Like remote, host-based 
window managers, HWM provides a graphical interface that you can use to 
start and exit clients, as well as position and iconize the windows on your 
display. 

You can run multiple 
instances of HWM within 
multiple Exceed instances.

Unlike other window managers running on the host, HWM is a local X 
client that runs on your computer. Running locally speeds up window 
management functions while reducing network traffic. You can run HMW 
in single or multiple window mode.

To start HWM:

On the Start menu, navigate to the OpenText Exceed product group, point to 
Exceed Tools, and click HWM. Depending on how you configured HWM, the 
HWM Virtual Desktop and/or the Icon Manager display.

A Quick Tour of HWM
Depending on the window 
mode, specific options 
may have to be selected 
for the system menu to be 
displayed when you click 
the Windows desktop. 

The System menu, also referred to as the control menu or context menu, is 
the main menu in HWM. The System menu contains most of the HWM 
commands, including standard functions that let you raise a window, move 
a window up and down, refresh the display, and kill a client.

For example, when you choose the Kill Client command, the pointer 
changes to a skull and crossbones. You can exit an application by choosing 
this command, moving the pointer to the application window, and then 
clicking the left mouse button. 

The System menu also contains the following submenus:

Window Ops menu     Contains commands that let you create icons, move, 
resize, raise, lower, zoom/unzoom, refresh, and close a window. You can 
display this menu by selecting it from the System menu or by clicking 
Window Ops in the client window. 

Note: You can run HWM either when the X server is operating in 
Single Window mode, or in Multiple Window mode when configured 
for X, or Default To Native Window Manager.
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When you select a Window Ops command from the client window, the 
operation takes place on the client. When you select a Window Ops 
command from the System menu, the operation takes place on the next 
client that you click.

Desktop Settings menu     Contains commands that show or hide the 
Virtual Desktop, the Icon Manager, or any X clients displayed as icons.

For more information about 
Local Commands or 
adding X clients to the X 
Commands menu, see the 
examples under “Active 
Functions” on page 290. 

Local Commands menu     Contains commands to open Xconfig, Xstart, or 
open Hwmcfg.src for editing in Notepad.

X Commands menu     Initially, this is an empty menu. You can add 
commands that start X clients by editing the HWM configuration file. You 
can also display this menu by right-clicking the X server window 
background.

Root Window menu     Contains commands that let you change the pattern 
or color of the X server window (root window) background. Your selection 
is implemented immediately.

Exit/Restart menu     Contains commands that let you exit or restart 
HWM.

Note: If you are running in multiple window mode, you must make 
sure that the Root Drawing option is set to either Background or Full 
Support. If Root Drawing is set to None, then the changes you make 
using the Root Window menu will not take effect.

To access the Root Drawing option, click Display And Video in 
Category View in Xconfig. On the Screen page, click Advanced. In the 
Multiple Window Mode Advanced dialog box, make the modifications 
as necessary.

Note: The Help command displays a quick reference table that 
shows you how to invoke various HWM and Virtual Desktop 
functions using keystroke or mouse button combinations.
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To access the system menu (single window mode):

In HWM, click anywhere in the X server window background. If the cursor 
is in a client window, you can also display this menu by holding down the 
Alt key and clicking.

To specify the display of the system menu (multiple window mode):

1 In the left pane of Xconfig, click the desired multiple window mode 
Screen #. The Screen # tab is displayed.

• Select Root Mouse Actions To X, and then click OK. Alternatively, you 
can select Root Mouse Actions To X on the Exceed X server toolbar. 

2

To enable the HWM Virtual Desktop:

Run HWM to open the Virtual Desktop. Include the following 
VirtualDesktop statement in your HWM configuration file:

VirtualDesktop

HWM Configuration File

HWM operates according to the specifications in the hwmcfg.src 
configuration file, located in the User directory. 

Note: You can disable the Virtual Desktop by inserting an 
exclamation mark (!) at the beginning of this line. For more 
information on Virtual Desktop statements, see “HWM Virtual 
Desktop” on page 283. 
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This text file is loaded each time you start or restart HWM. You can 
customize HWM by editing the Hwmcfg.src. You can display the HWM 
specifications when the application is running.  

To edit the HWM configuration file:

For more information on 
the system menu, see “A 
Quick Tour of HWM” on 
page 275.

In HWM, select Local Commands and then click Edit HWM Config on the 
system menu. 

Formatting Rules
The following sections outline some basic formatting rules to consider 
when customizing the configuration file.

Note: This file is annotated to help you understand the functions and 
statements in it. We recommend that you make a backup of the 
configuration file before customizing it. This ensures that the original 
file remains intact if you need to revert to it. Changes to HWM 
configuration file take effect when you restart HWM. 
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Configuration File Syntax

Component Formatting Rule

Statements

Exclamation Mark (!) Appears at the beginning of the line and indicates that this 
line is a comment.

#If...#Then Preprocessor statements must always begin with a 
number sign (#). For more information, see “Preprocessor 
Statements” on page 293. 

Menus

Submenus Submenus must always be defined before they can be 
included in another menu.

Lines

Backslash (\)
Continued Rows

Indicates that this line continues onto the next line.

Continued rows must appear sequentially in the 
configuration file. You cannot have blank lines between 
continued lines.

Tokens

Usage/Spacing Each statement should consist of one or more tokens 
separated by one or more spaces.

Case Sensitivity Tokens that are HWM functions are not case-sensitive. Any 
string that displays as text on the screen is case-sensitive.

Backslash (\) Within a string, the backslash character (\) starts an 
escape sequence (see the Supported Character Escape 
Sequences table below).

Note: A token is either a series of non-space characters, 
or any sequence of characters enclosed by matching 
quotation marks (for example, “a b/c? d*e”).
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Supported Character Escape Sequences

Sequence Function

\\ Represents a single backslash (\).

\n Generates a newline character (0x0A).

\r Generates a carriage return character (0x0D).

\xdd Formulates any byte value except 0. Each d is a hexadecimal digit. 

\u Inserts the default user path. A trailing \ is also inserted, if needed. 
For example, "\uhwmcfg.src" is equivalent to:

C:\Program Files\Hummingbird\Connectivity\version\
Default User\Exceed\hwmcfg.src 

\i Inserts the home\info path. A trailing \ is also inserted, if needed. 
For example, "\ixrdb.txt" is equivalent to:

C:\Program Files\Hummingbird\Connectivity\version\
Exceed\info\xrdb.txt

\h Inserts the home path. A trailing \ is also inserted, if needed. For 
example, "\hexceed.exe" is equivalent to:

C:\Program Files\Hummingbird\Connectivity\version\
Exceed\Exceed.exe

\ Continues a single line, onto the next line.

\? Enters a wildcard character that is otherwise used to delineate a 
string or start an escape sequence.

 

Functions

Functions are commands in the configuration file that perform specific 
actions. If you invoke any of the functions that affect a single window (such 
as iconify, refresh, zoom) from a menu that is bound to that window, the 
function operates immediately. However, if you invoke the same function 
from a menu that is not bound to the window, you have to click the left 
mouse button in the appropriate window to perform the operation.

Note: A question mark (?) denotes any wildcard character. 
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The following table lists the supported functions:

Function Description

Nop Specifies a no operation token.

Iconify Iconifies/restores a window.

Menu menu_name Activates the named menu. When this function is called, 
HWM places the upper left corner of the menu at the 
current mouse position.

Move Raises and moves a window or icon.

Resize Raises and resizes a window.

Zoom Zooms/unzooms a window.

Refresh Forces a redraw of the selected window.

RefreshScreen Refreshes the entire screen.

ShowIconMgr Shows/raises the Icon Manager.

HideIconMgr Removes the Icon Manager.

ShowIcons Displays client icons.

HideIcons Hides client icons.

Up Circulates a window up.

Down Circulates a window down.

Top Raises a window to the top.

Bottom Lowers a window to the bottom.

Kill Kills a client.

Exit Exits HWM.

Restart Restarts the window manager (and rereads the 
Hwmcfg.src file).

Freesel Releases ownership of the PRIMARY selection.

Setroot Changes the appearance of the root window.
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Statements

Statements are a sequence of actions in the HWM configuration file 
(Hwmcfg.src) that carry out a specific function in HWM. Editing the 
statements in Hwmcfg.src lets you customize HWM. When used in a 
Hwmcfg.src file, a single statement carries out a single action, while a series 
of statements carries out a complex sequence of actions.

The following sections describe the representative statements in the 
Hwmcfg.src file in the order they appear in the file. However, not all 
statements listed are included in the default configuration. 

The supported HWM statements can be grouped into the following 
categories:

• Virtual Desktop statements

• Font statements

• Window statements

• Color statements

• Icon Manager statements

• Menu Definition statements

• Mouse Button Binding statements

Note: You can disable any of the statements in the configuration file 
by inserting a comment indicator or exclamation mark (!) at the 
beginning of the statement.
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HWM Virtual Desktop
The HWM Virtual Desktop is the first section in the configuration file. The 
following statements appear in the default configuration file:

Statements Description

VirtualDesktop Opens the Virtual Desktop when you run HWM. You can 
disable the Virtual Desktop by inserting an exclamation mark 
(!) at the beginning of this line. 

The syntax for this statement is as follows:

VirtualDesktop

VdeskScale Specifies the scale of the Virtual Desktop window.

number defines the scale of the Virtual Desktop in comparison 
to your screen. This value indicates the number of screen 
pixels that each pixel of the Virtual Desktop represents. By 
default, the value is 20. Therefore, each pixel on the Virtual 
Desktop represents 20 pixels on your screen. 

The syntax for this statement is as follows:

VdeskScale number

StickyVdesk Places the Virtual Desktop within itself to prevent the Virtual 
Desktop itself from being displayed from within the Virtual 
Desktop window. This statement ensures that you will not 
inadvertently move the Virtual Desktop off the screen. 

The syntax for this statement is as follows:

StickyVdesk

Note: If you want the Virtual Desktop to appear as a rectangle 
within the Virtual Desktop window, insert an exclamation mark 
(!) at the beginning of this statement.

DoubleClick Specifies double-click span in milliseconds. The default is 300 
as shown in the following syntax:

DoubleClick_msec  300
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Other Supported HWM Virtual Desktop Statements
There are other statements that control the operation of HWM Virtual 
Desktop that are not included in the default configuration file. Other 
supported HWM Virtual Desktop statements are as follows:

color vdesk     Sets the foreground (screen frame) and background color of 
the Virtual Desktop. The syntax for these statements are as follows:

color vdesk foreground colorname

color vdesk background colorname

VdeskGeom     Specifies the placement of the HWM Virtual Desktop 
window. The syntax for this statement is as follows:

VdeskGeom [+|-]x[+|-]y

FadedMenus To specify faded menus, remove the exclamation mark (!) 
from the beginning of the statement.

The syntax for this statement is as follows:

FadedMenus

Note: The Render extension must be active.

borderwidth Sets the 3D border width to the desired number of pixels. The 
default is 8 as shown in the following syntax:

borderwidth 8

nocascade If you do not want to cascade windows, remove the 
exclamation mark (!) from the beginning of this statement:

!nocascade

positionisframe To specify (x, y) coordinates for your client window (not for its 
frame), remove the comment indicator (!) from the beginning 
of this statement:

!positionisframe 0

Note: You must also uncomment (remove the ! from) 
nocascade to set (x, y) coordinates for the window.

Statements Description
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This statement only works if windows are automatically placed (for 
example, if NoGhost is specified in Hwmcfg.src). A single + or - must 
precede each x and y.

The parameters are described as follows: 

Parameter Description

+x Specifies the horizontal position of the window, where x is the 
number of pixels from the left edge of the server root window to the 
left border of the Virtual Desktop.

-x Specifies the horizontal position of the window, where x is the 
number of pixels from the right edge of the server root window to the 
right border of the Virtual Desktop.

+y Specifies the vertical position of the window, where y is the number 
of pixels from the top edge of the server root window to the top 
border of the Virtual Desktop.

-y Specifies the vertical position of the window, where y is the number 
of pixels from the bottom edge of the server root window to the 
bottom border of the Virtual Desktop.

VdeskButton     Lets you configure which mouse button is needed to drag 
the server window frame or client windows to a new location. The syntax 
for this statement is as follows:

VdeskButton b1 b2

For more information on 
bind statements, see 
“Mouse Button Bindings” 
on page 291.

ShowVdesk/HideVdesk     Lets you show or hide the Virtual Desktop when 
the Virtual Desktop is enabled via an preceding VirtualDesktop statement. 
The syntax for this statement is as follows:

ShowVdesk

Note: b1 is the button that moves the frame; b2 is the button that 
moves the client windows. The values for b1 and b2 can be either 1, 2 
or 3, which represent the left, middle and right buttons on the mouse, 
respectively. The values for b1 and b2 must be different. The default is 
VdeskButton 3 1, where the left button (number 1) moves the client 
windows and the right button (number 3) moves the frame.
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HideVdesk

bind alt shift b3 showvdesk

Font Statements
For more information on 
preprocessor statements, 
see “Preprocessor 
Statements” on page 293.

The preprocessor statement shown below sets the font used by HWM. It 
uses the preprocessor #if...#else...#endif format to set one of two different 
fonts, depending on the size of the server screen. 

#if Xpixels >= 1024

font  10x20

#else

font  6x10

#endif

Window Statements
The following window statements let you move, resize, and focus windows:

NoGhost     Lets you instruct HWM to automatically place and size client 
windows. The syntax for this statement is as follows:

NoGhost

To move and resize client windows when they first appear on your screen, 
add an exclamation mark (!) to this statement. The windows then appear as 
outlines, which you can place anywhere on the screen or Virtual Desktop. 

ClickToFocus     Lets you focus client windows. This statement, by default, 
requires that you click a client window to focus and raise it. The syntax for 
this statement is as follows:

ClickToFocus [raise] 1

Note: Statements and functions can also be called using mouse-
button bind statements. For example, to show the Virtual Desktop 
whenever you hold down Alt-Shift and then click the right mouse 
button, use the following statement:
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If you want the pointer to focus the window, insert an exclamation mark (!) 
before this statement. The raise parameter is optional. You can also specify 
one of 1 (left), 2 (middle), or 3 (right) to indicate which mouse button to 
click.

Color Statements
Color statements set the colors that HWM displays for windows, menus, 
icons, dialogs, and the Icon Manager. 

3D Effect     HWM achieves its 3D effect by using three colors. In each of 
the areas where you can set background and foreground color, HWM 
allocates a third color that is a shade of the background. If colors are not 
specified for WINDOW, TRANSIENT, ICON, ICONMGR, or MENU, 
HWM assumes the colors are black and white, with gray shading.

Setroot color_specification     Specifies the color of the root server window. 
The syntax for this statement is as follows:

Setroot color_specification

The following table describes different types of color_specification.

Color_Specification Description

default Resets the server root window to its default.

solid color Changes the server root window to a solid color, where 
color is any color defined in the RGB database. If the 
color name contains spaces or tabs, enclose it in 
quotation marks (" ").

bitmap filespec
[fg color bg color]

Changes the server root window to the pattern 
described in the file filespec, where filespec 
specifies a standard X11 bitmap. You can optionally 
specify the foreground and background color.

Icon Manager Statements
The Icon Manager configuration statements that appear in the default 
configuration file are listed as follows:
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IconMgrOn     Enables the Icon Manager when you run HWM. The syntax 
for this statement is as follows:

IconMgrOn

This statement automatically displays the Icon Manager in the server 
window. You can disable the Icon Manager by inserting an exclamation 
mark (!) at the beginning of this line.

stickyIconMgr     Prevents the Icon Manager itself from being displayed 
from within the Virtual Desktop window. This statement ensures that you 
will not inadvertently move the Icon Manager off the screen while using the 
Virtual Desktop. The syntax for this statement is as follows:

stickyIconMgr

If you want the Icon Manager to appear as a rectangle within the Icon 
Manager window, add a (!) before this statement.

HideIcons     Hides any client that is currently iconified. The syntax for this 
statement is as follows:

HideIcons

If you want the icons displayed, you can replace this statement with the 
ShowIcons function.

Other Supported Icon Manager Statements
There are additional supported statements that are related to the operation 
of HWM Icon Manager. The following statements are not included in the 
default Hwmcfg.src file:

IconImage     Associates a specific bitmap file to act as an icon for a 
particular client window. The syntax for this statement is as follows:

IconImage window-name bitmap

For example, you can use the bitmap file provided in the Info directory (by 
default, C:\Program Files\Hummingbird\Connectivity\
version\Exceed\Info) as an icon for an xterm window by using the 
following statement: 

IconImage xterm "\bird.bit"
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You can also associate a pixmap to be used as the default HWM icon for 
clients that do not specify an icon by using the following statement:

IconPixmap filespec

For more information on 
the x and y variables, see 
“VdeskGeom” on 
page 284.

IconMgrGeom     Specifies the placement of the Icon Manager window. The 
syntax for this statement is as follows:

IconMgrGeom [+|-]x[+|-]y

Menu Definitions
Menu names are 
case-sensitive. 

The configuration file also lets you configure how menus appear on HWM. 
Menu definitions start with the word menu, followed by the name of the 
menu enclosed in quotation marks (" ") and ending with the word 
endmenu. Any items that appear on the menu are defined on the lines in 
between these two words. 

All HWM menus appear in the menu definition section. They can be 
divided into two categories: menus with inactive menu functions and 
menus with active functions. 

Inactive Functions
Menus with inactive functions are menus that do not perform any 
operations. They present information, rather than provide menu 
commands.

For example, the VdeskHelp menu has no active functions. Lines that do not 
invoke functions (or blank lines on a menu), are exited with nop, which 
indicates No Operation. Strings in the menu definition, or text enclosed in 
quotation marks (" "), display on the menu using the default font specified 
in this file. 

For example:

menu VdeskHelp

Note: filespec must specify a standard X11 bitmap file.

Note: Blank lines on the menu are indicated with an empty string ("").
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"Click on With Mouse Button Function" nop

"-------- --------------- --------" nop

"anywhere Alt Shift right Show VirtualDesktop" nop

"anywhere Alt Shift left Hide VirtualDesktop" nop

"  " nop

"in Vdesk left Move the view" nop

"in Vdesk on a window right Move 
and/or show the name of a window" nop

endmenu

Active Functions
Menus with active function menu items execute a specific operation or 
invoke a specific submenu when the user chooses it from the menu. For 
example, the Window Ops menu includes items which perform various 
window functions:

menu "Window Ops"

"Iconify" iconify

"Move" move

"Resize" resize

"Raise" top

"Lower" bottom

"Zoom" zoom

"Refresh" refresh

"Close" kill

endmenu

For more information on 
this menu, see “A Quick 
Tour of HWM” on 
page 275.

To start an application from an HWM menu, use “run” with the specified 
command. You can use the Local Commands menu to execute local 
Windows or X apps. For example:

menu "Local Commands"

"Xconfig" run "xconfig"
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Xsession" run "xsession"

"Xstart" run "xstart"

"Hwm config" run "notepad hwmcfg.src"

endmenu

You can use the X Commands menu to start remote X clients using Xstart. 
For example:

menu "X Commands"

"XTerm Packard" run "xstart packard.xs"

endmenu

Mouse Button Bindings 
The mouse button bindings section of the Hwmcfg.src file lets you display a 
menu or perform a function by either binding it to a mouse button, or to a 
mouse button and keystroke combination.

In general, the syntax for a bind statement is:

bind [location] [modifier] button menu_or_function

Mouse button binding parameters are described in the chart below:

Mouse Button Binding Parameters

Location1 Description

Root (or R) Binding is valid on the root window.

Window (or W) Binding is valid on a window.

Icon (or I) Binding is valid on an icon.

Left (or L) Binding is valid on a window banner's left 
button (typically the Window Ops button).

OutsideRight (Right, OR, or R) Binding is valid on a window banner's 
outside right button (typically the zoom 
button).
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1 If none of Root, Window, Icon, Left, Right, InsideRight, or Middle are 
specified, all are assumed. 

2 Alt is used as a synonym for Mod1, as this is the modifier associated with the Alt 
key in the keyboard files supplied with Exceed.

3 Only one of B1, B2, or B3 can be specified in any one statement.

InsideRight (or IR) Binding is valid on a window banner's 
inside right button (typically the button to 
iconify).

Middle (Mid or M) Binding is valid on a window banner's title 
bar, that is, outside of the buttons.

Modifier2 Description

Shift (or S) <Shift> required.

Control (CTRL or C) <Ctrl> required.

Mod1 (ALT or A) Mod1 required.

Mod2... Mod 5 Mod2... Mod5 required.

Button3 Description

B1 (or 1) Mouse button 1 (left).

B2 (or 2) Mouse button 2 (middle).

B3 (or 3) Mouse button 3 (right).

Mouse Button Binding Parameters
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Preprocessor Statements
Preprocessor statements let you set if...else conditions that define which 
statements in the Hwmcfg.src file are processed. The following preprocessor 
statements are supported:

Statement Description

#if expression Used to specify an expression. Expression format is 
described in the Expressions in Preprocessor 
Statements section below. If the expression is true, 
successive statements are processed. If the 
expression is false, successive statements are not 
processed.

#endif This statement marks the end of the range of the #if 
statement. For each #if statement there must be one 
#endif statement. 

#else statement(s) You can use one #else statement within each 
#if...#endif range. If the expression in the associated 
if statement is false, all statements between #else 
and the associated #endif are processed. 

For example:

#if Planes == 8 !test for 256 colors

 color active transient foreground blue

 color inactive window background red

 color...!specify colors

#else

 color active transient foreground white

 color inactive window background black

 color...!different colors

#endif

Note: #if...#endif statements can be nested, that is 
if...#endif ranges can be placed within each other.
293



OpenText™ Exceed™ User's Guide
Expressions in Preprocessor Statements     Expressions in preprocessor 
statements take the following format, and the fields must be separated by 
one space:

id operator constant

These fields are discussed in the following table:

Field Description

id

xpixels The width of the server screen in pixels.

ypixels The height of the server screen in pixels.

Planes Represents the number of video planes. The number of colors is 
2planes, that is, 4 planes specifies 16 colors; 8 planes specifies 256 
colors.

Color Used to test whether or not the server supports color. (For example: 
PseudoColor or StaticColor.) If the default server supports color, 
Color is set to 1. Otherwise, it is set to 0.

Static Used to test whether or not the server supports static read-only 
colormaps or dynamic read/write colormaps. If the server supports 
only static colormaps, Static is set to 1. If the server supports 
dynamic colormaps, Static is set to 0.

VdeskOn Used to test whether the Virtual Desktop is specified in Hwmcfg.src. 
If the Virtual Desktop is specified, VdeskOn is set to 1, otherwise it is 
0.

operator

== TRUE if ID is equal to constant.

<> TRUE if ID is not equal to constant.

< TRUE if ID is less than constant.

<= TRUE if ID is less than or equal to constant.
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About the Exceed Virtual Desktop

The Exceed Virtual Desktop window represents the entire area of your 
virtual screen. The top left corner of this box corresponds with the top left 
corner of your physical screen, which is only a portion of the virtual screen 
area. 

The Virtual Desktop can represent an area many times larger than the actual 
server root window. It displays an overview of the entire contents of the 
server root window, including those X clients that are currently 
off-screen. You can use this extended desktop area to display and work with 
numerous Microsoft Windows-based applications and X applications 
running the native window manager without crowding the work area.

The Exceed Virtual Desktop Window
Colored boxes within the Virtual Desktop window represent open 
application windows. The box that contains the color used by Windows for 
active application title bars represents the currently active application. Light 
gray boxes represent inactive application windows.

A red frame outlines the portion of the Virtual Desktop that is visible on 
your display. This frame can be moved by right-clicking it and dragging it to 
the desired location. If you move it to a client application, that gives it the 
focus. Each active client appears as a shaded box. When you click in a 
shaded box, the name of the client appears in the Virtual Desktop title bar. 
The client window with the focus appears with its title bar, border color, 
and shaded box in the highlight color.

> TRUE if ID is greater than constant.

>= TRUE if ID is greater than or equal to constant.

constant

constant A decimal numeric value.

Field Description
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You can position client windows anywhere within the Virtual Desktop by 
clicking the window and dragging it to the desired location. When you 
release the mouse button, the window moves to the specified location. 

Navigating the Exceed Virtual Desktop
Minimized applications do 
not appear in the Virtual 
Desktop window. 

When you click and hold the left mouse button on a box representing an 
application window, the title bar caption appears in the title bar of the 
Exceed Virtual Desktop window. You can use this feature to find 
applications that are currently off-screen. You can right-click any area 
within the virtual desktop to display that area on your physical screen. 

The following keyboard navigation is available when Exceed Virtual 
Desktop has focus:

• Use the Tab key to change the selected application in the Vir tual Desktop 
window.

• Press the Esc key to de-select applications.

• Use the up/down/right/left arrow keys to navigate the Vir tual Desktop 
window and to move selected applications.

• If you enabled Direct Placement in the Vir tual Desktop Options dialog box, 
you can move the current window by right-clicking anywhere in the 
Virtual Desktop window. 

• If you enabled Use Vir tual Desktop Workspaces in the Vir tual Desktop 
Options dialog box, you can use the numeric keys or the hot keys on 
your keyboard to shift the display onto a specific virtual display area. 
You can also right-click the Virtual Desktop title bar and select the 
virtual display area you want to view.

• To use Function keys to toggle between workspaces, use the Workspaces 
Configuration dialog box to specify workspace names and function key 
combinations. For more information, see Exceed Help.

To move an application:

Click and hold the application box drag it to the new location in the Virtual 
Desktop.
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Configuring the Exceed Virtual Desktop
You can modify the look and behavior of the Virtual Desktop and enable 
features that let you parse, name, and navigate the virtual area. For more 
information on configuring the Virtual Desktop, see Exceed Help.

To configure the virtual desktop:

1 On the Exceed Menu, select Tools, and click Vir tual Desktop. 
Alternatively, click Vir tual Desktop on the Exceed toolbar.

2 In the Vir tual Desktop window, right-click on the Virtual Desktop title 
bar and click Options on the menu that appears.

3 Use the Vir tual Desktop Options dialog box to make the necessary 
modifications.
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